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THE AIRPOD INTERFACE

APPLE'S AIRPODS were introduced
alongside the iPhone 7, and at first,
they looked like just an accessory to
soften the removal of the audio jack.
Apple went to lengths to say they’re

a particularly smart pair of wireless
headphones, but they still looked like
an answer to a practical question,
rather than an amazing new appliance.
Certainly, that’s what I thought.

But I’m starting to change my mind.
You can read our review of the AirPods
on p64, though that’s a review of what
they’re like now, and what I’ve come to
realize is that they’re an important
step on the road of things to come. The complete lack of wires and
all-day battery life (with a bit of charging from their smart case)
makes them an interface for your phone you can wear all day
without it interfering too much with your life, kind of like the
Watch. Double-tap and you can command your iPhone to send
messages, book a Lyft, read your appointments, get directions to
somewhere (which appear seamlessly on your Watch), and so on.
With a Watch and AirPods, your phone could stay in your pocket
or bag most of the time now.

It’s clear that Al is the future of a huge amount of computer
use. Right now, that means using Siri to trigger things both on
your phone and in the cloud. But that will change - as more of
your data gets stored in the cloud, Siri can be further divorced
from your phone without losing functionality. The next step will
surely be an Apple Watch with a cellular internet connection of its
own, paired with AirPods, talking to Al that’s based in the cloud
and tailored to your data. It’s information at your eartips. In some
ways, I see the AirPods as Apple’s first product that compares to
Google Glass, as massively different as they are.

Of course, the Glass comparison brings up the specter of
whether all this is really viable from a social point of view, rather
than a technological one. You’ll be able to control your life by
speaking aloud to nobody in particular... but would you?

MATT BOLTON, Editor
Twitter: @matthewbbolton
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>>>THE TEAM

Mat Gartside

Art Editor

Mat's best Mac timesaving
tip is to make sure you
customize the Dock.

Jo Membery
Operations Editor

Jo uses Automator to
perform common tasks
with just a few clicks.

Adam Banks
Contributor

The Finder is my mind
palace. My mind's a mess,
so shortcuts are a must.



LETTER OF THE MONTH

I read with much interest your article on email
encryption in issues #121 and #122. The step-by-
step instructions are very useful for those who
never set up email encryption or know about
digital certificates. I would like to recommend
that in a future issue, you also write an article on

how to do this with a CA (certificate authority)
such as Comodo. They provide free certificates, and the benefit is that
the recipient of digitally signed email can see that the certificate is
valid the first time they received such email - i.e. no need to trust

a self-signed certificate beforehand. CHARLES S.

Thanks for the suggestion, Charles! There are big conveniences in using
a certificate authority for signing your emails, but they also introduce
risk: they’re vulnerable to “man-in-the-middle” attacks, where hackers
impersonating a CA sign digital certificates and intercept the traffic
you’re expecting to be secure. In fact, this happened to Comodo in the
past, though new security measures have been introduced to mitigate
the risk. It’s still a good idea, but it’s important to know the risks!

The iKlips DUO
is great for
transferring
files between
Mac and i0S.

SHARE WITH US!

Card copying

When is one going to be able

to download items to an SD card
or other recording device from
iPad? | would also like for the
iPad to support a SuperDrive.

| now use my iPhone most of
the time, but if | photograph a
party and want to give people
the photos, | give them an SD
card with their photos on it.
Can't do that if | use my iPhone.
PAT GREENWOOD

| don't think you'll ever be able
to do this, unless a company
comes out with an accessory
and app specifically designed
for it (I'm not aware of any).
When it comes to sharing
things from iOS, Apple's
answer seems to always

be: the cloud. iCloud Photo
Library shared albums (or an

equivalent in Dropbox or
similar services) are the
easiest ways. The closest

you could get is a flash drive
that connects to the Lightning
port (such as Adam Elements
iKlips DUO) that also has a
USB connection, so you can
transfer the photos onto it,
then your friends can just
plug it into their computer.

Shortcut to success
Regarding the letter “Key
problems" in the December
issue (#122), | was a long time
user of QuicKeys. But that
product has not been
maintained for a number of
years, and really no longer
works well if at all with macOS
Sierra. But good news: there
is an alternative product
available called Keyboard

EMAIL: letters@maclife.com
FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife

We really like Keyboard Maestro and
it's being improved upon all the time.

Maestro (keyboardmaestro.
com). It does all of what
QuicKeys did and more, is
very powerful, and reasonably
priced. Online support for KM
is very quick and responsive.

| hope you will do a full review
on this extremely helpful tool.
In the meantime, | highly
recommend it.

RICK OBERNDORF

Great suggestion, Rick! We
reviewed Keyboard Maestro's
last big update (version 7)
back in issue #108 and gave
it our “Excellent” rating!

It's a fantastic tool.

Settling scores

On the Contents page is four
columns. Mark each review
with the number of squares
the review has. It will save
readers sifting through them!
RON STARK

This is an interesting idea, but
I'm always wary of highlighting
the scores too much. They're
useful, but they're one part of
the whole - | want people to
sift through the reviews, so
they get the full story on
whether a product might work
for them despite a mediocre
score overall, for example.

Mac|Lifes®
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Is it the end of
the line if your
Mac is obsolete?

Apple designates Macs as “obsolete”
after a period of time. We look at
what that means sy aLex BLAkE

FIND OUT HOW TO
KEEP OLD MACS
RUNNING WELL

p44

o Window Help O §t F6E Twioes L Q
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FEED YOUR MIND. FEAST YOUR EYES.

APPLE RECENTLY recategorized a
number of its Macs as “obsolete” or
“vintage.” This specifically affected
the Early 2009 Mac mini and Mid
2009 13-inch MacBook (obsolete),
and the 15- and 17-inch Early 2011
MacBook Pros (vintage). What does
this mean, and what can you do if
you own one of these?

Obsolete means that Apple will no
longer offer official repair support
through its retail stores and
third-party resellers. Vintage is the
same in all regions except California
and Turkey, where residents can get
limited support on certain products
up to two years after they become
obsolete. Apple tends to classify its
products as obsolete between five
and seven years after manufacturing
has been discontinued.

There’s no need to panic if your
Mac is affected and you need to
replace a part, though. Companies

Having an obsolete or vintage Mac
doesn't mean it's worthless - hardware
upgrades can give it new life.



such as iFixit (ifixit.com) publish
detailed guides to replacing almost
every part in your Mac, should you
need to. As long as you can source
replacement parts, from eBay for
example, and don’t mind getting
hands-on, repairs can be made.
What might be more of a concern

is the time and effort you have to
invest in replacing parts, rather than
having Apple do it for you. For some
components, such as the hard drive,
this is an easy process (depending
on your model of Mac). If a fan or
speaker goes, it’s much trickier. If
keeping your Mac running involves
numerous complicated fixes with
hard-to-find components, you may
be better off buying a new computer.

HARDWARE ISN'T your only
consideration when working with

an obsolete Mac - you’ll need to

find out what software it can run.
The most important consideration is
that Apple no longer offers security
updates to any version of OS X earlier
than OS X 10.9 Mavericks. How much
that’s likely to affect you depends on
what you do with your Mac - running
it offline should be fine, but using it
as your main work device could spell
trouble. There’s no point upgrading
the hardware if it falls prey to
malware! Swapping your old version
of Safari for a recent alternative,
such as Camino (caminobrowser.
org), and using anti-malware
software will help, but you’re

still at risk when online.

Intel’s new graphics-
boosting chips

What improvements can we expect from
Intel's latest processors? sy mart soLton

IN JANUARY, Intel revealed
models of its latest generation
of processors, codenamed Kaby
Lake, including models that will
almost certainly find their way
into future MacBook Pros, iMacs,
and Mac minis (possibly even

by the time you read this in the
case of the desktops, though we
expect it to take a little longer).
Many of Intel's recent releases
have focused on battery life
improvements, but Kaby Lake
will offer similar battery life to
existing chips in most cases. In
terms of performance, it will be
optimized for some specific tasks
(including working with and
viewing 4K video), but mostly
you're looking at a slightly faster
version of what we have now.
The biggest gains will probably
be in Intel's integrated graphics
chips, which Apple relies on
heavily in many Macs, where
performance may increase by
around 20% (with the GPUs
rebranded to Iris Plus instead

of Iris Pro, presumably just to
annoy tech writers who have to
explain the difference).

AS EVER, we don't know exactly
what Apple will use, but Intel
announced some chips that are
right in Cupertino’'s comfort
zone. For example, the obvious
chips for the stock 27-inch iMacs
would raise speeds from the
current 3.2GHz and 3.3GHz to

3.3GHz and 3.4GHz (the actual
improvement would likely be
better than those numbers
suggest), though the 4K 21-inch
iMac is less clear, since Intel has
yet to announce any Iris Plus
desktop parts. Chips suitable for
the MacBook Pro were released
too, but we wouldn't expect to
see an upgrade for those until
late in the year, though these
chips would also work nicely for
a Mac mini: we might see one
with 3.1GHz and 3.3GHz dual-core
Core i5 processors as standard,
with Iris Plus graphics.

Kaby Lake also supports
Thunderbolt 3 across the range,
and should be able to lift the
16GB RAM limit of the new
MacBook Pros, according to
reports. It also supports a new
faster type of storage, named
Octane, but we suspect Apple
is happy with its current
ridiculously fast storage.

The next Mac
lineup should
boast Intel's
latest optimized
processors. ’
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New ways
to touch
your iPhone

The next iPhone could
have new touch sensor
technology. We look

at what, and why

BY MATT BOLTON

RUMORS ABOUT THE future of the
iPhone come thick and fast, but two
relating to new sensor types caught
our eye, and seem just crazy enough
to maybe work. The first that the
iPhone screen’s surrounding bezel
will be reduced, becoming so small
that it cannot accommodate a Home
button any more, or the earpiece
speaker at the top. The latter can be
replaced with a speaker effectively
attached to the glass itself, and we’ll
come to what happens to the Home
button later, because the big
question here is what happens

with Touch ID. Reports say that

it’s possible for Apple to move the
fingerprint sensor under the screen
itself, so there might just be a circle
that appears on-screen when you
lift your phone, and you place your
thumb there to unlock it. These
sensors already exist, so it’s well

3D Touch surprised us,
and there may be more
SeNnsor surprises
in store...

b S e, L e

Will the next generation of iPhone
lose the iconic Home button? As
long as we don’t lose Touch ID...

within Apple’s capabilities to
produce one, though we’re not
sure how we feel about an iPhone
without the iconic Home button.

The other rumor is that there may
be more touch sensors around the
phone, either on the side or back,
separate to the screen, meaning
you’d be able to interact with apps
without touching the display. You
could slide your thumb down the
right edge to scroll websites, or move
your finger along the iPhone’s edge
to quickly scrub through a video; you
could zoom when using the camera
by sliding your finger along the edge,
and take a photo by just tapping your
finger gently on top... in all cases,
you’d have great control, without
obscuring the content you’re
concentrating on with your fingers.
Oh, and this kind of gesture could
replace the Home button.

Once upon a time, we’d have said
this seemed hugely unlikely, but 3D
Touch surprised us, and showed that
Apple is open to experimentation
with “invisible” options for
controlling apps. We like this idea a
lot, and though it’s just speculation
now, we could see it as a potential 7S
feature even if the Home button
redesign doesn’t happen.



>THE SHIFT

Expectations weigh heavy on the Mac

in 2017, and DAVID CHARTIER says
there's a fork in the road

'VE WORKED IN and covered the

Apple space for over a decade.

But for the first time in a long

while, it feels like there’s real,
legitimate unrest among the Mac
community. In its quest to evolve
and simplify the Mag, it feels like
Apple has forgotten who wants
the Mac, and why.

Exhibit A: for the first time in
about a decade, Consumer Reports
decided it cannot recommend the
latest MacBook Pro. While the new
Touch Bar is a clever addition,
Apple’s latest pro portables
suffer from battery performance
fluctuations wild enough that
Consumer Reports couldn’t sign
off on them (Apple has said it’s
working with Consumer Reports
to work out what happened).

Making things more difficult
is that the new MacBook Pro lost
every kind of port except for the
next-generation, incredibly thin
USB-C/Thunderbolt 3. Now, most
consumers may not have much to
upgrade. But professionals usually
have hundreds, if not thousands,
of dollars’ worth of equipment and

It feels like Apple has
forgotten who wants
the Mac, and why

cables. Eliminating longstanding
ports in one fell swoop, instead of
gradually, and expecting the pro
users to buy new equipment or do
the Dongle Dance, has been labeled
as everything from shortsighted to
inept product design. Considering
Apple put all its dongles on a 50%
off sale for a few months, I think
there’s some valid criticism here.
Apple saved about a half-pound
of weight and made the MacBook
Pros thinner. But did so at the
expense of a meager performance
gain and dropping the ball for
professionals — the community
for which these machines are
designed, or at least named.

EXHIBIT B IS the dust collecting on
the Mac Pro. It’s a beautiful design,
but it’s also difficult to upgrade.
Plus, Apple hasn’t bothered with it
in over three years. As of late 2016,
the Mac Pro’s web page still
mentioned Aperture, Apple’s pro
photo editing and organizing tool
it discontinued two years prior.

A few years ago, Apple went
“Back to the Mac,” using lessons
learned from the success of iOS to
enhance the Mac. Apple upgraded
macOS with i0S-inspired features
such as Trackpad gestures, iCloud
sync, and Launchpad. But I worry
that Apple may have brought too
much back to the Mac. It’s easy to

argue the iPad and maybe even the
iPhone have had to get thinner and
lighter over the years. But the Mac,
and especially the Pros, aren’t built
for everyone. They have unique
needs and customers, and it feels
like Apple has forgotten about
them in the name of growing the
overall Mac base or, worse, being
progressive for the sake of it.

Will Apple
regain
community
allegiance in
2017...7

I see two roads for the Mac.
Either Apple learns from this
stumble and adjusts the Mac’s
course back to its unique audience
and needs. Or the Mac continues
its slow descent towards
inadequacy and irrelevance, ceding
the desktop and notebook market
to rejuvenated competitors. Surely,
if Tim Cook’s promises of new
Macs are true, 2017 will show us
where Apple’s compass points.

»> David Chartier is a content strategist and writer with vast experience analyzing the tech world.
He runs the website Finer Things in Tech (finerthings.in) and hosts its podcast, The Finer Things In.
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Get an inside look at Apple's products with Designed by Apple in California.

ANY COMPANY WITH a history
stretching back over forty years will
have some interesting stories to tell,
but we all know that Apple’s lore
is especially intriguing. It’s got a
humble beginning, early successes,
internal struggles, external villains,
betrayal, falls from grace, some very
low points, a triumphant return...
and we’re only up to the late ’90s!
There have been many books
chronicling not just Apple’s history,
but also its creations. Here, we’ve
picked some of the best to check out,
many of which revolve around its
products and Steve Jobs, somewhat
inevitably. There are many more out
there that talk about its methods and
how it’s run, but if you’re an Apple
fan, these are the places to start.
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>>Start N your mind. Feast your eyes.

6 excellent
books for Apple fans

Get the inside story of Apple and its products with these great reads!

BY MATT BOLTON

1

Designed by
Apple in California
Let's begin with
this $199 tome
from Apple - a
huge coffee table

iWoz

tounded Appie

% Steve Worniak
T
Apple's co-founder

looks back at the
early days.

photo book of
Apple's product
designs over the
last 20 years. It's
lush, meticulously
presented, took
eight years to
create, and shows
products you
thought you knew
in a new light in
many cases.

2

Revolution

in the Valley
Andy Hertzfeld
was one of the key
architects of the
original Mac, and
runs Apple history

cocrealar of The Mac

ow The Mac Was Made

Find out more about the history of the Mac.

site folklore.org. In
this book, he tells
the story behind
creating the Mac.

3

Steve Jobs

The official
biography of Jobs
by Walter Isaacson
had access to the
man himself
shortly before his
death, so offers
some unique looks
into his work.
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iWoz

Apple's other
founder, Steve
Wozniak, writes
his own story here,
up to the creation
of the Apple Il. It's

about those early
years of tinkering
and pure creation.
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ICONIC

You'll have seen
Jonathan Zufi's
work on our pages
- his book is full of
original images of
older and rarer
Apple products, as
well as the recent
stuff. It's brilliant.
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The Second
Coming of

Steve Jobs

This is the warts-
and-all telling of
Jobs' ousting and
return to Apple.
Stark and honest.
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Email hacking is a risk for anyone, and
BRIANNA WU thinks its time Apple helped
make communication more secure

ORE THAN any other tech
company, Apple is not
afraid to break up legacy
formats and face public
blowback. It helped kill Flash, the
CD-ROM drive, and with the new
Retina MacBook having only
USB-C, it’s only a matter of time
before old USB inputs disappear.
For its next magic trick, I’d like
to see Apple make our old email
protocol disappear. As a public
figure, every day I worry that my
email will be hacked. And with
good reason — email is a shockingly
unsafe way to send a message to
someone. Although it’s usually
encrypted in transit through TLS,
you can’t count on it — and it’s
still vulnerable while stored on
a server. If you use a webmail-
based service like Gmail, that
information can be subpoenaed
by the Government or even stolen
by hackers.

Even if your password is strong, without end-
to-end encryption, your email is vulnerable.

The foundation of email protocol
was invented in 1982, and it’s still
in widespread use today. And
although services like Gmail and
Microsoft Exchange use their own
internal formats, it defaults back
to SMTP when communicating
with other services. In many cases,
email ends up in a completely
unencrypted format, quite readable
in ’80s ASCIL. I can do everything
right my end. I can have a 50-digit
randomly generated password. I
can have two-factor authentication
on, and my email is still not safe.
I’m at the mercy of hackers,
Government subpoenas, and every
server to send my message.

IT DOESN'T need to be this way.
When you send an iMessage, you
can feel reasonably confident
about the security. Apple designed
the service with end-to-end
encryption, meaning no one at

Apple ever has the message in a
format they can understand. You
trade public keys and private keys
with whomever you text. The
Government could ask for your
text, and Apple might be forced to
give it to them - but it wouldn’t be
in a format it could understand.

That safeguard really doesn’t
work with SMS, so you can’t count
on security when texting friends
on Android. But that just speaks to
the need for Apple to work with
other industry leaders and adopt
standards. The Mail app on macOS
and iOS has its critics, but it’s in
wide use. Building a proprietary
mail protocol for Apple devices
would be a selling point for Apple.
Imagine clicking a box in Mail,
“Send Securely.” Your message
would be encrypted and sent out
with traditional SMTP methods.

If you were on an Apple device, it
would be automatically decrypted.
If you were on a Windows machine,
the email would start with a link to
iCloud to register so you could read
it. Hopefully, Apple would make
this kind of technology open
source to foster wider adoption.

If 2016 proved anything, it’s that
email hacking is a serious threat.
The Government can’t solve it,
Google can’t solve it - this is the
kind of step forward only Apple
can take. Courage.

»> Brianna Wu is the head of development at Giant Spacekat, developer of Revolution 60 on iPhone and iPad,
and is a reqular speaker at industry events, as well as host on the podcasts Isometric and Rocket.
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>>Start N your mind. Feast your eyes.

Around $38,000

W Hi-Can High Fidelity Canopy
hi-interiors.com

»> Now you can get your all-important beauty
sleep in a revolutionary new smart bed. HiCan’s
"“technological cocoon” is packed with features:
configurable touch headboard, automated
privacy blinds, dimmable lighting, a motorized
footboard with home theater and multimedia
capabilities - HD projector and projection
screen, integrated surround sound system,
Apple TV, and Xbox One or PS4. The height
and angle of the mattress are also configurable
using the compatible iOS (and Apple Watch)
app. It's currently raising funds on Indiegogo.

16 MAR 2017. maclife.com



lightmodehelmets.com

2 LightMode Helmet Kit: Redesign
$149

»»> There's riding a motorbike, and there's riding
a motorbike looking like you've just come cruising
off the Grid from Tron. This Kickstarter project
comprises battery-powered electroluminescent
lights to transform your bike helmet from the
mundane to the realms of cyberspace. Compatible
with any helmet, the lighting strips are water-
resistant and USB rechargeable. It's a tad “DIY"
as a kit - you have to glue down the wire and tape
on your helmet, but that makes it affordable and
means that each design is unique (find inspiration
on the LightMode Helmets Instagram account).

— L —

1 Canon ME20F-SH
usa.canon.com
$19,999

»> Infrared cameras are useful while shooting in
really dark conditions, but the resulting videos are
usually more creepy than visually impressive. The
Canon ME20F-SH is a high-ISO shooter that can
capture crystal-clear images in near pitch-black
conditions. Billed as the company's first ultra-high-
sensitivity multi-purpose camera, the ME20OF-SH

uses a full-frame, 35mm CMOS sensor with massive

photosites, enabling it to record quality HD video
(little to no noise, accurate colors) in settings with
illumination as low as 0.0005 lux - about the same
level as an overcast night...

BeoSound 1
bang-olufsen.com
$1,495

»»> The BeoSound 1is a portable wireless speaker
that offers 360-degree sound and integrated access
to a variety of audio sources. The speaker can
connect with Google Cast, AirPlay, and DLNA (as
well as the free BeoMusic app) via Bluetooth or
Wi-Fi, and it boasts integrated access to Spotify,
Deezer, QPlay, and internet radio Tuneln. The
Acoustic Lens Technology results in room-wide
sound that promises delivery in volume and detail,
and the touch-control feature has a built-in
proximity sensor, which activates the speaker

in preparation for your control.
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>>>Feature

macOS

Timesavers

\ Sierra is the Mac's smartest,

most powerful operating system
ever. Nik Rawlinson shows how
Its many new features can help
you be even more efficient...




0S X, Apple seems to have hit fast

forward with the move to macOS
Sierra. It’s been heavily influenced
by iOS, with Siri, Apple Pay, and a
clipboard across macOS and iOS
devices, all of which look set to make
us more productive than ever. It’s
even got a new name, which adopts
the conventions of Apple’s other
operating systems.

Many of the built-in tools, including

Photos, Messages, and iTunes have
been redesigned or blessed with

FOLLOWING A FEW years of tweaking

Essential macOS timesavers

powerful new features, and there’s a
new file system on the horizon, too.
Back in issue 122 we looked at tips
and tricks that help you get the most
out of these new features — and plenty
more besides — and this month we’re
going to zero in on the ways that Sierra
can help you work even smarter than
before. We’ll be showing you how you
can get more done in less time and
with less effort, how to stay focused on
your screen rather than your keyboard
and mouse, and how you can benefit
from all of the hard work that Apple
has put into revamping what we
believe is the world’s best desktop OS.
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The big
changes

The key new
improvements
in macOS Sierra

PHOTOS
“ Photos boasts clever
facial recognition, plus
object and scene detection
and the ability to search by
name. Memories revisits
photos based on criteria
such as event, location or
people, and can play them

as slideshows. There are new

albums for special photo
types taken on iOS devices,
including depth-effect

> What if | can't run it?

Apple has a well-earned reputation for
making computers that last a long time,
largely because it doesn't often change
the system requirements when moving
from one operating system to the next.
With Sierra, though, it has raised the
minimum requirements for the first
time since 2014's Yosemite.

20 MAR 2017 maclife.com

portraits from iPhone 7 Plus.
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It doesn't ook 30 nice in Boston
MA, US for this evening  down 1o
B9°F with thunderstorms

S WEATHER

Boston, MA, US

Tomorrow, Sep 20
Scattered Showers
Chance of Rain: 40%

- SIRI

~Access Siri through

the menu bar, its Dock icon,

or by holding [$]+Spacebar. It
doesn't work with the “Hey Siri"
command like iOS because, as
Phil Schiller commented, Macs
go to sleep and don't feature the
hardware they'd need to hear
you while snoozing. It goes
beyond answering simple
weather queries, too, to find
files, send messages, navigate
your notifications, and more.

To run Sierra, which is free from the
Mac App Store, you need at least 2GB of
memory and 8.8GB of available storage.
You need a MacBook or iMac from late
2009 or later; a Mac Pro, Mac mini or
MacBook Pro from mid-2010 or later;

a MacBook Air from late 2010 or later;
or a 12-inch MacBook.

OPTIMIZED STORAGE

If you're running out of storage,
this feature suggests settings you can
change to free up space, such as
automatically moving old files to iCloud
until needed (they appear where you
left them), duplicate file detection,
and telling iTunes to delete watched
movies. See p30 for more.
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DESKTOP & DOCUMENTS

You can store Desktop &
Documents folders in iCloud Drive,
making them accessible in iOS's iCloud
Drive app (in iOS 9, Settings > iCloud >
iCloud Drive). It's then easy to share
files, though you can only open them
if there's a compatible iOS app.

If your Mac is too old, you won't
be able to install Sierra - not officially,
anyway; there are third-party tools to
force the installer to run, but consider
trustworthiness and that stability isn't
guaranteed. Still, there'll be security
updates for El Capitan for a while yet,
so make sure you keep it up to date.



9 ways to better
productivity

DICTATE RATHER THAN TYPE

We’re great fans of Nuance
Dragon (nuance.com), but don’t
forget macOS has dictation built
in, which you can enable in the
Keyboard preferences pane.
Invoke it by pressing [ twice.
By default, voice recordings are
sent to Apple’s server for
transcription, which returns
written words to your app; enable
Enhanced Dictation if you prefer
it to be done on your Mac.

FIND SPECIAL CHARACTERS

Holding down certain keys
reveals variations on their
character, but you need to know
which offer this. Turn on “Show
keyboard and emoji viewers in
menu bar” in Keyboard
preferences, click the new icon,
pick “Show Emoji and Symbols”
to reveal a grid of characters,
then double-click one to type it
in the app you’re using. Choose
“Show Keyboard Viewer” to
reveal an on-screen keyboard;
hold combos of Alt, (3], [¢] and [
and it’ll show keys you can press
for special characters; holding Alt
alone turns some keys orange and
labels them with diacritics; press
one to reveal characters that can
carry that mark.

CROSS-DEVICE CLIPBOARD

In Sierra and iOS 10, you can
copy something on one device
and paste it on another; each
must have Bluetooth and Wi-Fi
on, be signed in to the same

iCloud account, and have Handoff
enabled (in System Prefs >
General and Settings > General >
Handoff). This can take a few
seconds to sync, so if your first
attempt to paste fails, wait a
moment and then repeat.

COLLABORATE IN iWORK
Pages, Numbers, and
Keynote now support real-time
collaboration across iOS, macOS

and iCloud.com web apps. To
invite people to work on a doc,
click Collaborate on the toolbar
and enter email addresses or
phone numbers of people you
want to work with.

Fancy going for a

FOCUS WITH DARK MODE
In the General prefs pane
you can make the menu bar and
Dock dimmer, helping you to
focus better on editing images,
say. (Spotlight’s affected too,
but not Notification Center).
Use the item above that to set
the highlight color for controls to
graphite and dim the colored
window controls.

5

TABS ALMOST EVERYWHERE
In Sierra, many apps that
can create multiple windows

automatically gain the ability to
organize them in tabs. Look in
the Window menu for commands
to merge all windows or switch
the selected tab to a window.

RECLAIM SCREEN SPACE

Right-click the Dock’s
dividing line and turn on hiding;
the Dock will slide out of the way;
bring the Dock back by moving
the pointer to its screen edge. You
can apply this behavior to the
menu bar in General preferences.

SHARE USING AIRDROP

With Wi-Fi and Bluetooth
enabled, you can share files with
nearby Macs and iOS devices
(as long as they’re a model and
running an operating system
listed at apple.co/2eAz1elc). In
Finder, choose Go > AirDrop and
drag files onto the icon for the
device you want to send them to.

A TIDIER DESKTOP

Double-click an edge or
corner of a window to resize the
window to fill the space all the
way to the matching desktop edge
or corner. Hold Alt as well to
expand in the opposite direction
too; doing this on a corner
expands the window to fill the
desktop. (These do not work with
iTunes.) Drag one window’s edge
into another’s and it’ll briefly
stick to its neighbor to help you
line them up; if you don’t want
them side by side, keep dragging.
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Make the
most of Sierra’s

built-1n tools
New features and helpful
, advancements in familiar apps

combine for great timesavers

ever—evolving collection of apps that greatly
add to your Mac’s total value. Many of them
have gained helpful enhancements in Sierra,
and new features, such as Siri, offer you
fresh ways to work.

Though the bundled apps and built-in
features can each be used in isolation, some
interact to save you time. Sierra detects new
people and events in more apps than just Mail,
and adds them to Calendar and Contacts if that
behavior is enabled in the latter two apps’
General prefs. Let’s look at other fun and
practical things it offers.

THE LATEST operating system comes with an

).

n TWEAK THE MENU BAR

Previously you could move only some
of the icons at the right end of the menu bar.
In Sierra, by holding you can drag almost all
of them into whatever order you want. This includes
Spotlight, which used to be fixed in place. Notification
Center remains the exception; it's pinned at the far
right, though this makes sense given the feature
slides in from the right.

To remove an item provided by Apple, hold [s],
drag it downwards and let go when a cross appears.
For third-party items, look in their menu or their
app's preferences.
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See more images in Satari

images subject 1o copyright

SIRI

wSiri will likely prove to be the biggest
productivity enhancement of all in Sierra.
As well as forecasting the weather, giving
you travel reports and telling you what's
playing on the radio, it understands queries
such as “Show me the Excel files | worked
on this week,” “Launch Word,” and “Send a
message to Bob."” Your interactions with Siri
are shown in a floating window, so you can
continue working in another app while it
walks you through each stage of a multistep
operation - such as sending a message -
entirely by voice.

If you need images to use in a document,
say, you can ask Siri to “Search the web for
Golden Gate Bridge" and then drag results
from its window onto the page. Notice the
results pane has a + in the corner; click this
to add the results, or any other list such as
recent Pages documents, to Notification
Center for reuse.

In Siri's pane in System Preferences, you
can choose another voice for it, change the
mic it uses, and assign a different key
combination to invoke it.



HOW TO Master Disk Utility

Essential macOS timesavers

Disk Utility changes

Disk Utility's window is now fully
resizeable and the app has regained
storage array management. If Optimize
Mac Storage in iCloud Drive's prefs is on,
“purgeable” storage's contents are also
stored in iCloud and Sierra may remove
the local copy if it needs space.

Use RAID Assistant
Choose File > RAID Assistant and
pick the array type to create: RAID O

spreads files across disks to boost speed;

RAID 1 writes all data to all disks for
safety; and JBOD treats discrete disks as
one. On the next page, pick the disks/
partitions to include in the array.

Write optical discs

Disk Utility can no longer burn
DVDs and CDs. Instead, use Finder: insert
a blank disc, select some files, then
choose the Burn command in the File
menu. If you select a disk image, the
command changes to reflect that the
image's contents will be written.

PHOTOS
& There's a new Places album that
reintroduces a feature that was lost in
the transition from iPhoto. It pins your
photos on a world map so you can
quickly revisit them by where they
were taken. There's also a useful new
way to temporarily add short notes
and annotations about edits you intend
to make later. Double-click an image's
thumbnail to view the picture more
closely, then press (<] to edit the
photo, click Extensions in the sidebar
and choose Markup. Use the tools near
the top left corner to draw on the
photo, add shapes and type words,
all of which can later be removed.
When you're viewing a photo (but
not editing it), click Details to reveal
related pictures, which are determined
on the basis of where or when the
photo was taken, or content in it
that the app has identified.
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NOTES
After previously gaining the ability
to make memos that contain more than

just text, the version of Notes in Sierra

(and i0S 10) enables you to collaborate

with other people over iCloud. From the
note you want to share, click the icon of
a person on the toolbar, and enter email

addresses or phone numbers of people you

want to work with. Invitations can be sent
using Mail, Messages, Twitter, Facebook,
LinkedIn, or AirDrop, or by copying and
pasting a link into another app or service.

MAIL

There's a useful productivity addition

in Mail that's easy to overlook. At the top
right of the message list is a circle with

three lines in it; click that to turn on filtering

for the mailbox or search results you're
viewing. Initially, the messages below are
filtered to show only unread ones. To the
left, click the filter's description to set its
criteria, such as whether a message is
flagged, sent directly or copied to you, has
an attachment, or is from someone you've

set as a VIP contact. Click the icon again to

turn off the filter; the app remembers your
criteria choices for individual mailboxes.

° SAFARI

If you're transcribing an event or following a
how-to on YouTube, say, you can pop the video out
of Safari and play it in a screen corner. In YouTube,
right-click a playing video and (without selecting
anything) right-click on it again, then choose Enter
Picture-in-Picture; the video moves into a screen
corner and can be resized and repositioned - hold [s]
and drag it to place it anywhere, not just in a corner.

Aa .

/7 iTUNES

\

7 Like Safari, iTunes supports Picture in Picture,
so you can place video in a screen corner and have
it stick there even if you switch to a fullscreen app.
Since PiP snaps to screen corners, you can quickly
move video out of the way to reach something under
it. iTunes can now show lyrics in its main window and
the MiniPlayer, and you can control playback with
your voice thanks to Siri.




Make more
of gestures

ENABLE SECONDARY CLICK
Though there’s only one
discernible button on Apple’s
trackpads and mice, you can
perform a right-click (known
as a secondary click) to access
contextual menus — enable

it in System Preferences. You
can turn it on for both kinds of
device separately in the Mouse
and Trackpad panes. Trackpads
offer an alternative option of
pressing either their bottom-
left or bottom-right corner

for a secondary click.

DESKTOP NAVIGATION

Swipe left or right between
desktops and fullscreen apps
using four fingers on a trackpad

Choose which gestures work on your
trackpad or mouse; some useful ones
are disabled by default.

or two fingers on a Magic Mouse.
Double-tap (lightly) with two
fingers on a Magic Mouse or
swipe upwards with four fingers
on a trackpad to open Mission
Control and switch to another
window. Turn on App Exposé

in the Trackpad pane and you’ll
find that swiping down with four
fingers shows windows only from
the active app.

DIP OUT OF YOUR APPS

Spread your thumb and three
fingers apart on the trackpad to
move all your windows out of
the way and access the desktop,
enabling access to things you’ve
saved there. If you need to drag
one of those files into an app,
press (] and the Mission Control
key (also labelled [r3] on most
Apple keyboards) after you start
to do so and your windows will
instantly slide back into view.

OPEN LAUNCHPAD

Performing the previous

gesture in the reverse direction

- pinching your thumb and

three fingers together - opens
Launchpad, where you can open
apps with a single click on their
icon, like the Home screen on iOS

Essential macOS timesavers

devices, or you can type to filter
the apps and then select one
with the arrow keys and [</.

SWIPE THROUGH SAFARI

With two fingers on a trackpad

or two on a Magic Mouse, swipe
left or right to go backwards or
forwards through the pages
you’ve visited in Safari. This

also works in Chrome, as well

as in some document-based apps,
such as when viewing PDFs

in Preview.

MAKE USE OF FORCE TOUCH

On a trackpad with Force Touch
(Magic Trackpad 2 and many,
though not all, in MacBooks
since 2015), you can apply more
pressure past the initial click to
pull up extra info about certain
items under the pointer. On a
file icon it previews the file’s
contents in Quick Look; on an
address it shows its location on
a map; and on a word in a web
page or Mail message it shows the
definition and may also provide
links to a matching Wikipedia
page and other online sources.
You can apply this to tracking
codes and flight numbers to

see their progress, too.
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Unlike Spotlight, Launchpad only shows
apps. Like Spotlight, though, you can type
right away to find the one you want.
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Super Sierra Shortcuts

Get to know your function key combos
and you can zip from task to task

r . g

Use a Hot Corner as a
superfast way to lock
your Mac without
logging out.

Force Quit can quickly
tell you which apps
have crashed.

FORCE QUIT

The Force Quit key combo
([se]+Alt+[=]) isn’t a panacea
for whatever ails your Mac,
but it’s the quickest way
to see which apps are
unresponsive; they’re
clearly marked in the list
this shortcut reveals, and
there’s a button to force
the selected apps to quit.

Force Quit Applications

If an app doesn't respond for a while, select its
name and click Force Quit.

B Adobe Reader

M Future Studio (prod) Webstart version New
& Google Chrome

_ LibreOffice

=3 Preview

@ Safari

Command-Option-Escape.
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HIDE EVERYTHING

You may know that [s)+[H]
hides all of the active app’s
windows, and that you can
click the app’s Dock icon to
bring them back. If you have
a screen full of sensitive info
in multiple apps, you might
put the display to sleep using
a method described at apple.
co/2frGvfl, which differ
between models.

SECURE YOUR MAC

When leaving your Mac
alone for a moment in a
shared space, logging out
is an extreme way to secure
it, and it can take a while
for your apps and docs to
reopen if you do that.
Instead, ensure a password
is required to wake from
sleep (in Security & Privacy
prefs) and in Mission

Control’s prefs click Hot
Corners and set one of them
to put the display to sleep
when you move the pointer
there (optionally only while
holding a modifier key
combo to avoid accidental
activation). Triggering this
behavior returns you to

the login window, but your
account is still logged in and
no apps or docs are closed
in the process.

CLOSING AND REOPENING
Hold Alt while clicking the
“x” on a tab in Safari to
close all tabs except that
one. If you accidentally close
a tab (or window), pressing
(se]+[o)+[7] will bring it back;
as of Safari 10, you can repeat
this command to reopen
windows or tabs closed
further back in time, and

in History > Recently Closed
you can reopen a specific
page without having to step
back through all those you
closed later on.
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CHECK YOUR SPELLING

Two useful shortcuts you
should invoke before sending
every email: either press
[]+[¢]+[;] to open the
Spelling and Grammar
window and start a
spellcheck or - our favored,
quicker fix — [s¢)+[; |, which
steps through misspellings.
Some will be nouns and other
words not in macOS’s
dictionary, so you can press
the latter combo to skip
them. Another handy
shortcut if you frequently
type things like “teh”: [an]+[T]
swaps the characters either
side of the text cursor.

MOVE OR COPY FILES
Dragging a file between two
folders on the same drive
moves it from one to the
other, but doing so between
different drives copies it.
Hold (%] when dragging
between drives to move a
file, saving you the task of
deleting the original. Hold

- i L

.....

Alt when dragging between
folders on the same drive to
create a duplicate. Holding
(%2)+Alt when dragging creates
a shortcut (alias) to the
original file.

FIND OUT WHERE YOU ARE
Hold (%] and click the title
of a Finder window to see a
breadcrumb trail of folders
back to the top of the drive
and your Mac. Simply click
an item in the list to open
it. This works on document
titles in many apps, too.
(Microsoft Office apps use
(] instead of []).

SEE ALL OPEN SAFARI TABS
Press [%]+[¢]+(\] (or pinch
together two fingers on your
trackpad) to see thumbnails
of all open tabs to save
clicking through them to
find the one you want, or
use [an|+= or [en|+[ 0]+

to advance right or left,
respectively, along the

tab bar with each press.

NAVIGATE WITHOUT

A MOUSE

When your trackpad or
mouse battery is flat, just
press [«n]+[r2] (add [fn] if the [r2]
key on your keyboard defaults
to being a screen brightness
control) to move the focus to

It's easy to reopen
accidentally closed
Safari tabs.

the & menu, then use the
arrow keys to move left and
right through the menu
headings; [ v] opens a menu,
and (<) selects an item.

FOR WINDOWS SWITCHERS...
If you’ve come from a
Windows PC, particularly one
that has a full-size keyboard
with numeric keypad, doing
simple things like deleting
characters to the right of

the insertion point, moving
to the top or bottom of a
document, or invoking pretty
much any menu command
that involves holding C on
Microsoft’s operating system
can cause much confusion
initially. These docs will

help you to adjust: apple.
co/2fZ006f, bit.ly/
2goaQMO, and apple.
co/2gcHYb3.

iPhone

Using a gesture to
move through Safari
tabs is easier than
clicking a button.
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o Login items
Reduce the apps, background

processes, and server connections that
open at login: in System Prefs' Users &
Groups pane, click Login Items, select

an item, and click the - (minus) button.
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Tailor the
Touch Bar

The Touch Bar is not
only contextual, but
also customizable

HE NEW MacBook Pro’s
TTouch Bar puts contextual
shortcuts at your

fingertips without you having
to recall key combos that
trigger menu items.

In the Keyboard prefs
pane you can set the bar to
display app-specific controls
on the left and an initially
collapsed Control Strip of
system features on the right,
or devote the bar to one or

Are yoms wre pom ment fo qut 88 appinatons
anl log ot now”

b Daakate LS
i mcinde

W QO ater GGG Bch £

the other; based on that
setting, the next one down
sets the bar to show app
controls, the full Control
Strip or numbered function
keys when [n] is held down.

Click Customize Control
Strip to set the shortcuts
the strip contains. Tap the
arrow button on the strip to
switch between editing its
short and expanded states.

In the Keyboard pane’s
Text tab, you can stop typing
suggestions appearing in
the bar for all apps. While
in an app, choose View >
Customize Touch Bar to
find an option to disable
suggestions only for that
one, and sometimes
additional shortcuts you
can add to the bar.

- mlu Ft insert Format Amange View Share Window M

e Reopen at login

Go to @ > Log Out... and turn off
the setting that reopens windows when
you next log in. This can help a lot on
Macs that use a hard disk. Your choice
is saved however you close the dialog.

B Apps' windows

Apps remember their windows
when you quit them; an item in General
prefs changes this, which can make them
reopen faster. To then quit an app and
keep its windows, press [ |+Alt+Q .



Essential macOS timesavers

Customize Sierra
with third-party apps

Here’s our pick of four
essential utilities, as well
as a walkthrough showing
you how you can define your
own keyboard shortcuts to
invoke menu items; this
technique also enables you
to change key combos that
an app’s developer has picked
if you find them difficult
to remember.

has made in Sierra, there are

still plenty of ways you can
enhance the system and its
bundled apps.

A dedicated army of third-
party app developers tirelessly
works on utilities and tools that
either plug the gaps in macOS’s
feature list, or improve upon
what it already offers.

FOR ALL the changes Apple

Affinity Photo and similar apps can hugely
boost Photos' editing capabilities.

A—

$9.99 bahoom.com

O e e $ e—

Free alfredapp.com

$49.99 affinity.serif.com

$4.99 fluidapp.com

This tool brings one of
Windows 10's best features
to macOS: window previews
when you place the pointer
over an app's Dock icon.
HyperDock shows a
preview of each of an app's
open windows, and you can
pick the one you want
rather than bringing the
most recently used one to
the front. You can minimize
windows you don't need
into the Dock by “scrolling”
down over their preview;
they're then overlaid with
a gray no entry sign.
Hovering over iTunes'
icon lets you skip and rate
tracks, and you can adjust
the volume by scrolling.
HyperDock really is a
bargain for its low price.

Alfred provided keyboard
access to your apps even
before Apple came up with
Spotlight, but despite now
facing built-in competition,
it's holding its own due to
its expanding feature set.

While some of its most
compelling features, such
as batch file processing,
attaching files to emails
and 1Password integration,
require the $23 Powerpack
add-on, its flexible core
features are free.

Among the most useful
are shortcuts for looking
up keywords using Google,
Wikipedia and Amazon.
Alfred also provides quick
access to results: (<3 or
+@, @+@ and so on

to pick from the first nine.

Serif's plucky Photoshop
rival has already proved
its worth as a standalone
image editor. However, it's
also a first-class add-on for
Photos, greatly extending
the built-in features.
Under Photos In System
Preferences' Extensions
pane you can click Photos,
and pick which of six tools
to make available: Develop,
Liquify, Monochrome,
Miniature, Haze Removal,
and Retouch. Combining
Affinity Photo's best image
editing tools with Photos'
organization tools does
much to fill the gap left by
Aperture's demise, making
a capable and affordable
workflow if you don't want
Adobe's Lightroom.

If you often use web apps
such as Gmail or
Basecamp, you can turn
them into standalone Mac
apps using this neat tool;
they're still web apps at
heart, but this means they
don't take up a browser tab
and they can be placed in
the Dock for instant access.

You only have to give
Fluid four details: the site
address, the name for the
app it churns out, where to
save that app, and what to
use as the app's icon. The
last of those defaults to the
site's favicon, but you can
pick one of your own.

Fluid isn't only useful for
web apps: you can also use
it for news sites, sports
and social networks.
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Manage your files more efficiently

Store in iCloud

" Documents
&1 GarageBana

iCloud Drive 2852 v
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Trash 418 wa Mac

Reduce Clutter
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If @ menu item you use often lacks
a predefined keyboard shortcut, you can
add your own. You can set shortcuts to
work in a specific app or all of them
(handy for common items). Start by
going to System Preferences' Keyboard
pane and clicking the Shortcuts tab.
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‘ Store all fées and photos 0 (Cloud and save space by
keeping only recently opened filkes and optimized photos
on this Mac when storage space is needed

Optimise Storage ﬂ

Save space by sutomatically removing iTunes fims snd Optimiss
™ Drogr ammes that vou ve aveddy walched from this

Empty Trash Automatically e

Save space by sutomatically erasing tems that heve Turn On.
been in the Trash for more than 30 days.

Sort through documents and other content stored on
thes Mac and delete what s no longer needed

Store in iCloud.

Review Files

A The Optimized
Storage feature
helps free up space.
Go to & > About this
Mac, click Storage,
then Manage. Its
first suggestion can
turn on iCloud Photo
Library in Photos,
and put Documents
and Desktop online.

C Be careful with
this option, which
removes items from
the Trash when
they've been there
more than 30 days;
as long as you use
Trash properly, only
putting things in
that you're sure you
won't need again,
this is a useful auto
space saver.

B The next
suggestion is more
discerning, with
options to only
download recent
email attachments
(or none at all) and
to remove movies
and TV episodes
once watched (you
can redownload past
purchases later.

D GarageBand's
sound library may
be taking up several
GB of storage; select
GarageBand (or
Music Creation) on
the left for an option
to remove it. To get
it back, go to
GarageBand > Sound
Library submenu in
music creation tool.

Yo chungen 8 4 Lo e s e WS
8 rore
@ vasor | Sevaowrs Breros n x

* Sereend -
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What's available

Many shortcuts provided by Apple
aren't active by default. Click through the
categories on the left and scroll through
the items on the right; check whether the
item you want to access quickly is listed.
If it is, simply put a check mark in the box
on its left side.

& rousngTemt [ tot Formmt View Omganize Window Meln
» -

[, en [r—
Open xO
Open wcent -
—~
Cone -w
e xS
Dpicate oxs
Feerare
Move To
Revert To -

Print xe

9 Set your own

Otherwise, click App Shortcuts,
then the + button below the right pane.
Optionally, limit the shortcut to a single
app. Type the menu item's title exactly
as it's written (press Alt+[; ] to type an
ellipsis), then click the shortcut box and
press the combo you want to use.
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>>>Feature

Alan Stonebridge
shows you how to
get the best value
from tailored
suggestions,
millions of tracks
and other great
music features

HILE THERE ARE
numerous other
music streaming

services around,
there’s something to be said
for close integration with all
your Apple devices. You may
already have thousands of
songs stored in iTunes and
simply want the easiest
option. That is, of course,
Apple Music, but what do
you get for your money?
This feature explains its
features, and you’ll learn
useful techniques to help
ensure you’re getting great
value from the service.

As a new subscriber,

you can sign up for a no-
commitment, three-month
trial that won’t cost you a
cent. Perhaps you did that
already when Apple Music
launched in 2015. If you can
set aside your bad memories
of its poor integration with
iTunes and iOS at that time,
you’ll soon see that the
revamped interface makes
Apple Music in 2017 a far
more compelling experience.
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The redesigned
Apple Music has
better iTunes
integration and
clearer navigation.

What is Apple Music?

Your existing library and millions more tracks on demand

HE TIME when
you had to decide

which music to

spend your hard-
earned cash on are a thing of
the past. Apple Music gives
you access to so many
options that you’ll always
have something fresh and
exciting to play, for no more
each month than you might

have paid for each album in
the past.

Apple Music provides
recommendations tailored
to your individual tastes, and
you can search its millions
of tracks manually too, add
them to playlists, and
download them to play
offline. Not everything
available from the iTunes
Store or rival services is on
Apple Music - some artists
have resisted streaming
services. Nevertheless, new
releases are often available
on day one or soon after.
Even Kanye West’s The Life of
Pablo, initially said to “never
be on Apple,” is there.

Apple Music doesn’t mean
leaving behind the collection

you’ve built over the years;
iCloud Music Library puts it
online so you can access it
when you want, without
syncing with iTunes on your
Mac. Apple Music works on
Mac and Windows PCs, iOS,
Apple TV, and Apple Watch,
and even Android devices
running Android OS 4.3

or higher.

Find out below how to sign
up and, if you’re new to the
service, enjoy your first three
months for free. The
minimum term is one month,
S0 you can cancel any time
without worrying about a
long-term commitment.
However, we think you’ll
soon forget about buying
music and keep subscribing.

HOW TO Sign up and subscribe

@ MUSIC

Play & download all
‘the music you
want.

o Start signing up

In iTunes on your Mac or Music
on i0S, go to the For You page (iTunes >
Music). If you haven't subscribed already,
click Choose Your Plan. You can cancel
the subscription you're about to set up
at any time.
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9 Choose a plan

You'll see the three plans (details
on opposite page). Select one, click Start
Free 3 Months, then sign in using the
Apple ID you use for the iTunes Store -
enabling your past track purchases to
appear in iCloud Music Library.

CINEDE
.0800

B Indicate your tastes

You'll be asked to identify genres
and artists you like, used as initial clues
for personalized recommendations. After
this, you'll see the For You feature (see
page 36). If you want to cancel the trial
or subscription, refer to page 42.




What it costs

Get more from Apple Music >>>Feature

Make sure you're not paying more than you need to

co/2iAP6zS

> How to save money

F THE special
. pricing for families

and students

leaves you feeling
a little shortchanged as an
individual, you can save some
money on a year’s service by
paying up front. This will give
you 12 months of Apple Music
for the same price that would
normally only get you 10
months of it.

That works out at $9.25

per month, saving you almost
S20 over the course of a year
and bringing the annual total

down into more palatable
double digits. Of course,
taking advantage of this
requires you to have a
hundred bucks to spare
right now.

You can obtain this
discounted pricing at apple.
co/2egdB1W, as a gift card
that’s delivered as a physical
item or by email. Take care
not to leave the form on that
page set to a three-month
subscription, which gives
no discount over simply
paying monthly.

apple.

You can also pay for Apple
Music with iTunes Gift Cards,
so look out for discounts on
these at online retailers!

You can save
17 percent
on a year of
Apple Music.
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Personal suggestions

Discover artists and tracks picked especially for you

HE “FOR YOU"
feature provides

personalized

recommendations
of music it thinks you’ll like,
based on your listening
habits and feedback. Click
it near the top of iTunes, or
tap it at the bottom of i0OS’s
Music app. You’ll see two
special mixes: one of new
music it thinks you might
like, which updates on
Fridays, and another of
tracks you’ve indicated you
love, which refreshes on
Wednesdays. These are
a quick way to play songs
that fit your overall tastes.

If you have time to put in

a bit more effort, lower down

the page you can explore
categorized suggestions. Note
that the selection of albums,
updated daily, identifies the
basis of their suggestion,
helping you weed out any
that don’t fit your mood.

You heading at the top of the
page. Click Connect there to
read posts from artists and
curators; those you identified
when signing up to Apple
Music, and artists whose
music you’ve bought from

TELL APPLE MUSIC WHICH
SONGS YOU LOVE OR DISLIKE
TO INFLUENCE SUGGESTIONS

Some rows say “See All” at
their end; click those words
on the New Releases row and
you’ll be able to browse
further back by release date.
On your Mac, note the
subsections next to the For

the iTunes Store. On iOS,
these posts are found below
For You’s other content.

To manage who you’re
following, choose Account

> Following (Mac), or tap
Following alongside the
Connect Posts headline (iOS).
To follow someone specific,
enter their name in the
search bar/page, click or tap
them in the results, then
click or tap the ellipsis that’s
displayed near their name
and choose Follow.

HOW TO GUIDE SUGGESTIONS
We mentioned earlier that
items in For You are affected
by your feedback. To provide
information about an item,
whether it’s in your library or
elsewhere on Apple Music,
click or tap on the ellipsis
shown next to it, or press
firmly on the item if your
device has a 3D Touch screen,
and choose Love or Dislike.




> Browse freely

Explore new releases and what's hot right now

HAT IF you want to
n see music that’s

new or hot? In this

case, head to the
Browse page. Like For You,
there are several subsections
listed next to the heading
at the top of the Browse
page. (On i0OS, they’re
listed lower down the page.)
These enable you to browse
what’s new, charts of what’s
popular, videos, playlists
curated by Apple Music’s
editors and third parties
(such as Abbey Road Studios,

Motown, and other brands
both big and small), or you
can browse by genre to find
more specific sounds.

The content in the Browse
section isn’t tailored. It’s
about promoting things on
the basis of being new or
popular. However, the
curation aspect, notably of
playlists, means you can
expect a certain level of
quality. Take time to check
out the specifics of each
subsection. Playlists, for
example, contains a whole

group that’s been picked with
certain activities and moods
in mind, so you’re bound to
find something to help you
chill, spur you on through a
workout, or get a party going.

Videos contains more than
just pop promos. You’ll also
find documentaries and live
shows. In macOS Sierra, you
can easily enjoy long videos
while you get on with other
tasks: click the Picture in
Picture icon on a video that’s
playing to put it in a window
in a corner of the screen.

New Music

NOW 95 The Latest NOW Album

> Find things manually

Listen to exactly what springs to mind with just a few taps

OU'RE NOT limited
to using the For

You and Browse

pages to find
things in the huge Apple
Music library, of course.
Click in iTunes’ search bar
or tap Search at the bottom
of Music on iOS, then ensure
the option to search Apple
Music rather than your
library is selected. Before
you type in the search bar,
check the lists of your recent
searches and others that are
popular among Apple Music

subscribers below it; you may

not need to type anything at

all. You’ll also see an option

to clear your recent searches.
Otherwise, click or tap in

the search bar and then type;

suggestions of what you

might be looking for are

shown in the list; use the

arrow keys and then (<]

to choose one, or continue

typing and then press (<

to display results that

match your entry fill most

of iTunes’ window or your

iOS device’s screen.

FIND LYRICS FOR A SONG
You may not have to search
the web for lyrics to songs
in Apple Music’s library;
they’re included with many
of them. To see them for the
currently playing song, click
the button to the right of
iTunes’ status area, then
click the Lyrics tab. On iOS,
tap the Now Playing bar

and then swipe up on its
expanded view; if a song
has lyrics, they’re shown
just below the Shuffle and
Repeat buttons.

Search

Trending

maclife.com ‘ MAR 2017 | 37



>>>Feature

iCloud Music Library

Make your existing music collection available on all devices

AVING on-demand
u access to millions

of songs is just

part of what an
Apple Music subscription
offers, and you may be
wondering what happens
with all the music that’s
in your iTunes library. You
may have acquired tracks
from the iTunes Store and its
rivals, and imported tracks

Connect your other
Macs to iCloud Music
Library in iTunes'
General prefs.

General Preferences

R BN e

General Playback Sharing Store ot Devices

Library Name: = Music Library
Show Apple Music Features

ICloud Music Library s s spgegms -

Store your Apple Music songs and playlists in iCloud o you
can access them trom all YOUur devices

Add songs to Library when adding to playlists

Show:  List view lickboxes
Grid view download badges
Star ratings

List Size: Medium ™

from CDs or other physical
formats. From the latter type,
you may have music that
isn’t available through Apple
Music or any other download
or streaming service.
Thankfully, the music in

your iTunes library isn’t
confined to your Mac.

Apple Music provides a
feature called iCloud Music
Library that makes your
personal music collection
stored in iTunes available on
all of your devices, including
Windows PCs running iTunes
and Android devices using
the Apple Music app. This is
achieved without you having
to mess around with the
old-fashioned method of
syncing other devices with
your Mac. Instead, your
library there is inspected
and any music that’s also
available in Apple Music’s

> What about iTunes Match?

»>> If iCloud Music Library
is the only part of Apple
Music that interests you,
Apple offers a second,
lower cost service called
iTunes Match for this
purpose at $24.99/year.
To sign up, pick Music at
the top left of iTunes, click

Store to the right, then
click iTunes Match under
Quick Links in the right
column of the storefront.
There's no need to have
both iTunes Match and

To stop whichever service
you don't want, pick

Apple Music subscriptions.

Account > View My
Account, sign in with your
Apple ID, scroll down to
Settings then click Manage
next to Subscriptions.
Near the button that
cancels a service is the
date until which you'll
retain its benefits.
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massive collection is
immediately available to you
on all your devices. This
includes any music you have
bought from other download
store or a physical format.
Songs you’ve purchased
from the iTunes Store are
automatically part of your
iCloud Music Library as long
asyou use the same Apple ID
to subscribe to Apple Music
asyou did to sign in and buy
them from the iTunes Store.

TRACKS APPLE LACKS
Any of your tracks that aren’t
featured in Apple Music are
then uploaded to iCloud,
though they have to meet
some criteria. The time it will
take for all such tracks to be
added to your iCloud Music
Library and playable on all
your devices depends on a
combination of how many
of those tracks you have
and your internet
connection’s upload speed
(often a lot slower than for
downloads). Taking these
into account, it may take
several days for your entire
library to become available
to play on all your devices.

Despite the iCloud in
its name, tracks that are
uploaded to iCloud Music
Library aren’t counted
against your iCloud account’s
storage quota. The only cost
Apple charges is your Apple
Music subscription.

If this kind of syncing is all
you want from Apple Music,
read the box “What about
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This playlist shows tracks that aren't in iCloud Music Library; you get details
of why they're not included, such as Not Uploaded or No Longer Available.

iTunes Match” because this
will save you a lot of money.

Tracks that have to be
uploaded are only processed
if they conform to a few
rules. They must be under
200MB in size or less than
two hours long. Up to
100,000 songs can be
uploaded to your iCloud
Music Library (songs from
the iTunes Store don’t count
towards this limit) and so if
you have more than that in
your iTunes library, you’ll
need to consider pruning
your main iTunes library.
Items that are in a high-
quality format - such as
Apple Lossless, WAV, or AIFF
- are uploaded in AAC format
at 256kbps (the same quality
as tracks from the iTunes
Store), and the original
remains on your Mac.

There are some minimum
quality requirements, too. If a
track is already in MP3 or AAC
format, its bit rate can’t be
96kbps (kilobits per second)
or less; such low-quality
tracks are ineligible to be
added to iCloud Music Library
- see the guide to the right
for icons that indicate this

and other statuses. Bear in
mind that you can use a
Smart Playlist (File > New >
Smart Playlist) like the one
shown in the screen above to
check which, if any, of your
music can’t be uploaded to
iCloud Music Library.

Sadly, there’s a downside
to Apple’s track matching
technology: the track that
plays on your other devices
may not be the version you
expect. It may be a censored
version, for example, even
if the lyrics are only mildly
offensive, as we found with
the phrase “his broke ass”
in TLC’s No Scrubs.

One thing Apple notes,
though not prominently
enough, is that you shouldn’t
treat iCloud Music Library as
a backup. Software glitches or
accidental deletion of a track
from your library aren’t
necessarily trivial to recover
from. Back up your entire
iTunes library to an external
drive, update the backup
periodically, and ideally store
it at another location than
your Mac. SuperDuper is a
good tool for this ($27.95,
shirt-pocket.com).

Get more from Apple Music

Status icons
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Radio

Start Making Sense

PPLE MUSIC'S
debut in 2015 was
joined by Apple’s
own internet radio
station, Beats 1. You don’t
need to subscribe, though
doing so enables you to listen
to shows after they’ve aired,
in full broadcast form or as
playlists of showcased tracks
without commentary. A
subscription also gives
access to themed stations
such as Charting Now and
Discover New Artists.
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View Controls  Account  Window  Help

Internet radio

Soak up cool new sounds or familiar hits with curated online radio

£

TUNE IN
TO BEATS 1

Click or tap Radio.
What's currently
playing on Beats 1
is always the first
thing here. Click or
tap it to listen. To
help you return to
shows you've
played previously,
they're listed lower
down the page.

Charting Now

CATCH UP
ON OLD SHOWS

Click the Beats 1
heading at the top
of the Radio page
in iTunes (or tap
Beats 1 Shows in
Music on iOS) to
see what's coming
up, and to browse
older shows by
anchor or name
and play them.

Welcome 2017

FEEDBACK
FROM A MAC

If you like the track
that's playing, put
the pointer over
the status area at
the top of iTunes
and click the ellipsis
that appears to
indicate you love
or dislike it, or add
it to your library
or a playlist.

FEEDBACK
FROM I10S

Oni0sS, tap Music's
Now Playing bar,
then + to add the
current track to
your library or the
ellipsis to indicate
you love or dislike
it. (On a device that
has 3D Touch, just
press firmly on

the bar.)




HOW TO Add to your library

Middle Cyclone (Bonus Track Version)
Neko Case

Alternative « 28 February 2009 %.

SONG GENRE TIME

. This Tornado Loves You P
2 The Next Time You Say “Forever™ q}

* 1 People Got a Lotta Nerve q’ <
& PalerMaties @ 24
vengeance is Sieeping Anenatve @

Never Turn Your Back On Mother Earth (]

n Add Apple Music to library

You can add items from Apple Music to your own
library to play for as long as your subscription is active.
To do so, simply click or tap Add at the top of an album
or playlist to add the whole thing to your library at once,
or tap the + next to an individual track. By default, tracks
are also added to your library automatically when you add
them to a playlist, which you may not want. Don't worry,
as this can be prevented.
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© Mot in iCloud Music Library
[ Valentine's Day

B Show only downloaded music

Iltems with an adjacent cloud icon are available
in iCloud Music Library but haven't downloaded to the
device you are using, so you won't be able to play them
without an internet connection. While browsing your
library on a Mac, pick View > Only Downloaded Items,
or in Music on iOS choose Downloaded Music from the
category selector (if it isn't listed, tap Edit and put a
check mark next to it) to temporarily hide these items.

General Preferences

L T WO BEe

) Show Apple Music Features

8 iCloud Music Library e I SeaEwg s

Store your Apple Music songs and playfists in iCloud 3o you
can sccess them from all your devices.

{8 Add songs to Library when adding (o playlists

Show:  List view tickboxes
8 Grid view download badges
{8 Star ratings

Notifications: [ When song changes

e Keep items separate

Thankfully, iTunes and the Music app on iOS each
include a simple setting that you can switch off to prevent
Apple Music items you add to playlists also ending up

in your personal library. On your Mac, go to iTunes >
Preferences > General and uncheck “Add songs to Library
when adding to playlists.” In iOS, go to Settings > Music
and switch off Add Playlist Songs. Note that you'll need
to repeat this on each of your devices.

e 4
General Preferences

OEN W KN K-

Library Name: | Music Library ]
[ Show Apple Music Features
(0 iCloud Music Library e sy sygeges e

Store your ADDie Music 30ng1 and playlists in ICloud 30 you
can access them from all your devices.

Add songs to Library when adding to playlists

Show:  List view tickbaxes
{8 Grid view download badges
19 Star ratings &k
ListSze: Medum [
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o Hide download badges

The Albums view in iTunes displays a cloud icon
at the bottom left of the cover of each album that isn't
stored on your Mac. You may find these distracting,
especially in light of the our earlier advice about how
to switch between viewing your whole library and only
what's on your device. To hide the cloud icons, choose
iTunes > Preferences > General and clear the checkbox
that's labeled "Grid view download badges.”
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Unleash the hidden powers of Apple's jukebox software

PPLE HAS made efforts

to tidy iTunes' interface,

but you may notice

the absence of useful
features such as star ratings. Check
out these ways to take control and
make iTunes work better for you.

Access to Apple Music tracks
only lasts for as long as you pay,
and only work in Apple software.
To buy a track for ongoing access
or to play it on another device that
can use AAC-encoded tracks, put
the pointer over the status area,
click the ellipsis then choose Go To
> Song in iTunes Store. On iOS, tap
the Now Playing bar (or press firmly
on it if your iPhone has 3D Touch),
tap the ellipsis, Share Song, and
then Copy. Switch to Safari, hold
your finger on search and choose
Paste and Go. You'll be asked
whether to open the link in the
iTunes Store app.

If you've already added Apple
Music tracks to your library and
want to remove them, choose File
> New > Smart Playlist and set the
playlist's sole rule to “iCloud Status
is Apple Music."” Be wary of simply
selecting and deleting everything in
this playlist without first inspecting
it, particularly if you joined Apple
Music early after its launch; glitches
from this time may have left some
tracks incorrectly attributed as
being from Apple Music.

Indicating your love or dislike
of a track quides the suggestions in
For You, but iTunes’ old five-star
rating system provided greater
flexibility in Smart Playlists. Go to
iTunes' General preferences and put
a check mark next to “Star ratings”
to bring it back. Put the pointer
over a track in your personal library
to reveal a control for rating it, or

To end your
subscription, go to
iTunes, choose Account
> View My Account, sign
in, scroll to Settings,
then click Manage next
to Subscriptions. In i0OS's
iTunes Store app, tap
your Apple ID, sign in

and tap Subscriptions.
In either place, you can
cancel your sub (it
remains active for the
period paid for). Some
features become
inaccessible but remain
visible. To hide them in
iTunes, open

preferences, click
General and switch off
Apple Music; on iOS,
go to Settings > Music
switch off Show Apple
Music. Set up
Restrictions (see

) to hide the
Connect option.

click the ellipsis in the status area
and use the Rating submenu to
rate what's playing. On iOS, go

to Settings > Music and switch on
Show Star Ratings. Tap the ellipsis
on the Now Playing screen or apply
3D Touch to a song in your library,
then choose Rate Song.

Various ways to view your
library are shown at the top of the
sidebar. Place the pointer over the
Library heading and the word Edit
is revealed; click it to choose which
views you see. Clear the check mark
next to any views you don't need,
then click or tap Done.

Playlists from Apple Music
that you add to your library are
listed under a dedicated heading
in iTunes' sidebar. As in many other
Mac apps, putting the pointer over
this heading reveals an option to
hide its contents until you need
them - handy if you find yourself
subscribing to many.

You can use any track from
your personal library to indicate
the kind of music you want to hear,
rather than taking a gamble even
on one of the themed stations found
in the Radio tab. Click or tap the
ellipsis next to a track name and
choose Start Station (Create
Station on iOS) to play similar music
to fit your mood; it'll include music
from Apple Music, not just your own
library. Tap the star in the playback
controls to give feedback on
whether you want to hear more
or less like the current song.



Get more from Apple Music [REgd LIS

Apple Music versus rivals

Compare Apple with alternatives before you commit to it

ATURALLY, rivals to
n Apple Music exist for a

wide range of devices,

from game consoles to
multiroom speaker systems, but
here we compare direct
competitors — those you can
access on Mac and iOS devices,
and often other kinds of devices.
A major reason to stick with
Apple Music is its tight
integration with iTunes and other

Apple devices. Connecting iTunes
to iCloud Music Library so that it
puts your existing music online
takes just a few clicks. However,
Apple Music isn’t alone in
offering this kind of feature.
Notably, Google Play Music’s free
plan enables you to put 50,000
tracks in the cloud.

Each service below offers a
family plan, most enabling up to
six people who live at the same

address to pay a reduced rate
- but check that each person’s
preferred device is compatible.
One thing Apple Music lacks
that the four rivals below offer is
the ability to access your library
through a web browser. You may
not see this as a deal-breaker,
yet it’s nice to have access to
your music where you have
limited privileges - on a work
laptop, say.

SPOTIFY PREMIUM

AMAZON MUSIC GOOGLE PLAY MUSIC
UNLIMITED

$799/month $9.99/month
amzn.to/2jv7TQf google.com/music

30 days 30 days

$1499/month (family  $14.99/month

of 6), $149/year (family of 6)

(Prime members)

No Yes, with ads, inability

to skip tracks, and
personal music locker

THE SPECS APPLE MUSIC
PRICE (ONE PERSON)  $9.99/month
WEBSITE apple.com/music
TRIAL PERIOD 3 months
ADDITIONAL PLANS  S$14.99/month
(family of 6)
$4.99/month (student)
FREE VERSION Beats 1radio and
Connect access
AVAILABLE SONGS Over 40 million
FILE QUALITY 256kbps AAC
OFFLINE PLAYBACK  Yes
PUT YOUR Up t0100,000 tracks
PERSONAL LIBRARY  (+ what you've bought
ONLINE from the iTunes Store)
MINIMUM SYSTEM Windows 7,08 X10.9.5,
REQUIREMENTS i0S 8.4 or Android 4.3
WEB PLAYER No

40 million 35 million

Unspecified Unspecified

Yes Yes (purchased tracks)

Up t0 250,000 tracks  Up t0 50,000 tracks
(evenon a free
account)

i0S 9, Android, Mac, PC,  Windows XP, 0S X 10.5,

Amazon Echo, Amazon  Linux, i0S 7, or Android

Fire tabletsand TV,or 2.2 w/OpenGL ES 2.0

Sonos support

Yes Yes

$9.99/month $9.99/month Premium
$19.99/month HiFi

spotify.com tidal.com

30 days 30 days

$14.99/month 50% off additional

(family of 6) subscriptions (up to 4

$4.99/month (student)  extra family members)

Yes, with ads, and with  No

shuffle-only playback

on mobile devices

Over 30 million Over 40 million

0gg Vorbis, 320kbps 96kbps AAC+ or

(96kbps and 160kbps ~ 320kbps AAC (Prem),

in the free version) 1,411kbps FLAC (HiFi)

Yes (up to 3,333 tracks) Yes (Premium and HiFi)

n/a n/a

Windows 7,08 X109, Windows 7,05 X109,

i0S 8, Android 4.0.3, or  i0S 8.1, or Android 4.1

Windows Phone 8

Yes Yes




> > Feature

MAKE YOUR MACBOOK

With times tight and

even used Macs staunchly
keeping their value,

Nik Rawlinson reveals
how to make your current
setup last longer

EVERYONE LOVES getting
a new computer, but with
4 the holiday season just
behind us and constantly
rising prices, you’re
probably asking how you can put off
upgrading a little while longer. Here’s
where we’ll give you the answer. So
long as you’re running an Intel-based
MacBook, MacBook Pro, Air, or desktop
machine from 2012 or later, there’s a
lot you can do to make it last longer.

In this feature, we’ll walk you
through some of the most practical
tweaks and component upgrades you
can perform on a Mac of this vintage
- with a particular focus on notebooks.
None of them is particularly tricky or
overly expensive.

We’ll start by showing you how to
diagnose what’s making your machine
run slowly, so you know what needs to
be looked at. We’ll move on to which
parts you can — and can’t — upgrade
while keeping the bulk of your Mac
intact, and finally tackle macOS, with
tips for refreshing and, if needed,
reinstalling from scratch.
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LAST LONGER

e

In Activity Monitor, switch between
the various tabs above the activity
table to monitor which parts of your
system are under strain. This will help
you identify which upgrades will
return the greatest dividends.
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Component ™ Zone e
COStS ‘$437,500 ;$6,328,125

—— $105,000 $859,375
>>> WHILE MACBOOK prices have been ' '
fluctuating, component costs have been $11,200 | $103,880
steadily falling. This can change as global ' [
currencies rise and fall, but it certainly $1,120 $30,875
makes a strong case for upgrading parts i ‘ |
rather than a whole computer if you're S $1,107
on a tight budget. The chart opposite ' [
tracks the changing price of memory and $189

storage from 1980 until the present day.
$12

$5.50
$4.94
$4.37

$4.50 *

*self-calculated average online price

Average Cost of Hard Drive Storage
2016 Statistic Brain Research Institute, publishing as Statistic Brain

Average Historic Price of RAM
2015 Statistic Brain Research Institute, publishing as Statistic Brain
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Recognizin
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Diagnose problems and
identify which components
are underperforming the most

BEFORE SPENDING cash on upgrades,
you need to know it’ll be money well
spent. Slow-running Macs aren’t always
hampered by overloaded processors —
something you can’t upgrade, in any case.

More often they have insufficient memory, or a hard
drive that’s so full macOS can’t write cached files to disk.
The exact reason for any slowdown will almost always be
specific to your machine, so this is one occasion when
turning to Google isn’t the best solution. Instead, use the
tools we recommend here, or fire up Activity Manager (in
the Utilities folder) and work through the various tabs
until you’ve identified the bottleneck.

Click the column headings to sort your active apps
according to how many resources they’re using; for
example, if any are hogging the CPU, check for an app
update and, if this doesn’t fix the problem, consider
switching to a lighter-weight alternative.

ra

 BEROERE LT QWA my

HOW TO Assess the slowdown

WDC WOI0SVX-00.CITD Media

n Storage space

Open & > About this Mac, click
through to Storage and compare the
capacity and available space of your
primary drive. If you have less than

15 percent free, macOS will have trouble
organizing itself - free up some space.
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Launch items

Open System Preferences' Users
& Groups pane, select your account, and
the Login Items tab. How many things
launch when you enter your password?
Each one consumes resources. Reduce
this number to the bare minimum.

B Disk integrity
Apple-provided storage can
self-diagnose some problems. Open Disk
Utility, select your primary drive on the
left, and check SMART status in the table.
Anything other than Verified indicates a
problem, which could slow your Mac.



———

RAM test
>»> Small chunks of memory can corrupt, ﬂ‘ Q _4
which may impact performance. Your . _

Mac will notify you of serious memory S
failures through a series of startup e
beeps, and ignore minor flaws. If you & scigmnciiae
suspect memory might be in the early
stages of developing a problem, use
Rember (bit.ly/2gySvxd) to test the
chips in your machine. The launch
screen uses traffic signals to indicate
its status, but even if these are green,
run the full test to double-check.

CPU test

>»> You can’t upgrade your processor,
but you can check that it’s healthy and
not being hogged by greedy applications.
iStat Menus (bit.ly/2haSMor) puts
graphs on your menu bar that help you
keep an eye on resource use; click them
to see which applications are consuming
the most resources. Click the SEN menu
to display the temperature of your
various components. If the processor is
running hot, take it to a service center
and ask them to renew the thermal
paste. Overheating processors can cause
unexpected shutdowns.

Battery test

>>> Batteries don’t last forever. Over
time they lose their ability to hold a full
charge, and their constituent cells can
die one by one, which you’ll never

recover without replacing the battery F a7 man
wholesale. Use coconut Battery g e Tt
(bit.ly/2hoXmrQ) to check the health /[ 202 man
of your battery. Check Design Capacity, .

which is its factory-fresh state, and ——
Maximum Charge, which is what it can i
take now. If there’s more than 50 e ma

percent between these, follow our
battery replacement tips overleaf.

Meet your
diagnostic toolkit

Hardware test

Your Mac has a full diagnostic
suite built in. Hold (D] while
rebooting to launch Apple Hardware
Test, then click the Test button.

9 Diagnostics
On Macs introduced prior to
June 2013, the same reboot shortcut

launches Apple Diagnostics, which
runs an automated test sequence.

AVG Cleaner

AVG Cleaner (apple.
co/2h2iyha) identifies lost and
wasted space on your drive, and
enables you to remove clutter so
you can reclaim it.
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Change core
components

Don't trash it... upgrade it!
Here's how

BY NOW you should have a good idea
of which parts of your current setup
are coming under the greatest strain
- but don’t run off to the Apple Store
just yet. Although you might consider
your Mac to be a sealed device, it’s not, and there
are plenty of upgrades you can effect yourself.

If you don’t have confidence to crack open the
case personally, an Apple Authorized Service
Partner will be able to help. You can look up your
closest outlet at locate.apple.com. Bear in mind it
doesn’t need to be an official Apple Store, either;
the third-party stores recommended through that
link are all authorized and overseen by Apple itself.

GETTING THE GOODS

You can source components from a wide range of
mainstream outlets, including Amazon and
Newegg, or head for specialist Apple-focused
component shops. iFixit (ifixit.com) can identify
compatible parts when you enter your serial

RAM Recommended buys

.-
p—— a " ©
— B ¥«
9
. -~ o
o g°
Lk o]

Apple maintains a comprehensive list of Authorized Service
Partners who can help with more challenging upgrades.

number. You’ll find this engraved on the case or
on the About this Mac pane (open this from the &
menu). It will also point you to its huge number of
free online guides and problem-solving techniques
for your specific model.

If you only need an SSD or memory upgrade,
check out Crucial’s system scanner (crucial.com).
It’s free to download, and any components bought
on the back of its recommendations are guaranteed
to be compatible.

One final note: bear in mind that in many
systems Apple has made performing aftermarket
upgrades impractical, by soldering the memory and
storage directly onto the motherboard - effectively
making them impossible to remove. So you may
find that some of our recommendations below
aren’t available for your model.

e

g
=
m
m
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]
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CRUCIAL 4GB KINGSTON 8GB
DDR3-1066 KIT DDR3 KIT

$42 $55

crucial.com kingston.com

This maxes out
the memory in a
13-inch, 2GHz Core
2 Duo MacBook,
yet costs less than
$50. You'll need to
dispose of what's
already fitted.

Early Unibody
MacBook Pros can
be upgraded, and
this 8GB kit from
Kingston, rated at
1333MHz, will once
again provide the

max possible RAM.

CORSAIR 16GB
DUAL CHANNEL
DDR3L SODIMM
$130

corsair.com

This ultra-fast
memory will
work with most
upgradeable
MacBook Pros,
iMacs and Mac
minis after 2011.



HOW TO Replace a Mid 2010 MacBook Pro's battery

Get the

case off
Disconnect your MacBook
from the power outlet and
let the battery run flat. Use
a Phillips #00 screwdriver
to remove the 10 screws
that secure the underside of
the MacBook case. Keep
them safe while you slide
the bottom plate slightly
towards the hinge and lift it
up from the opposite side to
reveal the innards.

e Unscrew

the battery
Use a Y1 tri-wing
screwdriver to remove the
screws at either end of the
battery - these secure it to
the chassis. You'll know
which ones to use as they're
directly connected to the
battery itself; don't touch
others. If you don't have the
necessary tools, iFixit has
them available separately,
as well as in toolkits.

SSDs Recommended buys

KINGSTON
DATATRAVELER
MICRODUO 3C
$70 for 128GB
kingston.com
You can't upgrade
the memory or
SSD in the two
most recent
MacBook lines,
but the microDuo
Flash Drive fits

into the USB-C
port to provide
up to 128GB of
removable
storage.

SANDISK ULTRA
11120GB SSD
$90

sandisk.com
Lower-capacity
SSDs are perfect
for ageing
machines used for
office tasks rather
than games and
video editing.
Perfect for those

B Disconnect
the battery
With the hinge of the
MacBook away from you,
you'll find the battery
connector to the right of the
memory module. Lever it up
from the logic board using a
plastic spudger (which is a
bit like a small spatula).
Don't be tempted to use a
flathead screwdriver - you
want to avoid touching the
logic board with any metal.

on a budget, this
costs less than
$100 while still
giving excellent
performance.

CRUCIAL MX300
SATA 2TB SSD
$550

crucial.com

Feel like going

for the ultimate
storage upgrade?
This is expensive,
sure, but it's also
capacious and
fast, so represents
a significant

ANKER -

|y

o ReFIace the
battery

You can now lift out the
battery and dispose of it
responsibly (check your
local area for battery
recycling facilities). Source
a replacement battery from
a specialist supplier like
Anker. Replacing batteries
in pre-unibody MacBooks
often requires no more
than unclipping and
swapping them out.

futureproofing
upgrade for any
compatible
MacBook (or any
other Mac!).
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macOS Sierra
What can your Mac do now? Just ask.

HOW TO Re-install macOS

macQS Sierra

D

- ——

Reinstall...

Recovery mode

Refresh
macOS

Running OS X or macOS for
several years can leave your Mac
feeling bloated and sluggish

LIKE ANY operating system, OS X and
macOS will eventually slow down
without the occasional reinstall every
few years. Before going any further,
if you haven’t upgraded to macOS
Sierra, check whether your Mac can handle it — and
if it can, upgrade now. MacBooks from late 2009,
MacBook Pros from mid-2010, MacBook Airs from
late 2010 and anything more recent can upgrade.
Check Apple’s requirements at apple.co/2gztXnN.
If you’ve already installed Sierra, it’s so new it
should still be running at optimum performance,
as Apple will have performed some routine
housekeeping at the point of installation. Keep
our walkthrough on reinstalling it stored for later
reference, and follow the advice right for removing
other unnecessary data. And always back up first!

macOS Sierra

- [P —

...and wait

Hold [3¢]+(R ] while restarting your
Mac to boot into Recovery mode. Keep
them held down until the macOS utilities
window appears. Pick Disk Utility and
wipe your boot drive, with Mac OS
Extended selected on the Format menu.

50 MAR 2017 maclife.com

Quit Disk Utility and pick Reinstall
macOS. You'll need to be connected to
the internet so the installer can check
your eligibility for the operating system
and then download the installation data.
Specify the drive you've just formatted.

B Installation time depends on

your Mac and the speed of your net
connection, so go and do something else
while it completes. Once it's finished
you'll need to set up your user account
and re-enter your iCloud credentials.



Make your MacBook last longer

Useful speed-up tips

There a few day-to-day things you can do to ensure top speed

Reclaim disk space using Sierra’s

built-in tools

>»> Open About this Mac,

click the Storage tab and then
Manage... Click Review Files in
the Reduce Clutter section and
organize the results by Last
Accessed date. Archive the
oldest files to external media
by clicking the magnifier that
appears beside their names to
reveal them in the Finder, and

you’ll be able to reclaim the
space they occupied.

If you no longer need them,
click the x to delete them.
(Don’t forget to empty the
Trash afterwards.) The more
free space you have, the better,
as macOS needs to use some of
it to cache data that it can’t
store in RAM.

Uninstall apps
completely

>>> Deleting an app from the Applications
folder removes the executable, but can
leave extra data and background routines
in place (and running). Delete them fully
using AppZapper (appzapper.com), which

is free for the first five uses.
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Got a broken port?

»> Fixing a broken USB port
requires a complete logic board
replacement. You can easily
find these online from the likes
of Amazon, but fitting one
requires soldering, a steady
hand, and a certain amount

of expertise (iFixit rates the
process as “Difficult”). Before
you start work, though, check
it’s not a configuration issue
by rebooting while holding

Alt+¢]+[3] to reset the System
Management Controller (SMC).
Re-test the port after rebooting.

Replacing the MagSafe port is
easier as it’s a simple matter of
unplugging it from the logic
board. It’s still a 20-stage
process, though, which requires
the almost complete
disassembly of your MacBook
and the use of several tools for
10 differently sized screws.

Keep your apps
up to date

»»> Check the App Store
regularly for updates to your
apps. As well as adding
features and fixing security
issues, updates frequently
improve performance as
developers take advantage of
new software. For applications
that you downloaded and
installed outside of the App
Store, check out AppFresh for
Mac ($14.99, metaquark.de/
appfresh/mac), which
identifies what software
you're running and performs
regular checks for updates.
Several manufacturers,
including Adobe (with Creative
Cloud) and Microsoft (with
Office), check for updates
automatically. Although it's
tedious installing them when
you need to get on with your
work, make a point of doing
so after quitting each app so
your Mac remains in the best
possible shape.
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Subscribe to

Mac|Lifes®

Ahead of the curve, and endlessly entertaining...

Choose your
perfect package

GET THE DIGITAL EDITION GET THE PRINT EDITION

INTERACTIVE
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FEATURES
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SPECIAL :
Subscribe
OFFER now and get

0%
OFF

Adobe Creative Cloud
Photography plan
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Notion Email Intelligence

Terrible name, pretty good app

It's nice to be
able to see at
a glance which
emails need
chasing up.

Free Developer Notion Al, notion.ai

Platform Universal Requirements iOS 9 or later

Email is a pain in
the apps. It’s hard
to find something
that suits your
specifications - perhaps you
use it for keeping in touch with
family, or for your job, or for
running a business, but
whatever you use it for, it
always feels like the app is
optimized for someone else.
Notion Email Intelligence
apparently “learns your
behavior” to tailor its service
to you. It certainly works pretty
damn well, especially for
something that’s free. The
main draw of the app is that
it uses artificial
intelligence to figure
out who and what is

G Dan Marshall ssied

CoTT—IT)
So V do it recely and 2/ | get
S0% of all the money *olary*?

important to you. It’s
not entirely obvious
how it does it, but
after 25-60 minutes

of thinking about it
when you first set up
the app, it does pretty
well. It’s a little creepy
having a list of “people
that are the most
important to you,”
especially if it’s a

—
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business email account
and it starts rating

your clients as 10/10 in terms
of closeness, but sure. It works.

You can, with just one swipe,
archive, flag, and mark emails
as read. Once you get used to
which direction does what, it
makes going through emails
an absolute breeze. There is
a “Radar” tab, too, which is
absolutely fantastic (as long
as it works) — it picks up on
questions within your emails
and flags them up for you,
telling you to respond ASAP
and monitoring other people’s
delayed responses. It even
prompts you to respond to
new questions within a
certain time, presumably
to get better at email!

Notion has some issues,
mostly to do with its
simplicity. It’s hard to figure
out how to tell the app who is
important to you if it’s already
decided that they aren’t.
“Unimportant” emails are
gray, and can be archived in
bulk, but if there are important
emails in there you might
accidentally archive those, too.
You can also filter by which
emails are starred, but not by
unread. There are also options
like “Insight Signature” which

People 4

Andi
Hamilton

Wed

Most Active

Find out who you've emailed most in
a month. Why? No idea... Why not!

offers to add relevant statistics
to “encourage responses,” but
that’s terrifyingly vague.

Allin all, Notion Email
Intelligence — despite being
slightly obfuscated by its
minimal design - is an
excellent way to manage email,
even if it’s perhaps best paired
with another email app to
make sure nothing slips
through the cracks.

THE BOTTOM LINE. A useful,
thoughtful email app that
makes sure you only see the
most important messages.
KATE GRAY

NOTION EMAIL INTELLIGENCE
Email filtration that actually works

A simple, easy-to-read design

Radar is a fantastic addition

D Not as customizable as it could be
GREAT



Streaks Workout

The workout app that needs some work

$2.99 Developer Crunchy Bagel, streaksworkout.com

Platform Universal Requirements iOS 8.2 or later

The idea of this app is that

it can help you with basic
@ fitness by giving you simple

exercises in a workout
tailored to how much time you have
available that day. You try to build your
"“streak" of consecutive workout days,
and watch your improvement over time.
You can already do the tracking parts
of this with other apps (including the
original Streaks app), but the
convenience here is that the tracking
and workout quides are all in one place,
so it's easier to keep up with.

In practice, we're not fans of the way

the app actually works. You're asked as

Tinycards

part of the setup to choose from a library
of exercises which ones you'd like the app
to choose from when building your
routines, but how do you know which
workouts will best help with your
particular exercise goals? There's no
indication of the expected benefit of each
one. And when you trigger a workout,
you're expected to follow the movements
of stick figures going through two- or
three-frame animations. That and a brief
description are all the guidance you get
of posture and range of movement. For
an app that bills itself as a “personal
trainer,” this isn't good enough. At the
very least, it needs videos and more

A flashcard app that's worth remembering

Free Developer Duolingo, tinycards.duolingo.com

Platform Universal Requirements iOS 8.2 or later

Tinycards is the latest
release from the team
behind the popular (and also
free) language learning app,
Duolingo. Those familiar with Duolingo
will find the interface reassuringly similar
- colorful and easy to navigate.
Tinycards is based on the age-old
flashcard system of learning. Pick a
subject (choose from trending, your own
favorites or search), and you'll be invited
to level one. You're presented with a
visual icon card, tap to turn the card and
reveal its description. You can turn the
card repeatedly to commit the image and
name to memory. Swipe the card away to

move on. After two or three cards,
Tinycards will test you. You get a mix of
multiple choice graphics answers,
multiple choice word answers, and typing
the answer in (the tricky one, but you get
the occasional bit of assistance here!).
Get the answer right, and you get a
smiley face. Once you've completed a
level, you move on to the next. A weight
training icon takes you through another
test should you want to consolidate your
learning from a previous level.

The graphics are appealing, the
gesture-based controls are easy for all
ages, and there are literally thousands of
topics to choose from. It would be nice to

Tough testing, trusted ratings

=g

The app fails to indicate the benefit of each
exercise, and needs to offer more guidance.

guidance for its workouts. The app itself
works fine, but without more information,
we don't consider it fit for purpose.

THE BOTTOM LINE. A fitness app
that aims to be flexible, but that stumbles
at the first hurdle with poor instructions.
MATT BOLTON

POOR

B a

There are thousands of subjects, and often
a huge variety of decks within each subject.

get more of a “reward” when, say, you've
completed all levels of a deck. You can,
however, boast about your level by
emailing the link to a friend. You can also
create and submit your own decks.

THE BOTTOM LINE. A simple but
comprehensive and effective learning
app. JO MEMBERY

GREAT
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Putty 3D turns
your iPad into a
full-fledged
virtual sculpting
studio, complete
with support for
Apple Pencil.

Putty 3D

An intuitive digital 3D sculpting app

$3.99 Developer Nga Nguyen, putty3d.com

Platform Universal Requirements iOS 10 or later

Putty 3D’s specialty
is digital sculpting.
Using just a finger,
it’s easy to sculpt,
carve, and model using a
variety of different virtual
materials such as putty, clay,
plastic, and ceramic. Gestures
enable you to zoom with a
pinch, rotate the camera view
by dragging two fingers, undo

with two-finger tap, and more.
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The user interface is
straightforward, intuitive, and
easy to use. Most importantly,
the available tools don’t hinder
the creative process, allowing
creations to occupy the
maximum amount of on-
screen real estate. (There’s
even a setting to automatically
collapse tools while sculpting.)
It's quite remarkable what you
can come up with after spending
only a few minutes with Putty 3D.

For the more artistically
inclined, the app offers full
support for 3D Touch on recent
iPhone models as well as Apple
Pencil, which allows for more
accurate, pressure-sensitive
sculpting. We used both during
testing for this review, and
found the Apple Pencil nicely
suited to smaller details or
fine-tuning your designs

Speaking of finishing
touches, you can change the

Putty 3D's user interface
stays out of the way,
allowing your creative
freedom to bloom.

background to white, black,

a gradient, or image-based
lighting, change the focus

for a bokeh effect, or add a
vignette as needed; you can’t
import existing background
images, however. When you’re
finished, Putty 3D enables you
to export high-resolution
PNG files via the iOS sharing
extension, with or without
transparency if needed.

The app is optimized for
both iPhone 7 and iPad Pro,
which allow for larger objects
and higher-quality rendering
with Wide Color thanks to the
heftier GPU of those devices.
Overall rendering looked
good, but the edges would
occasionally show subtle
blocking at times.

One feature we’d love to see
added is iCloud sync - there’s
currently no way to start a
sculpture on iPhone and
finish on iPad, for example.
The developer is working on
OBJ and STL file export for the
next version, which will allow
sculptures to be imported into
Mac or PC applications, and to
be used for 3D printing.

THE BOTTOM LINE. For
only four dollars, Putty 3D
impressively puts digital
sculpting in the palm of your
hands. J.R. BOOKWALTER

PUTTY 3D
D Apple Pencil, 3D Touch support
Universal build

B 3D renders occasionally look
blocky around edges

B NoiCloud sync
GREAT



Patch: Smart Portrait Editor

An attempt to emulate iPhone 7 Plus portraits

Free (with IAP) Developer Henry Lee, patch.photos

Platform Universal Requirements iOS 9 or later

If you've not made the leap

to the iPhone 7 Plus yet, but
L are keen to achieve stunning

portrait photos with blurred
backgrounds, here's an app that could
help - Patch: Smart Portrait Editor. It's
simple: you open the app, you pick your
picture, it helps you select the subject to
stand out of the background, and then
you can save the result to your Camera
Roll. You won't be able to edit the photo's
colors, crop it down to size, or do any of
the things that we normally associate
with photography apps, though.

The auto-masking algorithm the app

uses to detect what is the subject

BeCasso

and what is the background worked
pleasantly well and only required us

to do a little bit of manual touching up.
Unfortunately, the manual masking tool
can be a little difficult to work with,
especially on smaller images. The size
of the brushes are very limited and
Patch doesn't allow for a lot of zooming
in. That being said, it does work, it just
takes a bit of patience.

It's not a terrible app, but it is very
limited. We've already tried other apps
that give you a little more control and
don't attempt to put a pay-to-remove
watermark on your images. Still, if you're
new to the game, we think that it's not a

Turn your photos into masterpieces

$1.99 Developer DigitalMasterpieces, digitalmasterpieces.com

Platform Universal Requirements iOS 9 or later

s You may not be a digital
Q" artist, but that doesn't mean
«p that you can't experiment
' with the fun of digital art.
There are tons of apps on the App Store
that are geared toward turning your
iPhone photography into pieces of digital
artwork. One of the options we're most
impressed with is BeCasso.

BeCasso is a neat app. It's designed to
create startlingly realistic digital art from
any pictures you take or save on your
iPhone. Using BeCasso couldn't be easier.
You choose an image, you select a couple
of filters, and the app does all the heavy
lifting. You can simulate watercolor, oil,

or acrylic painting styles with BeCasso,
and we had fun trying out all of them.
We do have a few tips for you, though.
If you're going to try out BeCasso, it
seems to favor images that have decent
saturation and a somewhat high contrast
- that is to say, colorful images with a big
difference between bright and dark
areas. While you can use images that
are somewhat more muted, you'll get

the best effect with more vibrant images.

We also suggest using bigger images, as
BeCasso is capable of spitting out high
resolution artwork with no problem.

If you've ever wanted to take a shot
at altering photos to look like digital

Tough testing, trusted ratings

Manually selecting the edges of your subject
can be an awkward process.

bad app to try out if you want to emulate
the DSLR-like background blur of the
iPhone 7 Plus's Portrait mode.

THE BOTTOM LINE. While novice
photo editors might like it, Patch will be
too simple for hobbyist photographers.
AMBER NEELY

OKAY

We love the effect that BeCasso has on
particularly high-contrast images.

artwork, we highly suggest that you
check out BeCasso. It's a great app that
we think most people will be able to
create very cool images with.

THE BOTTOM LINE. Definitely one
of the better photo-to-painting apps
we've checked out. AMBER NEELY

GREAT
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It might look
like a toy, but
Blocs Wave is
deceptively
powerful.
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e Taptoselect abar

l Drag to select a region

Blocs Wave

A great music app with a toy's friendliness

$2.99 Developer Novation/Focusrite Audio Engineering, blocs.cc

Platform Universal Requirements iOS 8.1 or later

Novation knows a
thing or two about
making music - we
love its Launchpad
MIDI controller and Launchkey
keyboard so much, they’re
next to us right now - so any
Novation app is likely to be
interesting. Blocs Wave is
designed for fast music
composition and
recording, and it
delivers: with two
taps we had a fantastic
EDM tune playing.
Blocs Wave is
deceptively simple.
You start with six
hexagonal pads, each
with a different kind
of instrument -
drums, melody, FX,
vocal, percussion and
bass - and if you tap
on the pad it’ll play
a loop. Tap again for

a different one; tap a different
pad for another instrument.
And that’s all you need to
create music.

If you’re familiar with
apps such as Ableton you’ll
recognize the approach: you
create your song as individual
sections and move between
them without duplicating, so
instead of having the chorus
in there twice you just create it
once and tap it when you want
it. Bloc Wave has room for six
different sections, each of
which can have eight
instruments, and you switch
between them with a tap.

It’s the kind of app that
rewards experimentation. Tap
the tuning fork icon and you
can pitch-shift in real time; do
the same with the dial icon and
you can change the tempo. You
can also change the volume
and pan of each track, as well

The app is based around
sets of loops, which you
can slice and edit to get
them just right.

as cutting up sounds to make
them unique. There’s a basic
selection of instrumental
loops, and there are lots more
available via IAPs. You can
also record your own audio.

Bloc Wave plays well with
others, too. It supports Ableton
Link so you can jam in time
with Ableton users on the
same network, and it also
supports hardware input,
Audiobus and AudioCopy/
AudioShare so you can use
it with other music apps. You
can export as AAC or WAV and
specify how many bars the
song should run for, and input
your own sounds via iCloud
Drive or Dropbox as well as
from Novation’s Launchpad
app. Best of all, you can export
it as an Ableton Live project.

If the measure of a music
app is how quickly you can
make something you like
then Blocs Wave scores very
highly: our productivity has
plummeted as we’ve been
engrossed in the app. It’s
enormous fun for amateurs
and pros alike.

THE BOTTOM LINE.
Beautifully designed and
enormous fun, Blocs Wave
is a terrific toy that turns
out to be a useful tool too.
GARY MARSHALL

BLOCS WAVE

Easy to use and ridiculously good fun
Deceptively powerful

Ableton Live compatibility

2 Loop library is quite basic

GREAT



Le Parker: Sous Chef Extraordinaire

If you can't stand the heat, get off the platform

$2.99 Developer Play Pretend, playpretend.com

Platform Universal Requirements iOS 10 or later

We're jealous of this titular
sous chef. Sure, he's been
banished from the kingdom,
ol separated from his one true
love and - horror of horrors, as any baker
reading will appreciate - lost his recipe
for a lighter-than-air meringue. But if he
guzzles down macarons in excessive
numbers, he's gifted with an extra life
rather than medical problems. Lucky jerk.
Le Parker is a relatively simple outing
that's clearly indebted to genre greats
such as Mario and Sonic. You gambol and
jump through deliberately tricky levels
more than slightly reminiscent of the
blue hedgehog’s first outing, hoovering

Phrase Shift

up sugary treats and exploring to find the
pieces of kitchen equipment that will
enable you to rebuild your career. They're
well hidden, so you're unlikely to find
everything on your first run-through.
Levels have multiple labyrinthine paths
to follow, so this exploration fuels
repeated plays.

If we could tweak one element of the
dish, it would be the jumping, which is
occasionally clumsy. You tap A for a small
hop or press and hold for a longer jump,
plus, of course, you're able to double-
jump. It's not quite as easy to control as
we'd have liked, and we found it a bit
more of an annoyance than simply

More cross words than crossword

$1.99 Developer Hyper Hippo Productions, hyperhippo.ca

Platform Universal Requirements iOS 6 or later

For those that love them,
words can be a truly joyful
S playground. Whether that's
a hard-fought game of
Scrabble in which you manage to land
"quixotic” just right across a triple-word
multiplier, or cramming a crossword
together so that your most audacious
guess fits, word games are addictive.
Phrase Shift tries to leverage this
vowel-mangling obsession; essentially, it's
a crossword puzzle with just one clue.
Each puzzle provides you with a set of
words, which act as both clue and answer.
You slide these words so that letters line
up in a column to form the correct

solution. “Freezing cold water?"” Time to
line up the |, C, and E. Next.

And that's it. While there are 120
puzzles on offer (split evenly across three
difficulty levels - plus an additional one
per day), they're all in exactly the same
format. How about more complex puzzles
that challenge you to solve multiple clues
at once? Alas not. When you've seen one,
you've seen them all.

Also - although we'll admit this is an
issue with crosswords in general - the
nature of these puzzles is you'll either
get the clue near-instantly, or just be left
scratching your head through hint after
hint. Your brain is on the same

) SN

If you eat a mega-sized macaron, you puff up,
temporarily gaining the ability to fly.

having one flavor of leap available. The
balance of the recipe isn't always spot-
on, but there's plenty to recommend
Le Parker, especially if you're a fan of
old-school platforming.

THE BOTTOM LINE. This is a solid
choice that's simple in setup yet demands
precision from you. EMMA DAVIES

GREAT

a
Harreld

Tapping “hint" reveals one letter at a time,
with a cool-down timer before the next.

wavelength as whoever wrote that
puzzle, or you're out of luck. With a
half-decent vocabulary, though, you're
likely to burn through the whole game
in less than two hours.

THE BOTTOM LINE. An overly simple
word puzzle game that will fail to satisfy
most crossword fans. EMMA DAVIES

OKAY
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Decorating your
kingdom is
aesthetically
pleasing, but
mostly pointless.
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Super Mario Run

It's-a him, Mario... on i0S

Free ($9.99 IAP) Developer Nintendo, nintendo.com

Platform Universal Requirements iOS 8 or later

Everyone expected
something different
from Super Mario
Run: a handheld
version of the original Super
Mario Bros., or something
more akin to mobile games like
Temple Run. Super Mario Run
is neither, but also sort-of
both. When you have
an audience of
millions, the ones who
are disappointed with
that dichtomy will
number in the
thousands at least.

But it’s not a bad
game because it’s not
what people expected.
It is, objectively, very
good. It’s polished like
all Nintendo games,
it’s very suited to
mobile, and despite
only having 24 levels,
it has surprising depth.

It’s a regular Mario
platformer, but he runs
and vaults small obstacles
automatically, and one tap will
make him jump. If you time
taps correctly, you can make
him do more: spin jumps, wall
jumps, high jumps. Knowing
and perfecting that makes the
game work for you.

The 24 levels in World Tour
each have three tiers of coin to
collect: hard, harder, and
hardest. But already there are
thousands of people who have
beaten the game, unlocking
the three secret levels that you
get for grabbing every coin. It’s
not all that hard, really, as each
level is about a minute-and-a-
half long. So what then?

Then, you play Toad Rally,
which - annoyingly, for a S10
game - costs tickets to play.
You are pitted against a
stranger (or friend from your

We hope you like
Ghost House levels,
because there's way
too many of them.

friends list) as you try to
impress an audience of Toads
with your acrobatic moves. The
better you do, the more likely
you are to win, and the more
Toads join your kingdom and
level up your castle.

It all feels finite, though.
Once you know the levels
inside-out, that’s it. Even
some clever random level
generation, or player-created
levels, might help it feel more
replayable. Hopefully it will
continue to be updated,
expanded and improved upon,
like many of Nintendo’s other
titles, in the coming months.

There is one huge gotcha,
though: Super Mario Run needs
a constant internet connection
to work. That’s fairly
manageable in big cities, but
in the boondocks, or when
traveling arond, it’s nearly
impossible. The game’s need
to be connected to the
MyNintendo system lets it
down more than any other
disappointment you may find
within its colorful levels.

THE BOTTOM LINE. A great
deal of fun, but you might just
devour it too quickly to want to
play again. KATE GRAY

SUPER MARIO RUN
Flawless artistic design
Perfectly reactive to touch
Simple and fun to play

B Requires internet connection
GREAT



Tough testing, trusted ratings

6 apps for meeting new friends

These social apps help you find like-minded platonic friends in real life

Whether you’ve just moved to a
new city, you’re looking to branch
out of your usual social group, or
you’re just shy about meeting
strangers, there are some great
socializing apps for kindling
strictly platonic relationships.

If you want to invite your
neighbors to a house party or need
a local bar recommendation, meet
your virtual community bulletin
board, NEXTDOOR (Free, iPhone).
It’s like your Facebook feed, but

only with people living around you.

Your neighborhood is verified by
comparing your bank card billing
address, and every user is required
to use full names when joining.
The team behind PATOOK (Free,
Universal) is so committed to
platonic friendships that they’ve
developed an Automatic Flirt
Detection (AFD) algorithm that
parses basic sentence structures,
differentiating between “you are
hot” and “the weather is hot.”
AFD also notices when someone

Man 10 +

18w 99 0 i+
Interests

10 +

text

You can use the point system on Patook
to weight your friendship criteria.

BY NOEL DUAN

< Connections

Expiring Connections

Conversations

Sarah

H

You have 24 hours to initiate conversation
with your connections on BumbleBFF.

is repeatedly messaging someone
without getting a response, among
other observations.

BumbleBFF is a sub-feature
of BUMBLE (Free, iPhone), a
self-described “for women, by
women” dating app created by
Tinder co-founder Whitney Wolfe.
While men and women can use
Bumble for romance, only women
can use BFF. Both romantic and
platonic features of the app work
the same way, though; you fill out
your profile, and start swiping on
nearby women who are also
looking for new friends. If you
have a match, you have 24 hours
to message each other before your
connection vanishes.

HEY! VINA (Free, iPhone) is
another location-based, women-
only friendship app that asks you
a series of basic questions, such
as whether you prefer meeting up
for coffee or drinks (or both!).
Connection to Facebook is
mandatory, so your profile is

automatically filled out for you.
You’re encouraged to chat first.
Now, imagine Facebook - but
for dog people only. MEET MY DOG
(Free, iPhone) is a simple solution
to a dilemma well-known to dog
owners: where can I find a friend
for my dog - and myself? In this
private social network, you can
share photos of you and your dog,
find out who else is nearby, chat
with other dog owners, and
schedule playdates with pooches.
Maybe you don’t believe in
judging a book by its cover.
REAL - MEET NEW FRIENDS (Free,
iPhone) doesn’t let you see the
other person’s face until you
match. There’s no gender filter,
either - this optimistic app
matches you solely based on
interests and personality traits.
Once you’ve matched, the app
even suggests local coffee shops
and volunteering opportunities the
two of you could partake in, to get
to know each other better.

Activity

Imagine if your Facebook feed were
populated by cute dogs instead of politics.
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Daily Habits

Keep yourself in check

Free Developer Denys Yevenko, xwavesoft.com

Platform watchOS, Universal Requirements iOS 9 or later

Few things are harder to
overcome than human nature,
which is what often makes
some of us lazy and prone to
avoid work at any cost.

While there is no shortage
of apps to help overcome
these kind of challenges,
Daily Habits is one of the few
with real potential to get a
handle on your routines.

This Universal app helps
users organize, maintain,
and track good habits, while
kicking negative, more
harmful ones to the curb.

Stop, pause, run

With watchOS 3,
you don't need
to pause Workout
when stopping
on a run. Browse
to My Watch >
Workout from
the iPhone Watch
app and toggle
on Running Auto
Pause. When you

come to a stop,
the Apple Watch
will pause.
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From the main iPhone and
iPad app, you can create groups
of users with similar interests,
invite family and friends, share
your progress, and keep in
touch with in-app chat; there’s
also Today view widget and 3D
Touch support.

Naturally, setting up and
scheduling your library of
habits takes place entirely
on your main iOS device,
but once that’s been done,
users will be able to view
the list of habits on Apple
Watch and can act on them
by skipping or marking as
done. By default, launching
the Apple Watch app opens
that particular day’s items,
but you can swipe left or right
to access two days’ prior or
two days ahead.

To make the most of Daily
Habits, you’ll want to spring
for $2.99 Pro upgrade, which
allows the app to integrate
with your iOS calendar, use
Touch ID to protect data,
display more detailed
statistics, sync between other
devices, and most importantly,
purge the ads and banners
from the main app.

@ WATCH

@ 348

% Habits

THE BOTTOM LINE.
Straightforward and easy to
use, Daily Habits helps keep
a positive focus on the things
you need to get done.

J.R. BOOKWALTER

DAILY HABITS

Simple, intuitive way to
keep tabs on good habits

D Mark habits complete or
skip entirely from Apple Watch

B Features such as iCloud sync,
calendar integration requires
in-app one-time Pro upgrade

2 Free version of main app
includes ads, banners

GOOD



Decibel Meter Pro

Make sure audio levels are to hand

99¢ Developer Performance Audio, performanceaudio.com

Platform watchOS, Universal Requirements iOS 9 or later

REOETIEEE Watch apps can be a
’ 8 bit on the gimmicky
side, often with little
utility. For musicians
or audio engineers,
the latest 3.1 update
4 to Performance
Audio’s Decibel Meter Pro could very
well offer enough function.

In addition to being able to measure
sound levels on your iPhone or iPad,
Decibel Meter Pro now includes Apple
Watch support, allowing smartwatch
owners to view the average sensitivity
of nearby audio right from the wrist.
The app features the same slick

AVERAGE

graphics found in the main app, which
faithfully replicates real audio meters.
Unfortunately, the microphone built
into Apple Watch isn't the one used to
measure surrounding audio levels -
you'll need to pull out the connected
iPhone and unlock the screen to view
real-time levels on your wrist. Not ideal,
but you can now place the iPhone
where the audio is without having to
strain your neck to view the display.
THE BOTTOM LINE. Not quite as
useful as it could be, but pretty slick
for a watch app. J.R. BOOKWALTER

SOLID

Marble Watchness

A nice looking, dedicated Apple Watch game

99¢ Developer Alexandre Minard, arwatchexperience.com

Platform watchOS Requirements iOS 10 or later

q Marble Watchness
is one of the latest

I
ll/u 'I'I,r mobile games that
- exclusively play on
: .
"*.:i‘, = prpIe Watch, and
407707 - it's unusual mostly
4 because the game

lacks support for the Digital Crown,

which is the controller most used

to date. Instead, players must tap

on-screen arrows to direct a 3D

marble around a free-floating maze,

collecting colored balls along the way.
The graphics are undeniably

nice, and the game is appropriately

challenging, especially for those with

pudgier digits. We're also giving bonus
points to the developer for making the
required iPhone app have some real
utility - when launched, players can
enter a nickname, reset game progress,
or view rankings for others around the
world. There's even a catchy music
score, which is more than we can say
for the Apple Watch version, which is
absent of any sound at all.

THE BOTTOM LINE. Slick graphics
make Marble Watchness nice to look at;
the game can be frustrating for those
with fatter fingers. J.R. BOOKWALTER

GOOD

Tip like a pro
with Calcbot

Calcbhot

ﬂ Calculate

@ Convert

RESTAURANT PAL

The free Calcbot app is
great for calculations, but also
makes a perfect meal companion.
From your wrist, launch the app
and tap option three, Tip Calc.

CHECK PLEASE

Next, use your finger to
type the total amount of your
breakfast, lunch, or dinner using
the large numeric keypad; tap
the red C key to clear.

20% Tip

BIG TIPPER

Use the Digital Crown to
scroll down, add a generous tip in
five-percent increments, split the
bill with friends, and quickly see
how much each person owes.
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AIRPODS

D Solid sound quality
D They stay in your ears!
B Double-tap inflexibility

B Mic performance isn't
great in loud
environments

GOOD NEmN
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Apple AirPods

The first Apple-branded headphones you'll want to wear

$159 Manufacturer Apple, apple.com

Features Lightning cable for charging, beamforming microphones, optical sensors

and motion accelerometers

managed to elicit mockery from many

people, so let's make a couple of things
clear about its new wireless AirPods right
away: they sound great, and they're
surprisingly comfortable to wear for a
lengthy duration, even if their visual
similarity to cabled EarPods may make you
think otherwise. Unlike EarPods, though, they
didn’t fall out of our ears even once in weeks
of testing, though we can't account for
variations in ear shapes.

The EarPods that come with the iPhone
sound too muffled and lack clarity, so we use
them only as a last resort. AirPods, however,
are delightful, giving good output with our
iPhone set to 50 percent volume - though
background noise can readily leak in since
they don't form an airtight seal. Audio quality
stayed great even as we cranked up the
volume close to max.

Apple's battery-life estimate of five hours
from a full charge appears to be accurate,
and even a little conservative; with volume at
around 70 percent, we saw about 17 percent
of the battery capacity used per hour.

In Settings in iOS or the Bluetooth pane in
macOS, you can customize how the AirPods
behave when you double-tap either earpiece.
Invoking Siri is the default, or you can opt to
play/pause - removing an AirPod also does

ﬂ pple’s previous forays into headphones

this, as long as you leave automatic ear
detection enabled - or take no action at all.
We would have appreciated the ability to skip
a track without speaking to Siri or reaching
for the iPhone; it's also a pity you can't set a
different action for each AirPod.

The silence which sometimes precedes the
chime that tells you Siri is listening feels
more awkward with the AirPods, as you're
reliant on that cue to confirm your double-tap
has worked. That aside, after a couple of days
we found the gesture easy to reliably use.

As for the beamforming mics (there's one
in each AirPod's stem), they're meant to
focus on your voice and filter out other
sound, but our experience was mixed.
Indoors and amid moderate noise outdoors
they worked great, but Siri became highly
inaccurate near noisy traffic.

If you're wondering about the AirPods’
size, yes, we worried about losing them.

Just one day after we received them, we
found their case had slid up and out of a
jeans pocket while we were sitting down -
and it took someone else to point it out.
Blame the case's smoothness, which a little
rubber strip for added friction would fix.

THE BOTTOM LINE. AirPods sound great
and are really comfy, but limited controls and
mic performance may irk depending on where
you use them. ALAN STONEBRIDGE
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Spark for Mac

The impressive mobile mail client arrives on the desktop

Free Developer Readdle, readdle.com
Requirements OS X 10.11 or later, 64-bit processor

Py

TP aBIROSRBLTOSS Ty

Spark's Smart Inbox sorts
incoming messages into
Personal, Newsletter, or
Notification categories.

SPARK FOR MAC

D Four configurable
message swipe actions

B iCloud sync with i0S
version makes initial
setup a breeze

B No contextual menu
shortcuts or color-
coded rules

B Lacks many i0S
features

GREAT NEEN
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Readdle made a splash last year with Spark,
a feature-rich iPhone email app that, while
far from perfect at launch, quickly blossomed
into one of the best mobile mail clients
around. Now Spark is coming to the desktop.

Spark for Mac isn't yet a straight port from
i0S, but successfully checks off most of the
key features, including Smart Inbox (which
automatically sorts incoming messages), natural
language search, Quick Replies, and smart
notifications. The macOS version also syncs
existing accounts, signatures, and other
settings from iOS, which made our initial
setup almost nonexistent.

The app bears more than a passing
resemblance to rival third-party email client
Airmail, which itself sticks to the tri-paned
playbook established by Apple Mail.
Accounts and folders occupy a small dark
sidebar at left, with a list of messages in
the center that can be configured to preview
up to three lines of text. The rest of the
window displays full messages in a threaded,
conversational view. There’s no way to open

individual missives here, although you can
by double-clicking from the messages list.
Navigation is intuitive, but Spark lacks
some of Apple Mail’s nicer features, such
as contextual menu shortcuts or the ability
to make important senders stand out with
color-coded rules.

Spark makes up for this with more
elaborate gestures: swipes can be configured
to perform a total of four different actions
(two each at left and right), including Move
and Move to Spam, which we use far more
than the clichéd Archive option found in
modern email clients. As with Mail, it’s also
easy to move messages between different
mail accounts - something we do daily -
although Spark sometimes took upwards
of 15 seconds to complete such tasks.

For a first release, Spark for Mac is
impressive and, best of all, free. There are
no ads or features to unlock - at least not
yet. Readdle plans to eventually offer in-app
extensions that add new features, and
hopefully deliver feature parity for missing
iOS features such as connected cloud
services and sharing extension support.

THE BOTTOM LINE. Spark successfully
makes the leap to macOS, but work remains
before it’s a match for the superior mobile
version. J.R. BOOKWALTER
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Great Wolt Lodae - Sandusky. OH

Spark can be configured with four different message
swipes, although there's no contextual shortcut menu.



Secrets

Speedy solution for sensitive info

Free ($19.99 Premium) Developer Outer Corner, outercorner.com
Requirements iOS 10.10 or later, 64-bit processor

Like popular Mac password manager solutions 1Password
and LastPass, Secrets securely stores sensitive info. Secrets
for Mac isn’t quite as comprehensive as those older rivals.
Entries can be assigned one of five item types: website
logins, credit card, bank accounts, notes, or software
licenses. By comparison, 1Password offers plenty of
potential categories, including Identities, Driver Licenses,
Reward Programs, and Wireless Routers. Secrets does offer
a password generator and Safari extension to save and
autofill login credentials, although using these isn’t quite
as intuitive. Secrets is now free for up to 10 items, with the
option to purchase a Premium upgrade for $19.99.

We got up to speed quickly by importing more than 1,200
entries from 1Password, a mostly effortless process except
for a single rogue login that kept causing Secrets to crash.
There’s also a companion Universal iOS app called Secrets
Touch that syncs data via iCloud, but in our testing it wasn’t
particularly reliable.

THE BOTTOM LINE. If you want a no-frills, subscription-
free password manager, Secrets for Mac is worth a look —
but watch out for the janky iCloud sync. J.R. BOOKWALTER

SECRETS

D Mac password manager, free for up to 10 items
D Safari extension for website login autofill

B Limited item categories

B Unreliable iCloud sync

SOLID HEN

Later

Reminders with choices

$9.99 Manufacturer Regular SIA, laterapp.co
Requirements iOS 10.10 or later, 64-bit processor

Later is a Mac reminders app that lives in the
menu bar and strips away complexity. Instead of
requiring users to choose a specific day and time
to be reminded about each new entry, Later offers
nine one-click presets. There are choices such as
3 Hours Later, This Afternoon, This Evening, This
Weekend, and Next Week, as well as the option to
choose a specific date. There's the option to use
[$¢] shortcuts to select presets, and record a
shortcut to add new reminders without the mouse.

Reminders automatically sync to other Macs via
iCloud, as well as a free iPhone app that offers the
same simplicity. The first preset can be configured
so “later today" means anywhere from one to
eight hours, but you can't add new presets or
customize existing ones, aside from adjusting
default start or end times. If simplicity is what
you seek, Later delivers - but at $9.99, quick and
simple comes at a price. There's no way to create
location-based reminders, nor do entries sync with
Apple Reminders - Later is a standalone app.

THE BOTTOM LINE. Quick reminders sorted,
but possibly a little too basic. J.R. BOOKWALTER

LATER

Quick reminders app for Mac menu bar

D Nine one-click presets with keyboard shortcuts
B Can't add or customize most presets

B No location-based reminders

GOOD mmmN
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Finish Later review
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AList

This colorful list app knows there's a time and place

99¢ Developer iLife Touch, ilifetouch.com
Requirements OS X 10.10 or later, 64 bit processor

NN UNalBROERTLTORE my

e —

————

Location-based
reminders: never pass
by the store again!

ALIST

Location sensitive
reminders

The price is right

B Almost no initial
setup assistance

B No recurring
reminder setup

GOOD NEmi
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AlList is a simple and colorful list app that
can be used for a variety of tasks, ranging
from work related projects to personal
errands. Is it going to persuade you to switch
from your current list app? Maybe not, but
aside from being pretty, it has a unique
location-based feature. AList comes in both
Mac and iOS versions. To get the most out

of it, you will want to purchase both, but

at 99¢ each, it’s a bargain.

Getting started on AList can be mildly
confusing: the app’s minimalist design
leaves you with almost no direction to start,
aside from creating a task group. After that,
it becomes slightly more intuitive. You create
task groups, and, if you like, subgroups, and then
add individual list items. You can then add
detailed comments to each item, a feature
only in the premium version of other apps, like
ToDoList. Tasks can be identified, categorized,
and prioritized using color coding and
various icons. This is a relatively rare feature:
other apps allow you to pick color schemes,
but stick to an overall monochrome
template. Being able to quickly locate the
urgent red list in a soothing sea of green,
purple, or blue is a definite plus. The color
coding, in addition to being useful, adds a
fun and cheerful note to your devices.

The ability to create groups allows this app
to be useful for a variety of tasks because you
can make your lists as simple or as detailed
as you like. The structure is simple and gives
you a lot of freedom. One potential drawback
is its lack of collaborative features; AList is
not the app you want for group projects since
you can’t share or delegate tasks.

AlList has one stand-out feature: location-
based reminders. The location feature
activates reminders either when arriving or
leaving a location. They can be set up from
both the iOS or Mac versions, as long as
you’re connected to Wi-Fi, and the setup
is similar to that of Apple’s Reminders app,
but with a more appealing layout. It’s a great
feature for anyone with a tendency to go
through their routine on autopilot.

The Mac and iOS versions sync nicely with
each other as well as your all of your devices’
native calendars and reminders, but that is a
feature that should be expected in a paid app.
Unfortunately, AList’s current version lacks
arecurring reminder feature, which is a
shame since daily reminders are a great
tool for forming new habits or adjusting
to major changes in your routine.

THE BOTTOM LINE. This app is a nice tool
and has a few useful features, but lacks
others. This makes it nice to have, but
not a necessity. S. ADRIANE KAYLOR

The ability to customize your lists in AList certainly
makes the app visually appealing and adds clarity.



Mass Rename

A simple batch-renaming facility

99¢ Developer GTrigonakis mac tools, gtrigonakis.com
Requirements OS X 10.8 or later

Mass Rename does exactly what it says; it is a utility meant
to make the mass renaming of files less tedious. The clean
aesthetic and top bar of the interface is reminiscent of
iTunes, making it feel well suited to macOS. The interface
has specific options for photos and music, using as much
metadata as it can pull from the files themselves - if there
is any available — making renaming photos imported from
cameras and SD cards, for example, a lot easier. It really
alleviates the cognitive strain for a lot of file types. For
people intimidated by using Automator or macros for
renaming lots of files, Mass Rename provides a workflow
that is more intuitive, though is perhaps too reliant on the
bare bones approach; the very highlight of its interface -
its clean simplicity - can be initially confusing, before you
figure out what you’re supposed to take action on first. (The
app does provide step by step hints, but these could be
worded more clearly.)

THE BOTTOM LINE. Not as flexible as Automator or
more advanced tools, but does the job and does it well.
KATRIEL PAIGE

MASS RENAME
D Clean interface
D Quick options for photos and media

B Basic utility (renaming files) can be done
using Automator, macros, other apps

B Alittle confusing to begin with
GREAT HEEN

Squash 2 for Mac

Speed up websites and
cut bandwidth bills

$20 Developer Realmac Software,
realmacsoftware.com

Requirements OS X 10.11 or later

Squash is designed to optimize, convert and/or
rename image files for emailing or uploading to
websites and social media, and it does so
exceptionally well. And it's fun to use, too. Using
Squash is simple. Just drag the file or files you
want to optimize over the app window and it'll
start crunching. It can compress JPEG and PNG
images to make them dramatically smaller with no
loss of visual quality, and you can adjust the level
of compression to make it more or less aggressive
in the app preferences or in your Mac's Touch Bar.
There's an option to strip metadata from JPEGs.
Squash can convert files too: PSD, RAW, CR2, and
TIFFs become compressed JPEGs without you
having to open (or own) Photoshop. That makes it
particularly useful for designers who need to send
ideas, works in progress, or finished designs to
clients. Fast, effective, easy to use and with
impressive results, it shines a little ray of sunshine
on a task that's normally dull and dreary.

THE BOTTOM LINE. If you're constantly
uploading images, Squash 2 will save you time and
money. And make you smile. GARY MARSHALL

SQUASH 2 FOR MAC
Easy to use
Fast, funny, and strangely satisfying

Inexpensive

Touch Bar support
AWESOME NEEEN

' Mac|Life
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PRIMITIVE
D Very simple to use

D Adequate custom
options

D Allows creative
interaction

= No saved settings
or undo tool

GREAT

Primitive

Painting with geometry

Developer Michael Fogleman, primitive.lol

Requirements OS X 10.10 or later

hen talking in computer graphics
Wterms, “primitives" are the simplest

shapes a system can draw - circles,
cubes, spheres and so on - from which more
complex designs are constructed. 3D
artists will be familiar with the concept, but
photographers don't usually think this way:
our primitives are square pixels, and we
just throw enough of them at the job for
an acceptable level of dumb accuracy.

Over the years, a lot of work has been
done on how photographic images could be
represented by primitives, not least for the
purposes of file compression. Michael
Fogleman, the science software engineer
who wrote this app, has applied that kind of
thinking to a new take on automatic painting.

Import a picture, pick a type of primitive
- triangles, circles, rectangles, or curves -
and the app works out how to get as close as
it can to the original by overlaying this shape
at diminishing sizes. Click More Options and
you can give it extra rules.

The process takes a little while to
complete, but part of the fun is watching it
happen. It starts with large areas, then adds
detail until you click Stop. The method looks
strikingly similar to how a painter would
work. You can also use the Drawing mode to
do the painting yourself: the canvas starts
blank, and wherever you click, shapes are

Tough testing, trusted ratings

generated, so you could for example build
up detail in key areas, while leaving the
background as big, bold shapes.
Frustratingly, curves tended to spread
far beyond where we clicked - possibly as
a limitation of the algorithms involved - but
other shapes were more responsive. You
can even switch shapes part-way through.

By default, Primitive works on a
downscaled version of your photo, between
256 and 1,024 pixels wide. You can use the
full resolution if you don't mind a lot of
waiting, but 1,024 pixels gave as much detail
as we wanted - so you could also work on a
small area pre-cropped from a scene. The
result can be exported as a bitmap at any
size or, much more interestingly, as an SVG
vector file, which you can then edit further
in an app such as Adobe lllustrator or Affinity
Designer. Even when we let Primitive run until
the image looked almost as detailed as the
original, there were few enough shapes
(thousands, not millions) to edit comfortably
- a remarkable effect.

THE BOTTOM LINE. Turn photos into art
with an unusual and beautifully effective
process of visual reduction. ADAM BANKS
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Life
It's really not a wonderful Life
99¢ Developer MacAppStudio, macappstudio.com

Requirements OS X 10.11 or later

Life's feature set isn't
nearly as complete as
more seasoned rivals
like Day One.

LIFE

Quick-start guide,
easy to use

B No photo import,
places, or maps

B Lacks text formatting
beyond bold, italic, and
underline

B Basic text search
doesn't work

WEAK BN
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Journaling apps are great for capturing life’s
moments so you can look back on events any
time in the future. Popular software like Day
One makes this easy to do from any device,
complete with photos and maps that offer a
more faithful recollection of bygone days.

Life is a new Mac journaling app with
similarly lofty goals, but one that lacks the
overall finesse of more seasoned rivals. The
basic premise is the same: add one or more
daily entries, spicing them up with icons,
emoji, custom tags, location, or marking
your favorite events.

Notably absent from the lineup are
photos, a feature clearly touted in developer
MacAppStudio's marketing but missing in action
from the initial release. Dragging and dropping
JPEG files from the desktop does little more
than add a text-based file path to the desired
image, although you can import a new avatar
image (or change the profile name) via the
app’s settings.

Even if photos were part of Life’s initial
release, the remaining functionality feels

half-baked at best. While you can add the
name of a location, it’s simply a placeholder
- there’s no GPS lookup or data-matching,
but a true “places” feature is in the works.
Text formatting is currently limited to bold,
italics, or underlined, although markdown,
alignment, and real-time word or character
counts are also promised for a future update.

Life works best with multiple entries per
day, which are displayed as a timeline under
the date in the left third of the window.
Search is also quite robust, with the ability to
find entries by date, tags, location, icon, or
emotions; basic text search leaves a lot to be
desired, however, failing to find terms that
are clearly present in the selected day.

We do applaud the developer for making
it easy to dive in with a quick-start guide and
intro video, although these helpful escorts
are inexplicably buried in a Settings tab.
iCloud sync allows Life to work with other
Macs as well as a paid companion iPhone
app, and you can set up reminders to
encourage more frequent journaling.

It’s also easy to print or email entries, but
there’s no sharing to social networks yet.

THE BOTTOM LINE. For a buck, Life makes
lots of promises but has a long way to go
before it can deliver a comprehensive
journaling experience for Mac.

J.R. BOOKWALTER

[

O

We didn't have much luck with basic text searches,
but Life's other power-search tools work quite nicely.



DonY forget 1o wiite the
Floradora reveew'

Floradora

Easy email notes

$2.99 Developer Justin Duke, floradora.cloud
Requirements OS X 10.10, 64-bit processor

This is a nice idea if you use email for storing notes or as

a kind of to-do list. If you want to send yourself a little
reminder to your inbox, instead of firing up the Mail app or
logging onto a website, click Floradora’s icon in the Menu
bar. When you first set it up, you tell it what address it
should be sending to, and what the subject line of its emails
should be. After that, the window that pops up consists of a
text field and send button - type or paste in what you want
to send, hit the button, and off it goes. Easy.

If that sounds good to you, you should grab it. But for us,
it needs a little more flexibility to be truly useful. We don’t
mind that you can’t send to more than one email address,
but the option to switch to another would be nice. We think
the inability to change the subject line is a bigger mistake,
though: it means you can’t label your notes clearly, and
makes it harder to use Rules/Smart Mailboxes with emails
sent from the app. And while you can paste images into
the window, you can’t drag them in from files - a limitation
of its nature as a Menu bar app, but still a shame.

THE BOTTOM LINE. A nice idea, but we need a little more
flexibility to get the most out of it. MATT BOLTON

FLORADORA

D Useful for people who live in their inbox
D Easy and convenient to use

B More flexibility would be useful

B Can't drag images in

GOOD mmmN

Photo Wormhole

Access-all editing extension

99¢ Developer Alexander Zats, zats.io
Requirements macOS 10.12 or later

Photos is a great app, but we've all got a favorite
editing package that doesn't work as a Photos
extension. However, with Photo Wormhole you can
open just about any editing software from within
Photos. Download it via the Mac App Store and
install it via System Preferences > Extensions >
Photos. The interface is uncomplicated, but it isn't
immediately obvious how to access the external
editors; right-click or secondary-click with two
fingers (weirdly, [ +click doesn’t work) to see
"Open with.” Hovering over this reveals the
compatible software. Photo Wormhole recognized
all packages we tried, including Adobe Photoshop,
Affinity Photo, Capture One, and Snapseed. Once
you've chosen, the software opens promptly with
the image showing. After you've finished making
edits, save the image and close it in the software
before returning to Photos, where you'll see the
original alongside the edited version. If you're
happy, select Save Changes (you can still click on
Revert to Original in Photos to undo your editing).

THE BOTTOM LINE. A great choice if you love
the convenience of Photos but miss an external
editing package. ANGELA NICHOLSON

PHOTO WORMHOLE
Great price
Simple to use

Accesses all the main editing software

B Not clear how to access the editors
GREAT HEEN
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ARTISTRY
PHOTO PRO

D Easy to use

D Selective adjustments
possible

= No crop control

= Selective adjustment
process is clunky

GOOD

Artistry Photo Pro

Tough testing, trusted ratings

The fun of Instagram with some

of the power of Photoshop

$19.99 Developer It's About Time Products, helloiat.com

Requirements OS X 10.11 or later

ne of the reasons that Instagram is so
O popular is that it makes editing images

incredibly easy. You don't have to go on
a course or spend hours on YouTube learning
how to use it; you just scroll through a few
options, give your image a tweak and it's
ready to share. Artistry Photo Pro tries to
achieve the same thing in a desktop package
with a little extra control.

The first step is easy, after you've opened
an image, you scroll through the options at
the bottom of the screen until you find one
that you like the look of. Once you've made
your treatment selection, the controls for all
the adjustments that have been applied to
create your chosen effect are shown in the
column on the right of the screen. If you want
you can use them to tweak the image further.
Simple sliders, backed up by clickable
numbers, make the edits easy and a series
of thumbnails indicates their impact. If you
don't like your adjustments, a double-click on
the slider returns it to the default settings.
It's also possible to apply additional effects
by selecting the “Add Adjustment” option at
the top of the right-hand column. There's a
good selection of options available and the
thumbnail makes it easy to experiment, but

a couple of basic controls - crop and
straighten - are missing. However, we're
told that Photos app extension support
is just a few days away at the time of
writing and that will solve the issue.

In addition to making global adjustments,
it's also possible to paint in an effect using
the controls revealed by clicking on the
paintbrush icon to the right of each
adjustment title. There's an option to
detect the edges in your image to limit
the adjustment to specific areas, but
we found this had mixed success. While the
selective adjustment feature can be very
useful, using it can get frustrating because
you have to click on the brush icon twice
every time you want to adjust the size,
hardness or opacity of the adjustment brush,
or switch to the eraser to correct a mistake.
It's also particularly annoying that if you
change your mind about the treatment
that you want to use and click on a different
effect in the bottom row, your carefully
crafted painting is lost.

THE BOTTOM LINE. It's not perfect,
but Artistry Photo Pro is easy to use and
there are some powerful tools available.
ANGELA NICHOLSON
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EXOLENS WITH
OPTICS BY ZEISS

Sharp, wide shots

Frame allows for tripod
and flash attachments

B Very expensive

B Multilens systems
available at this price

GREAT NEEN
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ExoLens with Optics by Zeiss

Life through (an expensive) lens

$200 Manufacturer Zeiss Optics, exolens.com

Features 18mm focal length, lens hood, rubber grips for iPhone 6/6s

lenses for the high-end camera market, but
the iPhone - really? So far, lens-boosting
accessories for the iPhone have been dominated
by manufacturers that don't necessarily make
SLR equivalents. So, when big manufacturers
get in on the act, are they really worth the
extra premium on price?

Here Zeiss has gone for a one-lens solution
rather than a complete lens studio of the sort
you can get for a similar price from the likes of
Manfrotto and Olloclip. Note that ExoLens has a
non-Zeiss lens kit for a similar price to Olloclip/
Manfrotto multilens systems. So, for just one
lens - in this case a wide-angle one (0.6x) - what

Zeiss is world reknowned for making amazing

do you get for the cash? Well, images are crisp,
just wide enough to make landscape shots really
pop, and though the case system looks odd, it
excels with a tight rubber grip that can be slid
off your iPhone in seconds.

We have found other wide-angle iPhone lenses
tend to suffer from a degree of horizon
curvature. The same artefact is found here, but
it's less noticeable than on most lenses. This is
a lovely add-on for an iPhone snapper but, in
terms of price and flexibility, a multilens system
will suit most people better.

THE BOTTOM LINE. We can't argue with the
images or the great case, but wow, it will hurt
your wallet. CHRISTIAN HALL



HP Sprocket

Battery-powered Bluetooth printer

£99 Manufacturer HP, hp.com
Features Bluetooth, Zink zero-ink printing, 1200x600 dpi

HP’s printing prowess is brought to bear on social
photographers in the Sprocket. The small (2.95x%4.57 inches)
device packs in Bluetooth, a lithium-ion battery and just
enough printing technology to allow it to print onto sticky-
backed sheets of 2 x 3in Zink sheets. (Zink is a contraction
of zero-ink - referring to sheets of photo paper which are
embedded with heat-activated CMY layers.) Load the paper,
install the app and you’re ready to go; pairing our iPhone
with the Sprocket over Bluetooth was painless and once the
app is open you can choose images from your Camera Roll,
Flickr, Instagram, or Facebook. The app includes various
editing tools and filters, including the de rigeur washed-out
effect. There are also various emoji-style stickers to add,

as well as the option of including a line or two of text.

We timed a print at just over 50 seconds. Print quality is
merely so-so - it’s unfair to expect terribly good quality but
even so, the banding and blocky color graduations suggests
the Sprocket is more for fire-and-forget fun than the
production of important mementos.

THE BOTTOM LINE. Print quality isn’t the best, but
customizable stickers are undeniable fun. DAVE STEVENSON

HP SPROCKET
B Fun stickers

D Good app

B Mediocre quality
B Fairly expensive
SOLID HEN

Griffin iTrip Clip
Wireless headphones for all

$19 Manufacturer Griffin, griffintechnology.com
Features Bluetooth, playback controls, mic, USB

The obvious audience for this accessory is iPhone
7 users with old headphones that they love: plug
any headphones into the jack on this unit and they
become Bluetooth cans. The iTrip Clip pairs with
your iPhone (or any Bluetooth audio device) and
then plays sound to whatever's plugged into it.
It has its own playback controls - including play/
pause, skip, and volume - and is powered by an
internal battery that charges over micro-USB (an
extra charger to carry, but it comes with a short
cable). Sound quality is good, it's really cheap, and
even includes a mic for calls or Siri (you can clip it
near your mouth). It's also good for home audio or
car stereo systems that you'd like to take wireless.

There is a problem, though: there's a delay on
the audio. This doesn't matter for audio-only stuff,
but it's irritating for video when the picture and
sound are out of sync. If this won't bother you, we
totally recommend it - but if you're an avid mobile
movie fan, it's not the solution you need.

THE BOTTOM LINE. An inexpensive option to
turn wired 3.5mm headphones into Bluetooth sets.
Best suited for audio, not video. MATT BOLTON

GRIFFIN iTRIP CLIP
Sound quality is good
D Inexpensive

Includes a mic for calls
B Delay on audio

GOOD mmmN
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FUJIFILM X-T2
D Greatly improved AF
D Large and bright EVF

D 24.3MP X-Trans
CMOS sensor

= No touchscreen
AWESOME

Fujifilm X-T2

Tough testing, trusted ratings

Can a mirrorless camera really keep up
in the world of fast-action photography?

Manufacturer Fujifilm, fujifilm.com

Features APS-C X-Trans Il CMOS sensor at 24.3MP, 3-inch tilt-angle screen, 1,040,000 dots,

4K video capture

ith the X-T2 sitting alongside the
WX—ProZ as the joint flagship camera

of the brand, Fujifilm believes it now
offers two distinct options for photographers.
The X-Pro2, with its rangefinder design, is
less obtrusive and suited to Fujifilm's range
of prime lenses, while the more SLR-like X-T2
is designed with the brand's growing range of
fast zoom lenses in mind.

It's no great surprise to see the 24.3MP
APS-C X-Trans Ill CMOS sensor that we first
saw in the X-Pro2 is now in the X-T2. Fujifilm's
latest sensor, with its clever filter designed
to eke out even more detail compared to
conventional designs, has delivered some
impressive results.

The sensitivity range covers a modest
1SO0200-12,800, but can be expanded to
1SO100-51,200 - and the good news is that,
unlike the X-T1, this extended range doesn't
force you to shoot in JPEG-only, with raw
capture now possible as well.

The X-T2's electronic viewfinder has also
come in for some attention, and while the
2.36-million-dot OLED display with 0.77x
magnification remains the same, there are
numerous improvements over the one used
in the X-T1 - not least improved brightness.

Meanwhile, the new double-jointed
articulated display makes it possible to pull
the screen outwards and away from the body
when the camera is tilted on its side.

Interestingly, though, Fujifilm has opted
to omit a touchscreen from the X-T2.

The X-T2 is the first Fujifilm X-series
camera to offer 4K UHD (3840x2160)
video recording, with a bit rate of 100Mbps
(compared to 34Mbps on the X-T1) at 30, 25
or 24fps. Finally, the X-T2 now features dual
SD card slots, and unlike the X-Pro2 both
are UHS-Il compatible.

We trialed it on
fast-moving cars using the in-built Preset 3
(Accelerating/decelerating subjects). Coupled
with the improved frequency of the autofocus
search timing - reduced from 280ms on the
X-T1 to just 114ms on the X-T2 - it rarely
missed a beat when taking a shot.

The unchanged TTL 256-zone metering
system performs very well, especially when
challenged by high-contrast scenes; indeed,
if anything it tended to underexpose. Raw
files deliver very pleasing color, while those
shooting in JPEG have Fuji's excellent set of
Film Simulation modes on tap as well.

THE BOTTOM LINE. There's still a bit of
room for improvement (isn't there always?),
but the improved AF performance and the
new sensor that delivers pin-sharp results
makes the X-T2 one of the most desirable
cameras available right now. PHIL HALL
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BRIK BOOK
FOR MAC

> Durable, secure
pop-on laptop cover

Creative alternative
to stickers

B Challenging to remove
the Briks once placed
B Lack of instructions

GREAT NEEER™

MAR 2017 | maclife.com

Brik Book for Mac

A case you can personalize with LEGO

From $59.99 Manufacturer Jolt Team, brik.co

Requirements 13/15-inch Retina MacBook Pro (models before 2016), 11/13-inch MacBook Air

The LEGO-compatible Brik Book is a shell for
your MacBook that adds a surface you can build
designs on from bricks. Deciding what to build
might be the most challenging step. Jolt Team
sell Briks (their own equivalent of LEGO bricks)
in a range of colors, and on their online Pixel Art
Design Gallery, they offer countless sample
designs, from a classic Mac Hello script to Libra
scales. A basic set comes with a recreation of
the white Apple logo, and extra sets are available
at additional cost. The case itself comes in gray,
clear, and blue, with other colors available at
certain times (red and green were available over
the holidays, for example).

Attaching the Brik Book to the back of an
11-inch MacBook Air is an easy feat, but some
initial legwork is needed to properly assemble
the cover art. Unfortunately, the manufacturer
doesn't include instructions for all of the designs
available on the website. As a result, assembling
the design seemed overwhelming at first, but
ultimately, we found it rewarding.

Removing a poorly positioned Brik is not that
easy. Jolt Team does offer a Brik removal tool,
but only includes it some select packs as
standard. The most effective strategy we found
without one was to stack two Briks atop of each
other then remove both from the grid. The total
time needed to assemble most of the designs
suggested on the website is under an hour, but a
single ill-placed Brik can torpedo that estimate.
Having said that, the Brik pieces stay firmly in
place no matter what; they're not in the business
of just popping off. The Book fits crisply on the
laptop and does not add substantial weight. It's
almost de-stressing to run our hands over the
Brik Book's outside; the texture is both playful
and soothing.

If you want your MacBook to stand out from
the crowd, this case will help to make yours a
nice little conversation piece.

THE BOTTOM LINE. The Brik Book is a great
notebook accessory, bringing a bit of fun to your
MacBook. MUIRA MCCAMMON



NETATMO HEALTHY
HOME COACH

D Beautiful, well built

D Can trigger other
HomeKit devices

- Far too expensive

= Doesn't monitor for
carbon monoxide

SOLID

Tough testing, trusted ratings

Netatmo Healthy Home Coach

Monitor climate and air quality

$99 Manufacturer Netatmo, netatmo.com

Features 802.11b/g/n (2.4GHz) Wi-Fi, iOS 8.1 or higher (i0S 9 for HomeKit integration)

not carbon monoxide), temperature,

noise, and humidity in a single room
in your home. It connects to Wi-Fi on the
2.4GHz band and is set up, controlled
and measured using an iOS app.

After the simple set-up process, you

can get a quick reading from the device by
touching the top of the cylinder - a pulsating
light from red (bad) to green (excellent),
will give you a “mood" reading. For exact
measurements, use the app, which will also
alert you should it record any unusual figures,
such as high COz2 levels or low temperatures.

This unit monitors air quality, CO2 (but

The app is flexible and versatile - there are
options for keeping it calibrated, plus profiles
for asthmatic and baby users, plus support
for multi-user access. The unit also links in
neatly with other Netatmo smart home
devices, and its readings can also be used
to trigger your other HomeKit devices.

However, it's far too expensive, particularly
if you want to monitor more than one room,
and doesn't really do enough to stand out
from the likes of Elgato’s Eve Room.

THE BOTTOM LINE. We love the design
and user-friendly app, but the Healthy
Home Coach is too pricey. NICK PEERS
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The Little Acre

A pint-sized adventure lacking in challenge

$12.99 Developer Pewter Games Studios, pewtergamesstudios.com
Requirements OS X 10.10 or later, Intel Core i7 2.3GHz, 2GB RAM, GeForce 9400M or equivalent graphics

One of the game’'s first

puzzles: dressing yourself.

THE LITTLE ACRE
Hand-drawn art style

> Story and voice acting
really bring the
characters to life

B Alittle too short

B Alittle too easy
GOOD mEmi
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What would happen if you were just minding
your own business in your modest cottage in
1950s Ireland and stumbled upon a portal to
another dimension? That’s the premise upon
which point-and-click adventure The Little
Acre is built. After the disappearance of his
scientist father, Aidan is struggling to raise
his rambunctious daughter Lily on his own.
Fooling around with the missing Arthur’s
inventions, Aidan accidentally stumbles into
a mysterious, dangerous, and technologically
advanced place - and while he’s looking for
away out, Lily climbs in after him.

Both Aidan and Lily are playable in this
charming adventure, though they can’t be
selected at will. Instead, the game will switch
between them at certain story points as they
try to reunite and escape — and maybe find
out what happened to Arthur along the way.

The tale is conveyed through animated
cut-scenes and lovely hand-drawn artwork,
and you can really feel the influence of ’90s
adventure games such as Broken Steel in
every frame. Also retaining that classic feel

is the simple way you play: collecting items
and figuring out how to use them within the
varied environments.

The Little Acre is on the short side, with
the story wrapping up in less than three hours,
depending on how long you linger on any
particular puzzle. The length alone
isn’t a problem, but the lack of challenge
is definitely a drawback. You’ll never have
more than a handful of items in your
inventory at any one time, and the game’s
hand-holding and lengthy dialog explainers
mean you’ll never really be stumped. That’s
great if you’re new to the genre or looking for
a brief experience, but not so much if you
want the satisfaction of unraveling a truly
devious brainteaser.

Still, even without the memorable
cleverness of some of its adventure game
counterparts, The Little Acre is enjoyable
from start to finish. The story and characters
are lovely, and its distinct style perfectly
suits the tone.

THE BOTTOM LINE. Though not the most
challenging experience the genre has to
offer, The Little Acre is nonetheless a
completely charming point-and-click
adventure. SARAH LEBOEUF

Home sweet home. Now pick up everything you can
and use it with everything else...



Shadow Tactics:
Blades of the Shogun

Staying alive by tapping F5

$39.99 Developer Mimimi Productions, mimimi-productions.de

Tough testing, trusted ratings

Requirements OS X 10.10, Intel dual-core processor, 4GB RAM,
Nvidia 9800 GTX, AMD Radeon HD 7770, 1GB VRAM

Set in Edo Japan, each stage in Shadow
Tactics is a sprawling diorama of twisting
alleys, fortified courtyards, and soaring
pagodas, brimming with curious guards
and stern watchmen. Shadow Tactics is
a stealth game in the old style - there’s
nothing innovative about skirting cones
representing sightlines or dragging
corpses out of sight. Not one member of
your five-man team is particularly suited
to brawling, and Shadow Tactics requires
a hermetic devotion to staying hidden.
The internal clockwork that governs
what enemies see, hear, and react to is
hard-nosed but judiciously fair. Sightlines
are affected by height and brush, and it
takes practice to learn how to hide in
plain sight. There’s a fine line between
raising suspicions and raising a red flag,
but killing is noisy, messy work.

The flashiest thing about Shadow Tactics is
“Shadow Mode,” which queues simultaneous
actions for each member of your squad - with
careful planning, you can dispatch an entire
room with one keystroke. Still, the legacy
of real-time stealth games lives on,
especially in its liberal use of quick-
saving. Successfully goaded an ox into
kicking a passing soldier to death? F5 to
save. Cut down where you stand by a
snarling, armored samurai? F8 to reload.
Quick-saving encourages players to
experiment (and fail) freely. With that
safety nets comes the freedom to
approach Shadow Tactics’ challenges,
large and small, as you see fit.

THE BOTTOM LINE. Shadow Tactics feels
considered and hand-crafted, at once an
homage to - and a path forward for - the
best in stealth gaming. JOSEPH LERAY

Some guards are harder
to distract than others,
but a dagger in the back
is a great leveler.

SHADOW TACTICS:
BLADES OF THE
SHOGUN

Meticulous attention
to detail

Generous quick-save
and branching levels

B Some persistent
visual glitches

D Fragile Al can cause
problems rare cases

EXCELLENT NEEN)
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BETTER LIVING THROUGH SMAF

> GET STARTED WITH THE..

There's an ever-increasing range
of smart devices that you can use
to monitor and protect your home

BY CLIFF JOSEPH

ecurity, lighting, and heating are
the three main types of devices that
tempt people to get started with
home automation, and we regularly
see new security cameras, smart lights, and
thermostats every month in Home Life.
However, there are a number of smaller and
less eye-catching devices that help to join the
dots between those three major product
categories. There are security sensors that can
detect movement in a dark room, or warn you if
a window has been opened when you’re away
from home. You can turn on just one radiator in
an upstairs bedroom using Siri voice commands,
or get an early warning with a smart fire alar

84 MAR 2017 | maclife.com
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The Internet of Things is rapidly taking shape,
and there’s now a dazzling variety of smart
devices and appliances that you can buy for your
high-tech smart home. However, there’s one
very simple option that can save you quite a lot
of money when you’re getting started. You can
make most electrical devices “smart” - albeit
in a limited way — by using a “smart plug” to
control their power supply.

Belkin’s WeMo Switch (S50) is one of the
most popular smart plugs at the moment, and
TP-Link has recently launched its own plug
called the HS100 ($30). Samsung, D-Link, and

make smart plqgs toat oh




LIKE EVERY COOL
GADGET NOWADAYS,
THESE SMART
THERMOSTATS

ARE PART OF THE
INTERNET OF THINGS
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uper smart home

-
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The Eve Energy
smart plug and
app help you
control your
utility bills.

12.52¢/mo~
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Eve's Motion Sensor works over Bluetooth rather than Wi-Fi,

but it Is compatible with HomeKit.

home-automation system and may not work
on their own, so check on that before buying.

PLUG AND PLAY
A smart plug is simply an adapter that goes into
an AC outlet, and then allows you to plug in other
devices such as a lamp or a radio, or maybe even
a washing machine. Most smart plugs use Wi-Fi
to connect to your network, enabling you to control
the power supply even when you’re away from
home - perhaps turning your lights on in the
evening to make it look like your home is occupied
while you’re away on vacation.

One unusual product here is Elgato’s Eve Energy
($50), which uses Bluetooth rather than Wi-Fi to
connect to the Eve app on your iPhone. Bluetooth

SOME SMART PLUGS CAN ALSO
HELP YOU TO SAVE MONEY BY
MONITORING ENERGY USAGE
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only has a limited range, but the Eve Energy is the
only smart plug that currently works with Apple’s
HomeKit software, which means that your Apple TV
can help you get around their limited range. They
can connect to the Apple TV, which acts as a hub for
them, meaning you can control them with your
phone remotely - even outside the home.

Some smart plugs can also help you to save
money by monitoring and analyzing your energy
usage. Smart thermostats are another good option
for saving money, but if you want really fine control
over your temperature, you can also buy devices
that control your air conditioning. Tado’s Smart AC
Control works with your phone and automatically
turns the air con down when the last person leaves
the house, and starts cooling/heating when
someone returns.

IN MOTION

We all want to keep our homes safe, so security
cameras are often the first smart devices that most
people buy for their home. But cameras aren’t the



only security option worth thinking about. Many
companies make motion sensors that can be used
to detect movement within a room during times
when your home should be empty, or just so that
you can keep an eye on what’s going on. There are
also sensors that can be attached to doors or
windows to warn you if they’ve been opened.

These sensors are often sold as part of a larger
security kit, such as Samsung’s SmartThings kit
($230), or Panasonic’s Home Monitoring and
Control kit ($250), both of which also include a
smart outlet and a central control hub that you
need to connect to your Wi-Fi router. Once you’ve
got that control hub, you can buy additional sensors
for around $40-S50 each, so it won’t cost a fortune
to cover most average homes.

If you’re on a tight budget, or you just want to
monitor one specific location, you can also buy
standalone sensors that just work on their own.
The D-Link Wi-Fi Smart Motion Sensor (S35) can
connect directly to your home network and its
26 ft range will cover most medium-sized rooms.
Elgato’s Eve range includes both the Eve Motion
sensor ($50) and a Door/Window sensor ($35).
Again, Elgato opts for Bluetooth rather than Wi-Fi
connectivity, but the HomeKit support means that
you can create “scenes” that combine devices; you
could use the door sensor to automatically turn on
your Philips Hue lights when you open the door.

To really proect your home, you can buy smoke
detectors for fire prevention, and water sensors
that can warn of leaking pipes. There are several
options here, with Nest’s Protect ($100) smoke
alarm being one of the most well-known, although
Honeywell, D-Link, and Samsung all make smoke
alarms and water sensors that work in conjunction
with their other security products.
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If you buy all your smart devices from one
manufacturer you shouldn’t have too much trouble
getting them to work together. Unfortunately,
getting devices from different manufacturers to
talk to each other remains a real challenge, just
as you might expect.

Apple’s HomeKit is still only making slow
progress, and it’s early days for the promising
Amazon Echo right now. However, Logitech
recently popped up with Pop, a simple “button”
that helps you link multiple devices together and
activate them with a quick press of your finger -
perhaps turning on your lights, Sonos speakers,
and Belkin WeMo smart plug all at once.

The advantage of this approach is that once
the Pop has been set up, you can just stick it onto
a convenient wall or other spot, and other people
can use it to control your home devices without
having to use an iPhone or app at all.

Belkin's WeMo Switch -
works over Wi-Fi.

-----

The Nest Protect smoke alarm
both talks and alerts your phone.
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FIVE OF

THE BEST

We recommend the best five smart devices for you

BELKIN WEMO SWITCH
$40
belkin.com

> Belkin's WeMo is one of
the most popular smart
plugs currently available,
and there's a second model
for $50 that can monitor
and analyze your energy
usage too. The WeMo is
compatible with the Nest
thermostat and Amazon
Echo - but, sadly, there's no
support for Apple's
HomeKit yet.
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SAMSUNG
SMARTTHINGS HOME
MONITORING KIT
$250

samsung.com

> This Starter Pack includes
a smart outlet, a motion
sensor, and two
multipurpose sensors,
along with a central hub
that links them. The hub
also enables you to add
compatible cameras, locks,
alarms, and more from the
likes of Yale and Honeywell.

D-LINK WI-FI SMART
MOTION SENSOR
$35

dlink.com

> The Wi-Fi Motion Sensor
is a simple and affordable
way to monitor a single
room, or any smaller

location such as a hallway.

It plugs directly into a
power outlet, and then
connects to your Wi-Fi
network to send you
alarms when you're away
at work, for example.

ELGATO EVE ENERGY
$50
elgato.com

> The Eve Energy uses
Bluetooth to talk to its app
on your iPhone rather than
Wi-Fi, but it's the only
smart plug we've seen
that works with Apple’s
HomeKit. That lets you
control it with Siri voice
commands, and link it up
with other HomekKit
devices, such as Philips'
Hue lights.



LOGITECH POP
$100
logitech.com

> The Pop is a “smart
button” that lets you
control multiple devices
with a quick tap of your
finger - no iPhone or iPad
needed once it's set up.
The Pop starter kit includes
two buttons, and will work
with devices from Philips,
Samsung, Belkin, and
others, and you can add
extra buttons for $40 each.

Super smart home

WHAT ELSE SHOULD | THINK ABOUT...

THE HUB
OF YOUR

HOME

If you're really serious about
having fine control of your devices,
consider investing in an Apple TV

he Home app that
arrived in iOS 10 works
well as a way of quickly
controlling multiple
smart devices within your home -
as long as those devices support
HomeKit, of course. If you’re only
running the app on your iPhone,
you can control all your smart
devices when at home. To use
HomeKit devices to their fullest,
you’ll need an iPad or Apple TV
(3rd or 4th gen) set up as a Home
Hub - see apple.co/2hlxm]JU; an

"
Ellsworth St

Front door unlocked
4 lights on

iPhone or iPod touch can’t be used.
Setting up one of those devices as
a Home Hub on your network
enables you to remotely control
your HomeKit accessories and, if
you have a 4th-gen Apple TV or an
iPad, set up automations and user
permissions. The former of these
capabilities enables you to control
devices based on paramters such
as you leaving or arriving
somewhere, the time of day, you
manually controlling an accessory,
or a sensor detecting something.

An Apple TV or
plugged-in iPad
can act as a hub
for HomeKit.



HOW TO

CONTROL YOUR HOME WITH HOMEKIT

JARGON BUSTER

The Home app gives you
the ability to define
scenes, in which you
specify settings for
multiple accessories,
enabling you to tap once
to activate preset choices
in an instant. You can even
set a scene to activate as
part of an automation.

ALL TOGETHER
Once you've got an iPad
or Apple TV set up as
your Home Hub, you

can invite other family
members to share control
of your devices too.
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At a Glance

9 (=) G
Closed ) ON
lam...  Front Door Hue white lam...
ENTRANCE HALL LOUNGE
HomeKit apps

Devices that support HomeKit can work
together - and even show up in each other's
apps. This is Elgato’s Eve app, which we're
using to set up an Eve door sensor. However,
the Elgato app can also see and control our
Philips Hue lights as well.

Accessory Automatic

When the Entrance H;:
Front Door...

Opens

Closes

In control

You need an Apple TV or iPad to enable
automations to work - you can't do it with just
an iPhone - but they provide really fine control
over your devices. Here we'll create an
automation that is triggered when the Elgato
sensor detects that the front door opens.

)

unge
1e white...
f

2

Bedroom Entrance...
Hue white... Front Door
Off Closed

Room to room

Apple's Home app also lists all your
HomeKit devices and enables you to group
them in rooms and automate them. Not every
app for managing HomeKit is as versatile as
Apple's app or Elgato’s Eve app, so you'll
probably stick with Apple's.

Entrance Hall Front Door
Opens

Only after sunset I
Accessories:

BEDROOM LOUNGE

Bedroom Lounge
Hue white... Hue white...
100% 78%

n Trigger happy

You can specify other triggers too, so
we've set this automation to trigger only if
the front door is opened after sunset in the
evening. Then we can tell it to turn on the
Philips Hue lights in various rooms, and even
adjust the brightness of each light separately.
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331 1 - R -0 Better living through smarter tech

GET SMART

CONNECTED & AETS TO ENHANCE YOUR LIFESTYLE

Plume
plumewifi.com

From $69

»> The Plume system aims to “put the router in the
cloud,” using sleek little pods to provide Wi-Fi coverage
throughout your home. The system is self-optimizing,
so it adjusts the network usage depending on your
needs and keeps an eye out for signal drops and dead
spots. Each pod boasts an Ethernet port and plugs
directly into a power outlet in whichever room you
need it. The pods then link up wirelessly to spread the
adaptive Wi-Fi signal. A single pod is $69, a three-pack
is $179, and a six-pack is $329. They're available in very
tasteful Silver, Onyx, or Champagne finishes.
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2 Smanos UFO
smanos.com
$179

>»> Dutch outfit Smanos
has a good reputation in
the security business,
and the latest addition
to its range of smart
security devices is the
eye-catching UFO
camera. The circular
design of the UFO isn't
just for show, as it
houses a fisheye lens
that provides a full
360-degree view of a
room when mounted on
the ceiling, or a narrower
180-degree view if you
stick it on a wall. It also
has useful night-vision
and motion-detection
security features.

8 Misfit Phase
misfit.com

$175

»> There's been a bit

of a backlash against
high-tech smartwatches,
so a number of
companies are launching
hybrid watches that
have a more traditional
watch face, while still
hiding some smart tech
inside. The Misfit Phase
looks like a stylish,
conventional wristwatch,
and is available in a
variety of colors, yet by
pairing it with the Misfit
app it can track all your
exercise activities and
sync with iOS's Health
app. It can also vibrate to
let you know when you
receive an email or some

other kind of notification.

>SMART
HOME

LIVING

When it comes to air quality,
JENNIFER PHIN can
hardly breathe for worrying

»>> | HAVE started monitoring the air
quality in our home using Eve Room,
an innocent-looking little wireless box
that sits in judgment in the corner of
the room, declaring the majority of the
house as unfit for human habitation.

Temperature anxiety came first, but
once I'd established that our baby was
an actual human and would complain
loudly if her temperature was anything
other than optimal, | started noticing
that Eve was not happy with the quality
of the very air we were breathing.

"Hey, it says the air in the baby's
room is Poor,” | say to my husband
one evening.

He nods, apparently unperturbed.
“Yeah. It's not anything terrible, it's
just measuring Volatile Organic
Compounds,” he says, ignoring the
fact that | am now Googling frantically.

"Okay, don't panic,” | say, mostly to
myself. “Do we store any dry-cleaning
solvents, printer inks or products for
the manufacture of footwear or
pharmaceuticals in there? Or do you
secretly smoke?"

“Uh, no," he says. “Maybe the baby
does. Hey, why don't you look up the
proper Elgato website?"

Elgato has helpfully provided a large
graph on the Eve Room landing page,
presumably to calm panicky
hypochondriacs like me. It is quite clear
on the matter - | just need to open the
window. For five minutes. The baby
sighs, Eve is happy, my husband
switches the TV back on, and | rest
assured that we are not all about to
suffocate on our own exhalations.

Maybe I'll read the instructions next
time. Maybe.
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APPLE TV

It may not be perfect, but DIRECTV NOW has been improved
and is now a very viable cable-free streaming contender.

DIRECTV NOW

Cord-cutter’s dream

Free (subscription required)

After much teasing on social media,
Vel AT&T finally unveiled its cable-
free, all-streaming DIRECTV NOW
service in November, offering over 100 live TV
channels and more than 10,000 on-demand
movies and shows. Naturally, one of the first
places to tune in was the fourth-generation
Apple TV, courtesy of the free TV and iOS app.
Despite initial growing pains with channels
that would freeze up or go missing, DIRECTNOW
mostly succeeded in bringing live TV to viewers
without a cable or satellite subscription. The
Apple TV app offers an extensive guide, the
ability to save favorite channels, and access to
shows added to your watch list on iPhone or
iPad. There are still a few things missing, like
DVR capabilities and live broadcasts from ABC
and NBC (only available in select markets), but
it’s a good start. The first seven days are free,
and there are no contracts, credit checks, or
equipment to lease. J.R. BOOKWALTER
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TripUSA

Take a little trip

Free

Feel like getting
out of town but
strapped for

cash? Next time the urge to
travel strikes, curl up on the
couch with your Siri Remote
and download TripUSA instead.

This free app is loaded with
videos shot all over the United
States, sorted by city and state,
with an emphasis on adventure
travel, hotels, and eateries
located from coast to coast.
There's also a search option
for armchair travelers looking
for a specific destination.

In addition to national parks
and popular hotspots like Walt
Disney World, there are plenty

of virtual tours through New
York, Las Vegas, Hollywood
(California and Florida), Hawaii,
Miami, Los Angeles, and much
more. You can even become a
virtual guest at some of the
finest bed and breakfasts
around, without having to

pay for a room.

The only real downside is
that some of the videos aren't
exactly shot in high-quality,
high-definition video formats.
We noted a bit of pixelization
and occasional low-resolution
image quality, but considering
the price, TripUSA is just the
ticket to beat travel blues.
J.R. BOOKWALTER
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Travel can be such a chore. Packing your bags, making your connecting
flights, losing your baggage. Travel around America the easy way...




Tiny Wings TV

Fly away

$2.99

") Remember all the hoopla
[+ a surrounding Tiny Wings,
s .. M the 201 mobile gaming
sensation many expected to become
the next Angry Birds? Now you can flap
your wings across the big screen.

Tiny Wings TV comes with two game
modes - Day Trip and Flight School -
featuring “procedural generated
graphics” that make the game look
different every day. iCloud sync allows
progress made on the iPhone and iPad
to pick up where you left off on Apple
TV, and there are 25 levels in the new
Flight School mode. Best of all, Tiny
Wings TV offers split-screen multiplayer
using the Siri Remote, a MFi game

Amazon App

Shop 'til you drop

Free

amazon It's kind of sad that
there's still no Amazon

-m Video app available
for Apple TV despite rumors to the
contrary, but in the meantime, you can
fire up Cupertino's favorite media box
and shop Amazon's virtual shelves
instead. Amazon App is an official
Apple TV storefront that allows you to
browse, search, view product details,
read reviews, and see immersive
images and video for millions of
products, on your TV screen. Prime
members can make purchases;
everyone else can use the remote to
add items to a wishlist for purchasing
from a mobile device or computer.

Try to get yourself a fancier nest by
completing tasks on Tiny Wings TV.

controller, or even the regular iOS app,
which allows your iPhone, iPod touch,
or iPad to be used as a controller. Play
as mama bird or one of her four
children, upgrading your nest by
completing tasks. J.R. BOOKWALTER
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Forget window shopping and start TV
shopping with the Amazon App on Apple TV.

The ability to watch product videos
from the comfort of our living room is
cool. If this is the future, we'll take it -
and the ability to do voice search like
the iOS app totally rocks.

J.R. BOOKWALTER

Better living through smarter tech

Make the most of
home entertainment

HITACHI 65R8 ROKU TV
$999 hitachi-america.us
In search of a new 65-inch 4K
Ultra HD LED TV but want to
stream content from apps like
VUDU or Amazon Video that
aren’t available on Apple TV?
Hitachi’s latest Roku-powered
set is enormously capable
considering the price, with a
great picture, simple remote,
four HDMI inputs, built-in
wireless, and Ethernet port.

HAPURS 2 IN 1 UNIVERSAL
MOUNTING SYSTEM
$7.99 amazon.com
With this ingenious and
inexpensive little mounting
bracket, the diminutive Apple
TV remote will remain with
your television until you’re
ready to use it. The kit includes
a protective silicone rubber
skin that makes it easier to
hold while browsing movies
and shows or playing games.
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Your best option is to raise a
support ticket with Synology. The
company should be able to give you
a clearer idea as to when it and Apple
will arrive at a resolution for this issue,
and it may offer early-release test
updates, which could get your NAS
up and running sooner.

2ASK

TECH SUPPORT & TECHSPLANATIONS

Is my Mac infected?

| have a problem with Firefox.

While accessing Hotmail messages,
| accidentally clicked on an adjacent
ad. To my alarm a window popped up
flashing "'Trojan,”” accompanied by
beeping sounds. | shut down Firefox

Synolog immediately. What can | do to make
M f in?
If you backup to a mVA ?: sla : again the Hotmail
Synology or other } s the |n‘ was on the Hotmai page
network-attached rather than in the body of an email,
storage, it may need —— the risk of malware is low, but it was
to be updated to — R clearly unwanted and unnerving. Most
work with Sierra’s — — likely it was an ad that simply displays
Time Machine. . B — such a message by default to scare

you into buying unnecessary anti-virus
software. You've probably seen similar
ads saying things like "“Your system is
slow, click here to optimize,” which are
also completely bogus.

Still, to confirm your Mac isn't
infected with anything nasty, download
an anti-malware utility such as
Malwarebytes - you can get that one
for free from bit.ly/2ftmVmV.

There's no need to trash Firefox, but
it would be wise to check its extensions
in case the link you clicked downloaded
anything that could prove a nuisance.
To do this, open a new window in
Finder, browse to the Firefox app and
then double-click its icon while holding
the Alt key: that window will close, and
Firefox will start in its Safe Mode,
which checks its integrity and
extensions. (It also offers an option to
restore Firefox to its default state.)

Next, browse to your usual Home

BACKUPS STOP IN SIERRA

Since | upgraded my Mac to Sierra, Time Machine has stopped
backing up to my Synology DS411J NAS drive, although | can
still log on to the drive directly. I've tried deleting my old
backups, and unmounting and remounting the drive, but when
Time Machine does make a backup following such maneuvers,
it hangs when preparing the next one. How can | get Time
Machine working again?

This problem hasn't just affected many
users of Synology NAS drives, but
people using alternatives from some
other vendors, too. There have been
long discussions and suggestions of
solutions on Synology's and other
support forums - see bit.ly/2fbYBCR

suitable backup store, the software
running on the NAS has to follow
various protocols. Sierra has
apparently changed its side of that,
either intentionally or due to bugs,
and thrown the process off.

It's always worth checking that your

for just one example - but no one has
yet discovered a lasting answer.

It's probably the result of a
mismatch between Synology's
software and macOS Sierra. To
convince Time Machine that it's a
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NAS is running the latest version of its
software, and that you've followed the
instructions in its documentation fully.
Sometimes software updates can
silently alter your Mac's network
settings, for example.

page, close that window or tab, and
then open a new one. The new tab
should be clean and clear. If it is, then
your actions should have rid Firefox of
any traces of the pop-up. You should
then be able to return to browsing.



Malwarebytes' eponymous free tool should
be your go-to for checking for malware.

Headphones losing lipsync
When | use LG wireless headphones
with my iPad Air 2, | notice audio
and video play back slightly out of
sync. Without the headphones they
play in perfect sync. What can | do
to fix this?

This is a tricky problem that can be
more noticeable to some people than
others. Its underlying cause is that it
takes time to send audio via Bluetooth
and convert the digital signal to analog
in the headphones. iPads and other
devices push video playback to the
display as quickly as possible, so the
combination results in your seeing any
given moment tens of milliseconds
before you hear the corresponding
audio signal.

It's worth making sure your network
settings are correct, and that you don't
have other Bluetooth audio devices
cluttering up your settings. It's also
important that you use the latest
version of iOS and apply any current
firmware update that's available for
your headphones.

Higher-specification headphones
should reduce the audio delay, but
different people have different
thresholds. You could spend a lot of
money on new headphones and still
notice the problem, so try any
alternatives before committing cash.
Our brains can also compensate for
loss of sync, and the effect normally
appears reduced while watching a
movie, as we get used to it. Switching
to wired headphones should make it
vanish altogether, as audio and video
will then be virtually synchronous.

Tech Support & Techsplanations

> Strange error in El Capitan

When | started up my
MacBook, running EI
Capitan, it promptly
warned me that there
was a “CoreTelephony
Trace File Error”
suggesting that | might
be out of disk space. As
| have ample free disk
space, | don't believe
that's the cause, and
everything still seems to
be working normally. How
can | stop the error?
This seems to be a not
uncommon error with OS
X 10.11 EI Capitan, and
various solutions have
been suggested. The full
error normally refers to a
problem opening a file in
the hidden “/tmp” folder.
The first thing to try is
to start up in OS X
Recovery (hold /+R
at the startup sound),
choose Utilities > Disk
Utility and use the app's

If the error persists, it's
likely that reinstalling
0OS X could fix it, but
that's a lot of time and
effort to expend if your
Mac works well otherwise.
Some people have
suggested that the error
results from System
Integrity Protection (SIP)
feature, and have offered
a command-line formula
that's claimed to “fix" it.
However, the /tmp folder

is explicitly excluded
from SIP's coverage.
Because the error
relates to a networking
library, it may be that
when you next use your
MacBook away from
home, particularly over
a Wi-Fi network, it fixes
itself. The other good
news is that it doesn't
seem to occur in macOS
Sierra, so if you upgrade,
that should fix things.

First Aid feature to check A
and potentially repair
—

your startup disk. - =

RAID gone wrong

My Promise Pegasus J4 external
drive array stopped working when
| upgraded my Mac to EI Capitan.
I've just upgraded again, to Sierra,
and it still doesn't seem to work.
Is this due to missing software,
and how can | put it right?

Your Pegasus system is an unusual
slimline, four-drive external RAID drive
with its own hardware RAID controller.
Some external drives like this one

operate without any additional drivers,
but this model relies on at least one
kernel extension, and a utility app, to
work with the controller.

Promise's last software update for
it covers OS X up to version 10.9, but
there have been no updates issued
since. You should first try to install
that latest version, which might yet
prove compatible with Sierra, too.

Security in El Capitan and Sierra

has changed, and they might not even >
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Pegasus J4

issues on El
Capitan and
Sierra, its R4
and R6 drives
work fine.

>>>

Though
Promise's

drive has

permit such an old installer to put a
kernel extension where it wishes; an
old kernel extension might make your
Mac unstable, but sometimes
surprisingly old extensions install

and run perfectly well.

If you have no joy, contact Promise's
tech support and ask what the
company's plans for your model of
RAID drive are. You might be lucky to
find there's an update due very soon.
These issues don't seem to have
affected Promise's more conventional
Pegasus R4 and R6 RAID systems,
whose extensions and utility appear
to be compatible with Sierra.

Making a fresh start

I'm giving my old iMac to my
daughter. It last ran El Capitan, and
| want to install a clean copy of that
system for her to use. Is that
possible, and how?

You need to initialize the hard disk
and install a fresh copy of EI Capitan
on it, stopping once the setup phase
starts. There used to be several ways
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of installing EI Capitan, but Apple has
withdrawn that version of the OS X
installer from new customers, so
unless your daughter has already
acquired it from the Mac App Store
using her Apple ID, she won't be able
to obtain it any more.

With your Mac connected to the
internet, restart in Recovery mode,
open Disk Utility, select the startup
volume and click Erase. Next, click the
Security Options button and select an
appropriate security level to wipe the
entire volume completely, including
free space.

When that's complete, quit Disk
Utility, select Reinstall OS X and click
Continue. You'll be prompted through
the process. Once the Mac restarts and
invites you to select your country,
press [s8)+(Q] to shut it down - you may
need to be persistent at this stage to
get this to work.

When your daughter starts up the
Mac, she will see the Setup Assistant
and no trace of your previous use of
the computer.

Medi

When erasing a drive to pass to someone
else, opt to securely erase the whole of it.

Printers + Sierra="7?
Which printers are confirmed
to work with Sierra?

Apple provides a list of all printers
and scanners that are supported by
drivers supplied with macOS Sierra at
apple.co/2gclUj7. Most if not all Canon
models require macOS 10.12.1 or higher,
because they have problems with the
initial release of Sierra. Other printer
manufacturers may also offer separate
drivers on their website.

Two become one
How do | convert a drive from
having two partitions to one?

Disk Utility may be able to do this
without losing the files currently
stored on the drive, but otherwise you
must assume that everything on it will
be wiped. Make at least one full backup
of the disk's volumes. Next, open Disk
Utility, select the drive on the left, click
Partition, then click the partition on
the pie chart that you want to delete,
followed by the - (minus) button below.

iCloud access
What should | do if someone
accessed my iCloud account?

If you have security concerns about
your Apple ID account, which includes
iCloud, contact Apple's support desk
immediately through getsupport.
apple.com. Also contact your credit
card provider to check recent card
transactions and discover if any
are fraudulent. They should be
knowledgeable as this sort of
problem is, sadly, all too common.



Folder aliases
Why can't Sierra correctly show
folder aliases?

This strange bug first appeared in
macOS 10.12. Sometimes Finder and
Open/Save dialogs show folder aliases
with the correct icon, but at other
times they're shown as documents.
They work correctly, though, so it
seems to be a cosmetic issue, not
a functional one.

Sierra and a (con)fusion drive
| turned my internal hard drive and
an external USB 3 SSD into a Fusion
Drive following the instructions in
Mac]Life #113. I've tried upgrading
to macOS Sierra, and although the
first phase of the install runs, my
iMac then restarts in EI Capitan.
Is Sierra incompatible with my
homemade Fusion Drive?

This doesn't appear to be a general
problem with non-Apple Fusion Drives,
but sometimes the Sierra installer

DiskMaker X can use Sierra's installer to
turn a USB flash drive into an install disk.

refuses to work properly. The solution
is to make yourself a bootable Sierra
installer on a USB thumb drive (empty
and at least 8GB capacity), and use
that to install Sierra instead.

If the InstallmacOSSierra app has
deleted itself, download a fresh copy
from the Mac App Store and copy it to
another folder, and perhaps to another
drive too. You can follow Apple's

EMAIL: letters@maclife.com
SHARE WITH US! FACEBOOK: facebook.com/maclife TWITTER: twitter.com/maclife

> Immutable Magic Mouse

I'm using a wireless
Magic Mouse with my
iMac running OS X
10.11.6. Every so often
the secondary mouse
button stops working. |
can fix this in System
Preferences’ Mouse pane,
but a little later it stops
working again. How can
| get my choice of
settings to persist?
This could be a problem

But the simplest of
answers is that this may
result from a “stuck”
preferences file for the
Mouse pane. In Finder
hold Alt and choose Go >
Library, open the
Preferences folder and
move “com.apple.driver.
AppleBluetooth
Multitouch.mouse.plist"
somewhere else, such as

Tech Support & Techsplanations

your Documents folder.
Next, open the Mouse
pane and set up your
mouse as you want it.
Doing that should save
your choices to a new
preferences file, which in
turn should retain them
properly. If that doesn't
work, look for third-party
software on your Mac that
might be interfering.

with the mouse, so if you
can, confirm that it works
properly with a different
Mac. It might also be the
result of El Capitan’s
persistent problems with
Bluetooth, for which the
only good solution is to
upgrade to Sierra, to be
completely blunt.

instructions for making an install disk
using Terminal at apple.co/2gd1dEl,
but the process is much easier using
Install Disk Creator (free, macdaddy.io)
or DiskMaker X (donationware,
diskmakerx.com).

Once the install disk is created, keep
it connected to your Mac, restart and
hold Alt at the startup sound to enter
the Startup Manager.

Select the install disk you made and
press [<3. Your iMac will then start up
from the stick and the installer will run
properly from it.

Going into recovery

Has Sierra changed the way

you enter Recovery Mode?

No, you still hold [s¢)+(R] when you
hear the startup sound to enter the
Recovery system.

However, if you use a wireless
keyboard, you may find that that your
Mac ignores its input at this stage. If
that happens, try connecting a wired
USB keyboard to your Mac, or connect
Apple's Magic Keyboard to a USB port
on your Mac using the charging cable
provided with it.

Mac|Lifes®
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Get more from Sierra's Today view

Expand Notification Center's Today view with add-on widgets

REQUIRES

macOS Sierra, internet
connection, Apple ID,
third-party widgets

YOU WILL LEARN
How to add and manage
widgets using mac0S's
Today view settings

IT WILL TAKE
10 minutes

O

SCREEN
CORNER

If you find it hard to hit
Notification Center’s
menu-bar icon, try
dragging your pointer to a
hot corner. Open Mission
Control in System Prefs,
click Hot Corners, choose
a corner menu and select
Notification Center.
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THE BIG REVAMP to
Notification Center in iOS 8
proved very popular, enabling
users to use the Today view to
see regularly accessed information, and
add widgets to customize the experience.
The Today view made its way into OS X
(now macOS) in 10.10 Yosemite in 2014,
providing at-a-glance views of calendar
events, reminders, weather forecasts,
stock prices, and more. Although
developers have been slower to get the
Today view on the Mac than they have
been on the iPhone and iPad, there are
a number of very useful third-party
widgets available in the Mac App Store.

Here we’ll show you how to use these
and Apple’s default widgets, along with
the Today view in general.

One thing worth noting if you try out a
lot of widgets and then discard a bunch of
them is that macOS Sierra has a tendency
to cache them in memory, even if you
uninstall their parent apps. Restarting
your Mac fixes this, but it’s quicker to
reboot Finder by opening Terminal,
typing the command killall Finder and
then pressing (<. You’ll find your Finder
windows briefly disappear, then reappear.
Now when you reopen Notification
Center, any uninstalled widgets will
be gone. ALAN STONEBRIDGE

HOW TO Get started with Today view

Notification Center

To access Notification Center, click the
icon on the far-right of the menu bar. It slides
across, above other content. As in iOS, you get

a Today tab for time-sensitive info and widgets.

You can scroll up and down if needed.

o Get started with editing

The Weather app will ask for permission
to use your location; click OK in the Weather
widget. Click Edit (at the foot of the panel) to
expand Notification Center to see installed
widgets (left) and those you can add (right).



AL
9 Switch some widgets

Widgets can be changed via drag and
drop or using the +/- buttons. Try removing
Stocks by clicking its - button; it moves to the
right-hand pane. Drag the handles at the right
of widget titles to reorder your widgets.

Access weather details

Some widgets, such as Weather, provide
more info when interacted with. By default you
see current conditions, but click a location and
an extended forecast is provided, showing the
next few hours and also the coming days.

a Add third-party widgets
You add third-party widgets in the same
way as the built-in ones, and some may need
configuring. Note that Today view is primarily
designed for “at a glance” information that's
important to you, so don't go too crazy.

How to do anything on your Mac, iPhone & iPad

o Customize a widget

Click Done to stop editing, then move
your pointer over the World Clock widget, and
click the "i" to put the widget into edit mode.
Click Add to create a new clock, then select a
location for it. Drag the clocks to reorder them.

®0 8 -IIIO“!I di T O

B Third-party widgets

The Today view is extensible, which
means you can add third-party widgets
installed via the Mac App Store. When a new
widget is detected by your Mac, the Edit button
will alert you to new items.

Interact and experiment

Some third-party widgets may interact
with their parent apps. For example, if you use
the Countdowns widget to set reminders, you'll
need to click the Settings button next to Add to
open the main app to edit any timers.

JARGON BUSTER

Widgets are tiny
applications that

are typically very
straightforward and

often have a single,
focused purpose, such as
showing the current time.

O

KEYBOARD
SHORTCUT

To use the keyboard to
activate Notification
Center, open System Prefs,
and select Keyboard >
Shortcuts > Mission
Control. Check Show
Notification Center, and
click the shortcut area.
Press your shortcut (such
as (3¢ +[F6)) to define it.
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Automate file organization

Harness the power of Hazel to monitor folders and arrange your files

REQUIRES
Hazel 4

YOU WILL LEARN
How to build rules

in Hazel, in order to
automate tidying

up your Mac's files

IT WILL TAKE
30 minutes

QUICK TIP

Hazel performs actions
within seconds of files
appearing in monitored
folders. You can turn
Hazel off, though,

to temporarily revert
to manually sorting
the contents of folders.

: T q

St00 Harel
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APPLE’'S TRYING quite hard
to nudge everyone towards
storing their data on iCloud
Drive. The problem is that
you only get 5GB of iCloud storage for
free, which is shared among many of
its services, not just iCloud Drive. So
managing the files you keep on your
Mac - and in cloud storage services
generally - is definitely a smart idea.
There are, of course, pieces of software
that will check through your Mac’s drive
and show you some kind of graph to
help you locate and delete huge files
(GrandPerspective being a free example
from grandperspectiv.sourceforge.net).
However, Hazel deals with bloating in a
different way. Recognizing that a lot of
clutter is down to poor organization,
it offers a rules-based system for
automating your Mac’s file housekeeping.
It works by silently monitoring specific
folders and running “rules” on them
when relevant files are discovered. These
rules can be extremely simple — moving

HOW TO Get started with Hazel

-
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Take out the trash

Install Hazel and open its System
Preferences pane. In the Trash tab, you can use
the top two checkboxes to delete files over a
certain age, and to keep the Trash below a set
size. The defaults are one week and 1GB.

documents to their most suitable
destination if you’ve just dumped them
on the desktop - or you can delve
deeper into complex rule sets, nesting
conditions, adding tags and labels,
creating archives, uploading content to
servers, and even running scripts.

In the walkthrough, we’ll start you off
with some straightforward rules, so you
can get to grips with Hazel. If you’re a
little concerned about Hazel wreaking
havoc with more complex rules, try them
on test folders. Create a Hazel folder
somewhere in your user folder, add copies
(not originals) of documents to it, and
then run your rules to see what happens.
(Also, back up. Always.)

Hazel will cost you $32 from
noodlesoft.com. A fully functional trial
version is available for download, which
you can use for this tutorial. As far as
we’re concerned, the app’s well worth
the outlay and effort, for the time — and
potentially even money - it’ll save you
in the long run. CRAIG GRANNELL

e ——

9 Remove app leftovers

At the bottom of the pane, enable App
Sweep. Hazel then monitors your Mac for when
you uninstall apps and attempts to (optionally)
get rid of support files during the process. (Few
of these are very large, but some are.)



9 Define a target folder

Let's create a rule that monitors the
Desktop. Select the Folders tab and click +
under the Folders panel. Choose Desktop and
click Open. Select Desktop in the Folders panel,
then click + under Rules to create a new one.
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Add an action

Under “Do the following..." pick “Set
color label" and a color. Click OK to save your
rule. Now, items on your desktop that were
added over a month ago and haven't been
opened within the last month get a red label.

Move older files

Select Desktop, right-click your rule and
pick Duplicate. Rename the copy “Move old
files," set its action to Move, and pick Other in
the folder pop-up. Create a “To sort" folder in
your Home folder, select it, click Open and OK.

How to do anything on your Mac, iPhone & iPad
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Label old files

Name your rule, then set the “If" pop-
up menu so that all conditions must be met.
Set the condition to “Date Added is not in the
last 1 month.” Click + to add another, and set to
“Date Last Opened is not in the last 1 month."”
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o Copy and test

You can copy your rule to other folders
by dragging and dropping it in Hazel's window.
Wait a few seconds and you'll see the results.
You can also open the rule, click Preview and
pick a file to test it against to see its effect.

e Manage rules

You now have two competing rules in
Desktop, so turn off the one you don't want to
use. Experiment with rules, such as to have
Hazel import music files from the desktop into
iTunes so they don't use iCloud Drive space.

JARGON BUSTER

Hazel's system is based
on rules and conditions.
Conditions are actions
based on specific criteria.
Each rule can include one
or more conditions, and
can be named. Multiple
rules can be assigned

to any folder.

QUICK TIP

In Hazel's System
Preferences pane, click
Info. Here you can set
Hazel to appear in the
menu bar, enabling you

to quickly turn it on or off,
or run a specific folder
rule immediately.
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Write and style text rapidly

Markdown makes it easy to write things for the web - and elsewhere!

REQUIRES
A text editor or
a Markdown-
friendly app

YOU WILL LEARN
How Markdown speeds up
all kinds of writing

IT WILL TAKE
15 minutes

MARKDOWN'S
CREATION

Everything you need to
know about Markdown's
origins and syntax is

at Daring Fireball -

see bit.ly/2eWCGSG.
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IF YOU'VE ever looked at,

written, or edited HTML, you’ll

know that while it’s fairly

straightforward it can also get
horribly messy-looking, even when
you’ve created a style sheet to separate
out the formatting for its content. For
example, for a numbered list you’d have
something like this:

<p>Best Macs ever</p>

<ob>

<li>MacBook Pro with Retina display</li>
<li>New MacBook«</li>

<li>Power Macintosh</li>

<ob>

Wouldn’t it be better if you could just
type this:

Best Macs Ever

1. MacBook Pro with Retina display
2. New MacBook

3. Power Macintosh

for the same results? That’s what
Markdown is for. It’s designed to make
writing for the web as easy as possible,

so instead of HTML tags you use simpler
methods to indicate what’s what. You can
then run your finished document through
a Markdown processor to turn it into
proper HTML. Easy!
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Apps such as Ulysses can automatically color your
Markdown text for easy identification and navigation.
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You don't need a special app to write Markdown,
but some apps offer useful features to help you.

There are many benefits to Markdown.
The most obvious is time, because it
enables you to fly through your
documents adding formatting tags as
you go. You don’t need special software
to do it, either, because you can write
Markdown in any text editor — even
TextEdit - so the system requirements
to use it are light and file sizes are tiny.

Still, it’s worth investing in a specific
Markdown-friendly app such as Byword
or Ulysses if you do a lot of writing. Such
apps add even more useful features,
including autocomplete, automatic
formatting, familiar keyboard shortcuts,
and (most usefully of all) publishing.

Markdown publishing enables you to
export your work to whatever format
suits without having to worry about
changing any of your document’s
content. So, in Ulysses you can send
your document in plain text, rich text,
Markdown, TextBundle, HTML, ePub,
PDF, or DOCX format, and automatically
publish to Medium or WordPress. The
app’s built-in Markdown processor
handles conversion, so your headings
are wrapped in <h1> tags in HTML and
assigned Heading 1 styles if you export
as a Word document.

Markdown might not make you a better
writer, but it’ll make you a much more
productive one. GARY MARSHALL



HOW TO Use Markdown to style and structure writing

o Make your mark

In this tutorial we'll be using
Ulysses, but you can write Markdown
text in any text editor. The first thing
to do is to start writing your content.
Don't worry about formatting any text
just yet; concentrate on your words.
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Be bold

Emphasis is the next most
common kind of text formatting. In
addition to symbols - double asterisks
for bold, single for italic - Markdown-
friendly apps enable the use of the

familiar [s8)+8] and [+ 1 ] shortcuts.
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n Link it up
To add a hyperlink, type the

display text for it in square brackets
and then the target address in
parentheses - say, [MacLifel(http://
maclife.com). Don't leave a space
between the name and URL.

How to do anything on your Mac, iPhone & iPad

9 Use your heads

One of the most common parts
of a document is its heading. Prefacing
a line of text with a hash (#) turns it
into the biggest title of all, Heading 1.
Ulysses color-codes Markdown text,
as you can see above.

Make a list

To create a bulleted list, there's
no need to remember complicated tag
structures: an asterisk or dash followed
by a space automatically prefixes and
indents your text. Lists continue until
you press the key on an empty line.

smphass | s calied 8 “markup defivtion”. Amy
caled & “markup enguege” Thers are many m
¥Ou May have come across one or the other on

platforms. Textie. Setext. o the INCreasngly b

-

«  hewp | wacite com|
trve Markup lang
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9 Let the app help

Shortcuts make adding
hyperlinks faster: highlight some text,
press (3 +(K] and then type or paste an
address into the pop-up that appears.
You can then see the target address by
double-clicking the link's title.

10040 1hes 1 heade

Make a hash of it

If one hash makes your text into
Heading 1, you'll never guess what two
hashes do... Markdown enables you to
set heading styles 1to 6 by prefixing
a line of text with the corresponding
number of hash symbols.

Get the numbers

The other kind of list is a
numbered one, and once again it's
simple to create: type a number,
followed by a full stop and then a
space to start your numbered list.
Once again, Ulysses color-codes these.

A

bekerve that writers shouid not be
£, layout Lashs should fever nterte
# you wil — distraction tree. 2en-d
o —, fact is that content creation i

the tter wil gt 1 the way Evert © ran vuge

e uses 50 called miremal marky
sages. From headiines 1o ists. 10 mages and OOtNOtes yOu SOl 3380

Iring 10 text passages by enterng some easy 0 remember Characters

Publish

Ulysses' share sheet enables
you to copy your document or export
it in plain or rich (formatted) text, PDF,
ePub, DOCX, or HTML format.
Document formats also offer a range
of design templates to choose from.
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Get your website listed by Google

Built your site in RapidWeaver? Let's get it in front of people’s eyes

REQUIRES
RapidWeaver 7, your own
website hosting space

YOU WILL LEARN
How to publish your
site to the web

IT WILL TAKE
30 minutes

PART
50F5

Visit myfavorite
magazines.com
to order!

RULE YOUR
DOMAIN

It's sensible to buy

a domain and hosting
space; cats.com

looks better than
somedomain.com/
users/21414/files/cats.
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SINCE APPLE canned the
MobileMe service and its
website hosting capability a
few years ago, RapidWeaver’s
pubhshmg options have centered around
FTP (File Transfer Protocol), which is a
way to quickly transfer files. To use FIP,
you’ll need to get the appropriate login
FTP server type details (FTP, SFTP or
FTPS) from your web hosting provider.
FTP access to your website’s storage
is protected with a username and a
password. You don’t need a separate
FTP app to upload your site: RapidWeaver
has an FTP uploader built right into it.
However, before you upload anything,
there’s one thing to consider: how your
site will appear to search engines. Time
for us to think about SEO.

av

SET UP FOR SEARCH

Search engine optimization, or SEO

for short, is the dark art of getting a
website to appear near the top of Google’s
search results. Other search engines are
available, of course, but Google has
almost all the search market in the US,
and other engines tend to follow the
same principles anyway.

At its simplest, SEO asks: what does
Google want? The number one criterion
is relevancy; more relevant results mean
Google is better perceived by its users,

s . .

et Comca Mbiers et

If you don't have direct access to your hosting space,
you can test by exporting to a local folder instead.
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S we't 0w you homa of B 0N Punge et

It's a good idea to add meta tags to individual pages
of your site so that Google sees each one as unique.

so if somebody searches for “Thai food
Bay Area” then Google wants to serve up
the most relevant results for that query.
The exact way Google works out relevancy
is secret, but key steps to its calculation
include having a good-quality website
with original content, simple and
effective navigation, frequent updates,
captions and alt text on every image,

and useful meta tags on each page.

Meta tags are bits of info that your
site’s visitors don’t see. They are there
for Google’s benefit, and include the
meta description tag, where you can add
additional descriptions for each individual
page in your site. Don’t try to write for
robots, though. Write for real people;
Google can tell if you’re just shoehorning
a bunch of irrelevant words or phrases
into your tags.

Google also judges your site on how
many incoming links it has, so it’s a good
idea to contact relevant websites to ask
them to link to yours. However, the
source of links must also be of good
quality, and relevant to your site.

It’s possible to get very detailed with
SEO advice, but the part you need to know
is really simple: make your site as good as
you can, always think about your potential
readers, and keep it up to date with
content that’s fresh and interesting. Then
your site should thrive. GARY MARSHALL
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HOW TO Tag, test, and publish your web pages

[P Ty p——y

o Check your health
RapidWeaver's Health Check
button runs a scan on your website to
identify any errors that might prevent
it from working properly. If its finds
anything, click Fix next to an item to
go to the appropriate page.
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o Choose your path

By default, RapidWeaver
uploads your site to the top level of
your hosting space (and your domain
as well). If you want it in a subfolder,
such as “mysite,” enter or browse to
/mysite/ in the field labeled Path.

5 s g ve

n Publish your pages
When you're ready to upload,
click the arrow to the right of the
toolbar's Publish button and choose
your server to start the FTP process.
You'll be asked for your site's address;
for example, mysite.com.

e 8 b dge ate

Tag your pages

Make sure you've added meta
descriptions not just in Code View
here, but for individual pages in the
Inspector as well. Try to keep your
descriptions under 156 characters
and don't write them for robots.
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Test connection

Click Test and RapidWeaver will
try to establish a connection to your
hosting space’s FTP server. If the test
doesn't work, double-check you didn't
make any typing mistakes in the details
you entered in the last two steps.

Make coffee

Even a fairly small website
can take a while to upload because
internet upload speeds are a fraction
of download speeds. RapidWeaver
keeps you informed and will notify
you when it is finished.
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B Prepare to publish
Click Publishing in the left-hand
pane. To continue you'll need to know
your hosting space's FTP server
address, your username and password
for logging in to it, and the server type
your hosting provider uses.

e T

B Speed it up
If you received the OK message,

go back to the Connections pop-up
menu and choose the fastest
connection option that's listed in it.
Make sure you add your FTP server
to RapidWeaver's bookmarks as well.

¥ v g o e
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Admire your efforts

9 Once the upload is done, click

Visit on the notification (top right) to
view your site in Safari. Pick a browser
in RapidWeaver's preferences, or turn
on Safari's Develop menu in Advanced
prefs; pick Develop > Open Page With.
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Free up storage space on iOS devices

Make room on your iPhone or iPad for new apps and media

REQUIRES
iPhone, iTunes (optional)

YOU WILL LEARN
How to use storage
settings in i0S itself, as
well as in iTunes

IT WILL TAKE
10 minutes

The Settings app
identifies all the
space hogs
eating up your
valuable storage.
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NO MATTER what capacity

iPhone you have, there will

come a time when you’ll find
- it’s running out of storage
space. The good news is that you can clear

apps, photos, videos, and other items off
your device at any time.

DELETING AN APP

Go to Settings > General > Storage &
iCloud Usage and tap Manage Storage
(under Storage heading). Your installed
apps are listed in descending order of size.
Tap one to see how much space the app
itself takes up and how much is being
used to store its data and documents; tap
Delete App if you wish to remove it.

You can also delete apps from your
Home screen: tap and hold an icon until
they all jiggle, then tap X on an icon to
delete that app. Bear in mind that
deleting an app will delete its saved
documents and data. You can redownload
any app purchased from the App Store,
but this won’t restore its data.

DELETE VIDEOS

In the Videos app, tap Films or TV
Programmes then tap Edit (top right), and
tap the X. To delete individual episodes of
a show, tap the artwork, then swipe left
across an episode and tap Delete. If you
delete a rented movie, it’s gone for good.

DELETE PHOTOS

By default, every photo and video you take
on your iPhone is saved in the Photos app,
and uploaded to iCloud Photo Library, if
enabled in Settings > iCloud > Photos.
This library is an online copy of all

photos and videos taken with your i0S
devices or imported into Photos on your
Mac - if you’ve enabled the feature on
those devices as well. You can free space
by telling your iPhone to store photos at
areduced quality. In Settings > iCloud >
Photos & Camera, select Optimize iPhone

@ Aimee Mann 167 MB

1:_j -:' i:v “».:—3
‘ Bat for Lashes 26 MB

P.‘JJ The Beach Boys 74 MB
-

stic Monkeys

In Settings, some apps reveal a detailed breakdown
of all their content that's taking up storage space.

Storage. This doesn’t affect full-quality
originals stored in the online copy of your
library; only copies on your device. If you
have turned on iCloud Photo Library, be
careful about deleting photos from your
iPhone because they’ll also be deleted
from other iOS devices and Macs on which
you have enabled the feature.

DELETE A SONG

The best place to see what music is

stored on your iPhone, especially if
you’ve enabled iCloud Music Library, is

at Settings > General > Storage & iCloud
Usage > Manage Storage (under Storage) >
Music. Swipe leftwards on any item, or
All Songs at the top of the list, then tap
Delete to get rid of it.

MAGAZINES AND BOOKS

To delete all issues of a magazine, tap and
hold the app’s icon until it jiggles, tap X
on the app’s icon to remove it, then press
Home. Deleting individual issues differs
between publications. Items in the iBooks
app are deleted differently. Tap Select,
then tap items to remove, then Delete.

RESTORE ITEMS

Remember you can always restore your
previous app and media purchases by
tapping Purchased in the bottom bar
of the respective apps.

ROB MEAD-GREEN
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HOW TO Manage space on your iPhone using iTunes

Control the music

If you manage your iPhone using iTunes
and your music library is set to sync to your
device in its entirety, consider changing. Go to
Music, under Sync Music, switch to “Selected
playlists, artists, albums, and genres.”

9 Clear unwanted apps

Click Apps in the sidebar and, in the
pop-up menu, select Sort by Size. Apps with
a Remove button are already on your device.
Press it for any large apps you can do without
and the button will say “Will Remove.”

Assess the results

As you make changes to what's synced,
the capacity bar on the iTunes window updates
in real time to show how much space will be
free. Click Apply to commit the changes you've
made to your device, then press Sync.

9 Manage other media
Also turn off “Automatically fill free
space with songs.” Now tweak other settings.
In Movies and TV Shows, you can specify that
only unwatched items are synced to your
iPhone, or limit shows to a few episodes.

Options

Automaticaily sync when this iPhone is connected
Sync with this iPhone over Wi-Fi

Sync only ticked songs and videns
Prefer standard delinition v %2 ke

[ Convert higher bit rate songs b ~ 258 kbps AAC
Manually manage music and videos
Reset Warnngs

Configure Accessibility. ..

o Make songs smaller

You can choose to sync music at a
lower quality. In Summary, under Options,
check “Convert higher bit rate songs to..." and
select an option. A lower bit rate means less
space taken up, and lower sound quality.

Music
@ Apps
o) BOOKS
@ Updates (

Auto Download

If space is short on your iPhone, go to
Settings > iTunes & App Store and disable
automatic download of apps, music and books
bought using other devices. Tap Purchased in
the store apps to download individually.

Q

SYSTEM APPS

i0S 10 gives you the ability
to “delete” built-in apps
such as Stocks - although
you gain very little space
back by doing this.
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Organize files in Office for iOS

How to manage, share, and collaborate in Word, Excel, and PowerPoint

REQUIRES
Microsoft Word, Excel,
or PowerPoint

YOU WILL LEARN
How to use file storage
options in Microsoft's
i0S Office apps

IT WILL TAKE
15 minutes

ONE OF THE key requirements
of an office package is that
it’s flexible with document
organization. Apple’s iWork

i0S apps technically allow you to edit and

move documents between cloud storage
providers, but it’s not that flexible. If you
want easy access to documents, you’re
driven towards storing them all in iCloud

Drive. In contrast, Microsoft’s Office apps

- Word, Excel, and PowerPoint - are far

more forgiving. All three apps enable you

to link into a wide range of cloud-based
solutions, putting you in charge when

it comes to choosing where to store

documents. You can also easily choose to

store documents offline on your iPad.
There’s direct support for seven
different cloud providers at present -
these make it easy to save changed
documents back to their original location

(manage these services by tapping your

account picture and choosing Edit). But

even if your chosen service isn’t directly
supported, Office is flexible enough to

HOW TO Organize and share documents in Word

Save file

n A quick tour

Once you've signed in, you'll
have access to all files on your OneDrive
account, plus any files you store on your
iPad. Tap New to create a document
from scratch - pick from a template,
or choose the blank option.
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Auto-save is on, and the
document will be saved to OneDrive
by default as Documentl. Tap the File
button and select Name to give it a
different file name, plus choose where
to store it - on your iPad, for example.

indirectly support it - install its
associated app and it should appear as an
option in the iOS Share menu when you
tap More. It’s not quite as friendly this
way (you can’t save automatically back to
the original folder), but the step-by-step
guide reveals how to work around this.
The Microsoft apps also offer ways of
both sharing documents and collaborating
on documents shared by others. The
second half of the guide shows you how to
share and collaborate - if your contacts
have multiple email addresses, use the
one associated with their Microsoft
Account so they can edit the doc in Word.
Tap Share > Shared With to review
who has what access — tap their name to
change privileges, or to stop sharing the
document. The web link option makes it
easier to share more widely (but beware,
anyone with access to the link can then
view or edit the document), while Send
a Copy allows you to share a separate
copy of the file by another medium,
typically email. NICK PEERS

Q N ; " @
A o H J K retun
+ B Y] *

Connect services

To add a new supported service
(you can do this from the Open and
Account screens too), tap Add a Place
to view a list of supported services,
including Dropbox and Box. Tap your
chosen service to continue.
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o Link to app or log in

If you've installed the app for the
service you'll use, Word will open it
and link the apps; otherwise you'll need
to enter your username and password,
then grant OneDrive access to the
service in question when prompted.

“

Fie

Save a Copy

S

Print

o Move and export

Tap the File button and choose
Save a Copy to save your file to a
different location; choose Export to
save a copy in OpenOffice (.odt for
text, .odp for presentations, and .ods
for spreadsheets) format instead.

Oisplay for Review « - 0. Block Authors

ctober

Collaboration

Use the Review tab to track
changes made by yourself and your
collaborators. If changes are made by
other users, you'll be notified - tap
Save and Refresh to update your
version to incorporate their edits.

B Use unsupported
services

If the service isn't listed - for example,

iCloud Drive or Google Drive - tap More...

instead. Tap Locations to select your
service, then browse and choose Save
Here or select the file you wish to open.

Share

invite People

| | .
-1"}L ,Jlt
Share docs

You can share a document with
other people if it's saved to OneDrive.

sl

L

"LLJ

With it open, tap the Share button in the

top right-hand corner; you can also tap
“..." next to a document’'s name in the
File Open screen. Choose Invite People.

e
o Uned 13 00 Morecsmbe Raject
aa Reject & Move to Next
» drgyte 13,00 Cokchester Untes
] Reject Change

-
wr Unaed 1500 Layion Ot Reject All

-

Reject All & Stop Tracking

e 13 00 Cothester Unted

m Review changes

Flick the Track Changes button
on to monitor what's changed - the type
of edit and who made it are displayed
next to the change. Use the controls

to the right to set what's shown, plus
approve or reject changes.

Save back

Files opened using the More...
method are downloaded to your iPad,
where all changes are subsequently
saved. To save the file back, you'll need
to choose Save a Copy to upload it
back to the original location.

< Inwite Peopie Send

Can Edit &
ASd your DS 10 thes Newsietler and we i

60 110 the tamiy{

Enter contacts

Office will ask to connect to your
contacts - let it do so, and start typing
someone's name. Matches will appear
- select the email address, choose to
make the document editable or not,
add a message, and tap Send.

Review

o B £, miock authors

Wapiay tor Raview al ] - +*5

Block Authors
rtmouth Block Authors 4

Unblock All My Areas

snafiald Town

thester United

Protect document
If your document is saved to
OneDrive, you can select a portion
of your document and protect it from
other users by tapping Block Authors
and choosing Block Authors. Select
Unblock All My Areas to undo.

maclife.com| MAR 2017 | 111



»>Create

Advanced editing in iMovie for iOS

Enhance your productions with precision editing and video overlay effects

REQUIRES
iMovie, some fun and
active clips

YOU WILL LEARN
How to add cutaways, split
screen and picture-in-
picture effects

IT WILL TAKE
15 minutes

two clips to select it. Then

clips onto separate tracks.
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Precision Editor

Tap the transition icon between

yellow arrows icon below the transition
icon to summon the Precision Editor.
This will place the two adjacent the

WHEN USING iMovie on an
iPad it’s a simple matter to
" drag-and-drop the best parts
pron of your raw footage into the
timeline and then trim them for a tighter
cut. You can easily swap the running order
of each clip in the non-linear timeline to
tell a story more clearly. This results in
a series of consecutive clips that you can
share easily with family and friends to
a range of social media sites.

By deploying iMovie’s more advanced
editing features you can make your
iPad-edited movie stand out from the
crowd. Here we’ll demonstrate how
iMovie’s advanced editing tools and
techniques enable you to apply
more professional-looking production
values to your programmes.

When filming repetitive activities
(such as a man juggling) you can make
your movie look more engaging by varying
the shot sizes and camera angles that you
use. With careful editing you can then cut
from a wide shot to a close up and the
action will flow seamlessly (despite the
fact that the two clips

HOW TO Use the Precision Editor

tap the

the end of the wide shot.

Choose Out point
Now drag the top clip's yellow
trim handle to scrub through individual
frames. In this example we've chosen

a frame where the club is about to
leave the juggler’s right hand near

were shot at different times). This
makes it look like you were filming the
action using two cameras instead of one.
iMovie’s Precision Editor enables you to
fine-tune the in and out points of
consecutive shots to ensure continuity
of movement — we’ll show you how.

ADD VIDEO LAYERS

Next, we’ll move on to demonstrate other
advanced features, such as combining
video clips in layers. This enables you to
add cutaway clips. Professional editors
use cutaways to illustrate a point being
made or hide jump cuts in interviews.
Cutaways also add texture and variety

to your programmes.

By editing in layers you can also display
two clips at the same time. This adds
more visual variety and enables you to
tell a story more creatively. By splitting
the screen to show sections of two clips
you can create a title sequence montage,
for example. Alternatively, you can place
one picture inside another to add extra
information to your project’s narrative.
GEORGE CAIRNS

Choose In point

Drag the lower layer clip's
yellow control handle until you find the
precise frame that you want to cut to.
Here we've matched the action of the
wide shot to the movement in the mid
shot, ensuring seamless continuity.
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HOW TO Add a cutaway clip

o Select a cutaway

You can hide an edit point in
the timeline by placing a separate clip
above it as a cutaway layer. Place the
timeline's playhead where you want
to insert a cutaway. Tap to select a
cutaway clip in the browser.

b
9 Add an overlay o Trim the cutaway

Tap the three dots in the dialog Tap the cutaways layer to select

box that appears next to the selected it in yellow to edit. Then drag the trim
clip to access more options. You can handles to choose where it starts and
tap the overlapping rectangles cutaway  ends. Here we've cut from the juggler
icon to overlay the clip as a separate to a cutaway of the dog watching and
video layer in the timeline. then back to the action.

HOW TO Add a picture in picture

Choose PIP effect

Place the playhead where you
want to insert a picture in picture (PIP)
effect. Select a clip in the browser. Tap
the ... icon and choose the icon of a
small rectangle inside the larger one.
The clip will appear as an overlay.

9 Reposition Zoom in

the overlay You can magnify the content
Tap the PIP overlay clip in the timeline. within the inserted picture to make it
Tap the move tool icon (arrows) in easier to see. Tap the magnifying glass
the viewer. Drag the inserted clip to icon in the viewer. Pinch inside the
re-position it. Pinch the inserted clip frame to zoom in on an area. Drag to
to resize it within the bigger frame. reposition the zoomed area.

> LET'S SPLIT
Create a split-screen sequence

Even after you've added a clip as a cutaway or picture-in-picture overlay, you can
change the way it mixes with footage on the timeline's lower layer. Tap the overlay
clip to select it. An Overlays icon appears below the timeline. Tap it. You can now
choose from a range of split-screen effects that combine parallel timeline clips
left/right or top/bottom. Once you've split the screen, tap the magnifying glass
and pinch and drag to fine-tune the composition of the overlay layer's contents.
Here we've juxtaposed the dog and the clubs.
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RANDOM APPLE MEMORY

iLife

Adam Banks recalls Apple's early dabbles with media software

APPLE NEVER wanted to be a
consumer software company. When it
shipped MacWrite and MacPaint with the
original Macintosh, it was in the hope
that they'd inspire third-party rivals. Few
took the bait. By 1998, the big A had
spun off a subsidiary, Claris, to avoid
having to develop apps in-house - then
accidentally killed it by trying to force it
to adopt the ill-fated OpenDoc. Now apps
were taking up time and attention again
- and still there were more to make.

In 1999, the iMac DV was launched
with the unique selling point of FireWire,
a super-fast interface for which the only
obvious use was to import video from
tape-based cameras. That called for a

NEXT
MONTH

»>> Be an Apple
Genius!
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video-editing app, and iMovie was born.
DVD burners were the next hardware
innovation in search of software support,
which duly arrived in iDVD. And in 2002,
Apple's response to the rise of digital
cameras (even though it had stopped
making them itself) was iPhoto. “We
believe the Mac can become the hub of
our new emerging digital lifestyle,” said
Steve Jobs at the time.

A vision of integration delivered by
three unrelated programs - informally
known as the “iApps" - felt incongruous,
and on January 7 2003, during a
product-packed Macworld Expo keynote,
Jobs announced they'd be rolled into a
suite, iLife. This was the big idea, by his

>>> Make the most
of your screens

>>> Smart tech for
your car

own account, of software VP Todd
Basche. In fact, the iApps still felt like
unrelated programs, and when
GarageBand was added in 2004, then
iWeb in 2006, they didn't integrate
particularly well either.

With the advent of the Mac App Store,
even the box bearing the iLife branding
disappeared, leaving no more than a
name. Today, only two of the iApps
survive. As for Basche, he works for
Taser, integrating surveillance cameras
and smart weapons...

MacLifess
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